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ABOUT THE SYSTEM 
ENGINEERING GUIDE

This user guide describes the configuration and management of the VAV and FCU 
controllers connected to a BACnet™ RJ45 (IP), T1L (IP), or MSTP network via a 
EAGLEHAWK or HAWK-8000 controller. Configuration and management are performed 
using the IRM engineering tool based on the CentraLine-N4 framework. The Engineering 
Tool can be used to program the controller to support various applications such as setting 
up the controllers for usage in BACnet™ RJ45 (IP), T1L (IP), or MSTP network, creating 
applications for the controllers, synchronizing applications between project and 
controllers, adjusting terminal layout deviations, cloning applications, firmware download 
etc. 

Note: In this guide, the Merlin NX is referred to as an IRM NX controller in a few sections. Details of 
features and configuration provided in this guide are applicable to IRMNX Compact VAV 
controllers, IRM N4 controllers, and IP/MSTP VAV controllers. However, few features might 
not be supported by VAV or IRM N4 controllers.

Note: It is recommended to carefully, read, understand, and consider the Notes and Important 
provided to address the differences in supported features per controller model.

The user guide covers the following topics:

• Chapter 1: About the System Engineering Guide
This section describes the engineering tool's essential information, specific 
operation details, and system overview of the IRM controller.

• Chapter 2: Introduction
This section describes the engineering tool's essential information, specific 
operation details, and system architecture of the IRM Controller.

• Chapter 3: Overview of the Engineering Tool
This section describes the properties of BACnet device, components of control 
manager, and procedure to configure periodic program, event program, and On 
board IO. 

• Chapter 4: Configure IRM NX controllers
This section describes the steps to configure the IRM NX controller, IP settings, 
linking of controller IO points to the BACnet points, and terminal assignment view.

• Chapter 5: Engineer the Controllers (Engineering Modes)
This section describes steps to setup controller with or without using serial number, 
common operations of IRM program, Bluetooth configuration, On board IO 
migration, and alarms configuration.

• Chapter 6: Sylk Device Programming
The IRM controllers support the Sylk bus. The Sylk devices and Sylk parameters are 
part of the engineering tool palette. This section describes step by step process to 
program the Sylk device.
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• Chapter 7: Modbus Engineering
This section describes the Modbus Interface rules, as well as the procedure for 
configuring Modbus device settings and verifying communication

• Chapter 8: Other Operations
This section describes other operations such as firmware download, bulk operation, 
creating controller backup, and commissioning.

• Chapter 9: Pre-Engineered Templates and Balancing
This section describes procedure to configure the Flow Balancing View and Global 
Balancing Object. Also describes steps to deploy the Global VAV Template.

• Chapter 10: Troubleshooting
This section describes the procedure for resolving the problem, specifically when 
working on an engineering tool, as well as best practices for designing a controller. 
This section also includes workarounds, a diagnosis report, and a system status 
check.

Applicable Technical Literature
Table 1  Applicable Technical Literature

Document Title Reference

IP/ MSTP VAV Technical Literature (Centraline)

Merlin NX IP VAV Product Datasheet EN0Z-1073-GE51

Merlin NX MSTP VAV Product Datasheet EN0Z-1072-GE51

Merlin NX IP and MSTP VAV Installation Instructions EN1Z-1076-GE51

Merlin NX IP and MSTP VAV Mounting Instructions EN1Z-1074-GE51

Merlin NX Compact VAV Product Datasheet EN0Z-1061-GE51

Merlin NX Compact VAV Installation Instructions EN1Z-1061-GE51

Merlin NX Compact VAV Mounting Instructions MU1Z-1061-GE51

IP/ MSTP VAV Technical Literature (HBS)

IP Product Datasheet EN0B-0301-IE10

MSTP Product Datasheet EN0B-0300-IE10

Mounting Instructions MU1B-0300-IE10

Installation Instructions EN1B-0301-IE10

IRM Migration Guide EN2B-0428-IE67

Compact VAV Controller Product Datasheet EN0B-0078-IE10

Compact VAV Mounting Instructions MU1B-0590-GE5

Compact VAV Installation Instructions EN1B-0591-GE51

Other Supported Technical Literature

Honeywell Unitary Controller 24V - Datasheet 31-00571

Honeywell Unitary Controller 24V - Mounting Instructions 31-00572

Honeywell Unitary Controller 24V - Installation Instructions 31-00614
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IRM related technical literature can be downloaded at buildings.honeywell.com.

System Requirements

IRM Function Blocks User Guide EN2B-0415-GE51

Global VAV Balancing Tool User Guide EN2B-0041-IE10

Honeywell Connect Mobile User Guide 31-00472

NIAGARA IRM Application Guide EN2B-0416-GE51

NIAGARA Hardening Guide EN2Z-0985-GE51

MERLIN N4 Product Data EN0Z-1035-GE51

MERLIN N4 Installation Instructions EN1Z-1035-GE51

EAGLEHAWK NX Product Data EN0Z-1039-GE51

EAGLEHAWK NX Installation & Commissioning Instructions EN1Z-1039-GE51

EAGLEHAWK NX Panel Bus Driver User Guide EN2Z-1043-GE51

EAGLEHAWK NX Onboard IO Driver User Guide EN2Z-1044-GE51

Table 1  Applicable Technical Literature

Document Title Reference

Compatibility CentraLine-N4.9.xx.xxx and higher.

Firmware
Refer to the latest release notes for the updated firmware details.

Download the latest firmware from buildings.honeywell.com.

Engineering Tools
Refer to the latest release notes for the updated IRM engineering tool details.

Download the latest IRM Engineering Tool from buildings.honeywell.com.

Migration Tool spyderToIrmNxMigrator-wb.jar


https://buildings.honeywell.com/us/en
https://buildings.honeywell.com/us/en
https://buildings.honeywell.com/us/en
https://buildings.honeywell.com/us/en
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Table 2  Supported Controller Models

Controller Model Description

IRM N4 Controller (Centraline)

CLMERL4N

IRM N4 Controller with large housing.CLMERL6N

CLMERL8N

CLMERS4N
IRM N4 Controller with small housing.

CLMERS5N

IRM N4 Controller (HBS)

CPO - RL4N

IRM N4 Controller with large housing.
CPO - RL5N

CPO - RL6N

CPO - RL8N

CPO - RS3N

IRM N4 Controller with small housing.CPO - RS4N

CPO - RS5N

Compact VAV Controller (Centraline)

CLMEVA423B24N IRM compact VAV controller with an integrated actuator.

CLMEV423B24N Replacement IRM compact VAV controller without an integrated actuator.

Compact VAV Controller (HBS)

CPO - VA423B24N IRM compact VAV controller with an integrated actuator.

CPO - V423B24N Replacement IRM compact VAV controller without an integrated actuator.

IP VAV Controller (Centraline)

CLMEVA75I24NM IP VAV controller

CLMEVA00IB4NM IP VAV controller with Bluetooth (without UIO and SSR support).

CLMEVA75IB24NM IP VAV controller with Bluetooth.

IP VAV Controller (HBS)

CPO - VA75I24NM IP VAV controller

CPO - VA00IB4NM IP VAV controller with Bluetooth (without UIO and SSR support).

CPO - VA75IB24NM IP VAV controller with Bluetooth.

MSTP VAV Controller (Centraline)

CLMEVA75M24NM MSTP VAV controller

CLMEVA00MB24NM MSTP VAV controller with Bluetooth support (without UIO and SSR 
support).

CLMEVA75MB24NM MSTP VAV controller with Bluetooth support.
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MSTP VAV Controller (HBS)

CPO - VA75M24NM MSTP VAV controller

CPO - VA00MB24NM MSTP VAV controller with Bluetooth support (without UIO and SSR 
support).

CPO - VA75MB24NM MSTP VAV controller with Bluetooth support.

Unitary Controller

UN-RS0844ES24NMC / D
Honeywell Unitary IP controllers with small housing.

UN-RS0844ESB24NMC / D

UN-RS0844MS24NMC / D
Honeywell Unitary MSTP controllers with small housing.

UN-RS0844MSB24NMC / D

UN-RS0844TS24NMC / D
Honeywell Unitary T1L controllers with small housing.

UN-RS0844TSB24NMC / D

UN-RL1644ES24NMC / D
Honeywell Unitary IP controllers with large housing.

UN-RL1644ESB24NMC / D

UN-RL1644MS24NMC / D
Honeywell Unitary MSTP controllers with large housing.

UN-RL1644MSB24NMC / D

UN-RL1644TS24NMC / D
Honeywell Unitary T1L controllers with large housing.

UN-RL1644TSB24NMC / D

Table 2  Supported Controller Models

Controller Model Description
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Engineering Recommendations
For successful and seamless engineering, follow the below recommendations.

Table 3  IRM NX Engineering Specifications

Specification Description

Recommended 
number of BACnet 
IP controllers

• Daisy chain topology

The recommendation is no more than 100 controllers per BACnet IP port. 
In the daisy connection, it is recommended to add 15 proxy points and 20 ref in or 
ref out to each BACnet IP controller.
To optimize the Niagara station performance, the tool uses the Niagara BACnet 
worker pool to manage communication between controllers and synchronize user 
changes. 
A station with more proxy points (than recommended) will have a very busy BACnet 
worker pool. When the worker pool is busy, there will be a delay in processing the 
messages sent to the controller and thus impacting tool performance. As a result, 
some of the tool features will not function correctly. For example, delays in 
synchronizing live changes or probable failures in synchronizing user changes with 
the controller. 
When there are failures, the user needs to redo the tool operation or perform a full 
application teach to synchronize the changes..

Figure  1. Daisy Chain Topology
Note: Engineering on 100 controllers in a daisy chain is only possible in swap out 

mode.
• Ring network topology
The maximum number of controllers that can be connected in the ring network 
topology is 40 with 1 switch. The switch manages the connection of the loop. 

For optimal performance and bus traffic, it is recommended to limit the number of 
controllers upto 40.

Figure  2. Ring Topology

Daisy Chain Topology 

#3#2

#4

#1

#N

Supervisor/
Web Browser
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Recommended 
number of BACnet 
MSTP controllers

• 40 controllers per BACnet MSTP bus.

It is recommended to add 15 proxy points and 20 ref in or ref out to each BACnet 
MSTP controller.

Available Memory

• Compact VAV: 344 KB

• IRM N4: 344 KB

• IP/ MSTP VAV: 2 MB

• Unitary: 2 MB

Baud rate

• BACnet MSTP 

• Supported Baud Rate: 9600, 19200, 38400 (default), 57600, and 76800.

• Modbus 

• Supported Baud Rate: 1200, 2400, 4800, 9600, 14400, 19200 (default), 
38400, and 57600.

Maximum function 
blocks usage

• Maximum 32 folders overall (IRM CVAV/FCU controller).
• Maximum 100 folders overall (IRM IP/MSTP VAV controller).

• Maximum 100 folders overall (Unitary IP/MSTP/T1L controller).
• IRM controllers allows to add total of 150 function blocks per folder with four 

folders reserved by default.

Note: It is recommended to add 100 function blocks per folder for optimum 
performance. 
Each folder used by the program consumes 8 KB of memory. 

• Maximum 2000 function blocks (IRM CVAV/FCU controller).
• Maximum 6000 function blocks (IRM IP/MSTP VAV controller).

• Maximum 6000 function blocks (Unitary IP/MSTP/T1L controller).
• Sylk device configuration limited by Sylk power usage.

Note: The WmConfigHvacA function block can be placed not more than three times 
onto the wiresheet. It can only be configured as a Sylk wall module once. 
Instead of using the Sylk wall module, the function block can also be 
configured as a wired or external wall module (a Modbus wall module). This 
limitation applies to both IrmFolder and IrmSubFolder.

Modbus

• Maximum 8 Modbus devices.
• Maximum 155 read or write data points for all the Modbus devices per IRM CVAV, 

IP/MSTP VAV, and Unitary IP/MSTP/T1L controller.
• Maximum number of high priority registers per controller is 6.

Maximum Sylk wall
modules

The maximum number of wall modules depends on the following factors:
• Sylk bus power consumption.
• Number of parameters used.
• Total config file size. The IRM NX tool has an inbuilt resource calculator to 

calculate the amount of Sylk wall modules.

Table 3  IRM NX Engineering Specifications (Continued)

Specification Description
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BACnet device 
discovery over BLE 
Controller gateway

• IP Controllers Limitation: 
For IP controllers, the entered Instance Id range between two instance ids 
should not exceed 30.

• MSTP Controllers Limitation: 
For MSTP controllers, the entered Instance Id range between two instance ids 
should not exceed 30.

Note: If more than 30 IP or MSTP controllers are discovered, the HCM will connect 
to a random group of 30 controllers

Note: It is recommended to use BACnet Instance Range search for BACnet device 
discovery using Bluetooth gateway.

Table 3  IRM NX Engineering Specifications (Continued)

Specification Description
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Security Best Practices
The purpose of this section is to provide information to those involved in the installation 
and maintenance of a product or system so that they can understand the requirements for 
configuring and managing the security of the product or system.
• Use the latest version of the engineering tool and firmware.
• CentraLine-N4 installation files, configuration files (including station backup), 

certificates, and licenses are included in the disaster recovery plan.
• The PC running CentraLine-N4 should be protected from unauthorized physical access 

wherever feasible.
• The Ethernet network (and any other networks to which the PC is connected) is 

protected, for example, using firewalls and intrusion detection systems.
• The PC is running the latest version of the Windows operating system, with all updates 

and service packs.
• The PC has anti-virus software.
• Appropriate user accounts are created on the PC, and file access is restricted to only 

authorized users.
• The CentraLine-N4 is configured to use HTTPS (Hypertext Transfer Protocol Secure) 

with a certificate from a trusted Certificate Authority.
• Make sure the CentraLine-N4 is configured to backup data regularly to a secure location 

as per your company's backup policy.
• Ensure that complete commissioning is carried out in a closed local area network 

without connecting to the internet to avoid unauthorized detection of BACnet message 
packets. 

• Use encrypted communication between the engineering tool and the controller. 

For additional information refer following documents:

• NX General Security Best Practices (EN0Z-1040GE51)

• Niagara 4 Hardening Guide — EN2Z-0985GE51
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INTRODUCTION

The IRM engineering tools provide flexible and fully programmable control, resulting in real 
benefits such as lower energy costs while driving new levels of functionality and perfor-
mance.

Basic Concepts
Table 4   Engineering Configurations

Configuration Description

Engineer the 
Controllers 
(Engineering Modes)

There are three way of engineering IRM NX controller:

• Add Controller Setup with Service Pin: Use this procedure when you do not 
have the controller's serial number.

• Controller Setup using Serial Number: Use this procedure when you have the 
controller's serial number.

• Discover Online Controller: In this method, the devices are discovered on the 
BACnet network in the first stage and used simultaneously for application 
engineering. Online engineering is recommended when undertaking 
engineering directly with devices already installed on the BACnet network.

Synchronization Status

Synchronization status check allows monitoring the running project and status 
of the connected IRM NX controllers by the control manager (online engineering 
only). Any modification detected in the controller, project, or both can be 
synchronized by applying the following actions.

• Teach to controller

• Learn from controller

• Clear project (as required)

• Clear controller (as required)

Tuning Policies. 

Defines rules for evaluating both write requests, which is to writable proxy 
points, and the acceptable “freshness” of reading requests that result from 
polling. It includes standard tuning policy properties and additional properties 
related to client-side usage of the BACnet subscribe cov service.
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Configure MSTP VAV 
Controllers

IP setting operation is provided to ease the IP configuration for multiple IP VAV 
controllers from a single window. This feature allows users to perform many of 
the following functions. 
• Batch update of IP configuration.
• Auto-increment of IP addresses.
• Visual indication of modifications to IP addresses.
• Reporting of errors in IP configuration.
• Offline and online IP configuration.

Bluetooth 
Configuration

Bluetooth configuration allows configuring the Bluetooth enabled IP/ MSTP 
VAV controller in a batch. This feature enables users to perform the following 
operations. 

• Configure the Bluetooth property of the IP/ MSTP VAV controller.

• Enable or disable Bluetooth function.

• Setting a Bluetooth passcode.

• Setting Bluetooth passcode validity to enable mobile balancing application 
to connect to the devices over Bluetooth.

New Controller 
Configuration

All new IRM NX controllers are assigned with default factory device ID = 
4194302. However, if multiple controllers have the same device ID, they cannot 
talk via the BACnet protocol (Who is? - I am broadcast messages). The new 
controllers on the MSTP bus will not be visible after discovery. When working 
with multiple controllers, you must also set a unique device ID to each controller.

Flow Balancing View

A variable air volume (VAV) system allows a single IRM NX controller to provide 
the appropriate amount of cooling to multiple zones with different cooling loads. 
The VAV regulates the air volume to the zone by opening or closing the damper. 
This damper is controlled by a floating motor installed on an integrated actuator 
of the IRM NX controller.
The flow balancing tool can be configured with various parameters and 
indicators to optimize the calibrations used to balance the airflow. 

Modbus Engineering

The IRM NX VAV controller is conditionally compliant with the “regular” Modbus 
device standard. The controller features a removable 2-wire with shield, non-
isolated, RS-485 interface suitable for Modbus communication (terminal 16, 
17, and 18). 

Terminal Assignment 
View

This function enables you to assign or swap (UIO to BO terminals and vice versa) 
the IO terminals of the controller without modifying the Onboard IO 
configuration.

Application Details
Using the details from the flash memory exceeded function block and IRM folder 
section, the user can verify the property sheet and re-configure the respective 
function block, IRM folders, or subfolders to the defined limit.

Custom Sensor 
Configuration Details

If the sensor does not meet any standard characteristics of the available 
sensors, you can select the type as a custom sensor and set its characteristics. 
There are three types of custom sensors: current, voltage, and resistive.

Day Light Savings 
settings

The daylight savings setting is a part of the control manager and enables the 
user to configure the daylight setting, if required. 

Table 4   Engineering Configurations (Continued)

Configuration Description
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Global Balancing 
Object

The global balancing object is a component of the engineering tool. It allows you 
to configure the balancing object based on the project requirements and 
generates the controller's balancing data report.

Alarms Provides the notification classes for establishing alarming.

Irm Controller 
Diagnostics

The IRM NX controller diagnostics monitor the control engine's activity, BACnet, 
Modbus trace, and Sylk trace.

Master Sync

The master sync function is based on multiple devices that must have the same 
application type. This is called a master sync group. The master sync group is 
established via the clone application function, which clones the application of 
one selected device (template) to multiple devices.

Clone Application
This function enables you to clone the device application based on a selectable 
template (device) to selectable devices. As result, all devices will receive the 
same application type which is the basis of a master sync group.

Split Application

This function enables you to split the unique application of the master sync 
group into a new application and keep the existing application. For the new 
application, you can enter a different project program name. A new project 
application type is issued automatically by the software. The new application 
can then be cloned to form the new master sync group.

Controller Firmware 
Download This function enables you to update the firmware in the controller via download.

Sylk Device 
Programming

Sylk enabled sensors and actuators save I/O on the controller and are faster and 
cheaper to install since only two wires are needed, and the bus is polarity 
insensitive.

Reference Datapoints 
Usage

The reference datapoint is used to set up communication between BACnet 
controllers using reference input and reference output points.
This data communication is achieved through the use of reference input and 
reference output points, which are assigned to physical or value BACnet points.

Create a Backup 
Controller and 
Application

This function enables you to create a controller or application backup.

Reset to Factory 
Default This function enables you to reset controller.

Table 4   Engineering Configurations (Continued)

Configuration Description
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System Architecture of IP VAV Controller
The following schematic shows a BACnet IP based system connected to two IP VAV con-
trollers. The system is engineered using the engineering tool based on the CentraLine-N4 
workbench.

Fig. 3   System Architecture of IP VAV Controller
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System Architecture of MSTP VAV Controller
The following schematic shows a BACnet MSTP based system containing a HAWK-8000 
controller as a router and MSTP VAV controllers. The system is engineered using the engi-
neering tool based on the CentraLine-N4 workbench.

Fig. 4   System Architecture of MSTP VAV Controller
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System Architecture of Unitary Controller
The following schematic shows a BACnet™ RJ45 (IP), T1L (IP), or MSTP based system con-
taining a Honeywell Advanced Plant controller as a router and Honeywell Unitary T1L (IP), 
RJ45 (IP), and MSTP controllers. The system is engineered using the engineering tool 
based on the Centraline-N4 workbench.

Fig. 5   System Architecture of Unitary Controller
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Control Palette
The “honIrmControl” palette is used for creating the application, which includes all 
necessary components such as logic function blocks and physical points for BACnet 
devices, IRM programs, and folders.

Fig. 6  Control Logic Palette
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Overview of the Engineering Tool (IRM)
The engineering tools provide flexible and freely programmable control, resulting in 
tangible benefits such as lower energy costs while driving new levels of functionality and 
efficiency.

Site engineers can use smart engineering and commissioning procedures to configure 
multiple flexible applications.

Bacnet Network Property Sheet 
This component is the base container for all BACnet components (devices and proxy 
points). It resides under the station’s Drivers container. Its default view is the “Hon Bacnet 
Device Manager”. 

In addition to devices and proxy points, this component contains the station’s BACnet 
communications protocol stack (Bacnet Comm), and a Local Bacnet Device, which 
configures the station’s representation as a BACnet device. For more details about 
properties of Bacnet Network, refer to Bacnet Device Property Sheet on page 56.

Steps to open Bacnet Network property sheet:

Step 1. Right click on Bacnet network > Views > AX Property Sheet.

Fig. 7   Bacnet Network Property Sheet
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Bacnet Network Tuning Policies Property Sheet
This component is a container for one or more BACnet tuning policy.

When using the BACnet driver you can create multiple tuning policies and assign specific 
tuning policies to BACnet proxy points as needed based on the Bacnet Comm > Network 
port used (IP Port, Ethernet Port, Mstp Port). For more details on configuring Tuning 
policies, refer to Tuning Policies on page 231.

Step to open Bacnet Network Tuning Policies property sheet:

Step 1. Right click on Tuning Policies > AX Property Sheet.

Fig. 8   Bacnet Network Tuning Policies Property Sheet 
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Bacnet Network Irm Bacnet Device Manager View
The engineering tool has several views to assist with programming the controllers. The fig-
ures below are navigating within the CentraLine workbench from the top down.

Most of the items seen in the figure and table below can also be used from the Irm Program 
view. The actions will perform the same for either view. There are additional options to 
select from the Irm Bacnet Device Manager view which can be used for multiple controllers. 
The Irm program view can be used for individual controllers.

The Irm Bacnet device manager view is used for the IRM NX controllers.

Step to open Bacnet Network Irm Bacnet Device Manager property sheet:

Step 1. Right click on BacnetNetwork, select Views > Irm Bacnet Device Manager 
view.

Fig. 9  Irm Bacnet Device Manager view
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The Irm Bacnet Device Manager view allows you to perform batch operations on multiple 
controllers.

Fig. 10  Irm Bacnet Device Manager view

The following table shows the options indicated on the Irm Bacnet Device Manager and the

IRM Program views.

Table 5  Description of Irm Bacnet Device Manager and IRM Program Views

Options Descriptions

To create new device folder.

To create/add new device.

To edit device.

To discover devices.

To add device from discovered pane.

To match device in database with discovered 
device.

To synchronize device time with PC time. For 
more details, refer to Synchronizing 
Controller Time on page 54.

To update MAC Address configurations; 
enable or disable auto MAC feature. For more 
details refer to Controller MAC Address 
Configuration on page 133.

To change ethernet settings; set IP Address 
type (DHCP/Static). For more details refer to 
IP Configuration on page 117.

Bluetooth port configuration; generate 
passcode for balancing. For more details refer 
to Bluetooth Configuration on page 222.
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To makes application backup and swaps 
application out of RAM. For more details refer 
to Swap on page 187.

To restore the saved application to RAM. For 
more details refer to Swap on page 187.

To makes the selected device a source for a 
group of devices (targets). For more details 
refer to Master Sync on page 208.

To makes the selected devices a target for a 
group of devices. For more details refer to 
Master Sync on page 208.

To removes device from being a source or 
target (remove from group).

To force the application (or changes) to a 
group of target devices. For more details refer 
to Master Sync on page 208.

To split off application from a Master Sync 
group. For more details refer to Split 
Application on page 214.

To copy the application from one device to 
one or more device. For more details refer to 
Clone Application on page 210.

To deletes the application from the project of 
the selected devices. For more details refer to 
Clear Project on page 183.

To delete the application from the selected 
devices. For more details refer to Clear 
Controller on page 181.

To updates all BACnet Object values from the 
controller to the application. For more details 
refer to Update All Bacnet Object Values from 
Controller to Application on page 204.

To create a balancing report from online 
controller values or wire sheet values. For 
more details refer to Generating Balancing 
Report on page 375.

To download the application changes in the 
project to the devices. For more details refer 
to Teach To Controller on page 172.

To downloads the whole application to the 
devices. For more details refer to Teach Full 
Application To Controller on page 174.

Table 5  Description of Irm Bacnet Device Manager and IRM Program Views

Options Descriptions



IRM SYSTEM ENGINEERING GUIDE 31

To uploads the current application from the 
devices in the project. For more details refer 
to Learn from Controller on page 177.

To downloads Bluetooth firmware to the 
device(s). For more details refer to Download 
Bluetooth Firmware on page 403.

To downloads controller firmware to the 
device(s). For more details refer to Controller 
Firmware Download on page 340.

To downloads the balancing object values 
from the station’s balancing object to the 
device. For more details refer to Teach 
Balancing Values to Controller on page 373.

To uploads the balancing object values from 
the device to the station’s balancing object. 
For more details refer to Learn Balancing 
Object from Controller on page 373.

Table 5  Description of Irm Bacnet Device Manager and IRM Program Views

Options Descriptions
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Controller View 
The view below may or may not be seen depending on the controller you are working with 
and if a template was used.

Step to open Controller view:

Step 1. Navigate to Config > Drivers > Bacnet Network.

Step 2. Expand BacnetNetwork, right click on a controller > Views.

Fig. 11   Controller View 

Table 6   Controller View Options

Components Description

Schematic Represent the VAV Controller status and Setpoint 
controls.

AX Property Sheet This is default property sheet view for the HAWK-N4.

Flow Balancing View

The flow balancing tool can be configured with various 
parameters and indicators to optimize the calibrations 
used to balance the airflow. For more details, refer to 
Flow Balancing View on page 359.

Application Config View This contains the configuration details for various 
parameters in application. 

Terminal Assignment View

The Terminal Assignment View allows the user to assign 
or swap the controller's IO terminals without opening the 
Onboard IO configuration. This feature allows users to 
change the IO terminal assignment even if the device is 
swapped out. For more details, refer to Terminal 
Assignment View on page 146.
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Controller Point View
This is the default view for the Points extension (or Points folder) under any BacnetDevice, 
and works similarly to the way other point managers work, which support online point dis-
covery.

Step to open controller Irm Bacnet Point Manager view:

Step 1. Navigate to Config > Drivers > Bacnet Network.

Step 2. Expand BacnetNetwork > Controller, right click on a Points > Views> Irm 
Bacnet Point Manager.

Fig. 12   Controller Point View

Table 7   Irm Bacnet Point Manager Description

Component Description

Irm Bacnet Point Manager

The Irm Bacnet Point Manager allow to discover and add 
BACnet points when the controller is online. The default 
view for the BACnet points extension is the IRM Bacnet 
Point Manager. 

• To sort objects click on any column header. To group 
like type objects together, sort by Object ID (BACnet 
object type).

• To select other properties (apart from Present_Value) 
as a candidate to proxy, click the plus (+) icon to 
expand the object.

For more details about configuring Irm Bacnet Point 
Manager, refer to below ORD in the Niagara help.
module://docBacnet/doc/ControllerConfiguration-
C76D113B.html
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Controller IP Settings
IP Settings allows configure IP setting and network time server for multiple IP/ MSTP VAV 
controller from a single window. For more details about configuring controller IP Settings, 
refer to Configure MSTP VAV Controllers on page 125.

Step to open controller IP Settings property sheet:

Step 1. Navigate to Config > Drivers > Bacnet Network.

Step 2. Expand BacnetNetwork > Controller > right-click IP Settings > Views> 
AX Property Sheet. 

Fig. 13   IP Settings Property Sheet
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Controller BLE Configuration
The Bluetooth configuration allows to configure bluetooth setting for IP/ MSTP VAV 
controllers. This feature allows enabling or disabling the Bluetooth functionality and 
setting up a Bluetooth password.

For more details about configuring controller BLE Configuration, refer to Bluetooth 
Configuration on page 222.

Step to open controller BLE Configuration property sheet:

Step 1. Expand BacnetNetwork > Controller > right-click BLE Configuration > Views> 
AX Property Sheet.

Fig. 14   Controller BLE Configuration

The following are the actions you can perform from BLE Configuration.

Table 8   BLE Configuration Actions

Actions Description

Write BLE Configuration To 
Device

To send the Bluetooth configuration modifications to
the controller.

Read BLE Configuration From 
Device

To read the Bluetooth configuration from the 
controller.

Generate Passcode
To set a passcode for the connected Bluetooth
controller, which helps you to authenticate the 
correct controller.
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IRM Program 

Fig. 15   IRM Program Folder

Following are the available components in IRM Program.

Table 9   IRM Program Folder 

Components Description

Control Manager To configure controller or application property.

Periodic Program To create a control strategy program running cyclically on a fixed 
time base.

Event Program To create a event-driven control strategy running during event 
program executed.

Onboard IO To configure hardware configuration of the application with the 
physical points.

Alarms To configure the extension for BACnet event notifications (alarms) 
sent to the station by that device.
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Irm Program View
Step to open Irm Program View:

Step 1. Expand BacnetNetwork > Controller > right-click IRM Program > Views.

Fig. 16   Irm Program View

The following are the views available in the IRM Program.

Table 10   IRM Program View

Components Description

Irm Wiresheet
The Irm Wiresheet is the location where the Control 
Manager, Periodic and event program objects, as well as 
the Onboard IO and Alarms are programmed.

Sylk Parameter Summary Provides a summary of the Sylk parameters which are 
programmed.

Sylk Device Summary Provides a summary of every Sylk device which is 
programmed.
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Irm Program Actions
Step to open Irm Program actions:

Step 1. Expand BacnetNetwork > Controller > right-click IRM Program > Actions.

Fig. 17   Irm Program actions

Following are the actions you can perform in IRM Program.

Table 11   IRM Program Actions

Actions Description

Reset Overrides This action is used to clear the overrides on all the function 
blocks.

Ping To verify the connectivity between engineering tool and 
controller.

Teach To Controller Download application changes in the project to the device(s); 
select to ‘overwrite BACnet objects in’ device OR application.

Teach Full Application 
To Controller

Downloads the whole application to the device(s); select to 
‘overwrite BACnet objects in’ device OR application

Learn from Controller Uploads the current application from the device(s) in the 
project. 

Check Hw 
Compatibility

Compares the hardware used in the controller and the 
hardware defined for in the application can be verified. 
Any differences are indicated on the Hw compatibility job log.
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Check Application 
Compatibility

Compares the application to determine if it is compatible with 
the hardware chosen

Clear Controller Deletes the application from the controller.

Clear Project Deletes the application from the selected device(s).

Take Snapshot Allows for a backup and restore with the current status of an 
application.

Restore Snapshot Allows for user to restore from a previous snapshot.

Swap A swapped device is frozen and saved to a project repository on 
the PC hard drive.

Set Controller 
Password Allows user to set a password in the controller.

Reset Tool Password Allows user to reset the password in the controller.

Ping Sylk Devices Verifies and displays the Sylk device status based on the device 
connected to the network at the configured address.

Validate Sylk Device Verifies and displays the Sylk device status based on the device 
connected to the network at the configured address.

Toggle Parameter 
Default Action 
Visibility

To hide or show parameter default action. 

Update All Bacnet 
Object Values from 
Controller to 
Application

Verifies and displays the Sylk device status based on the device 
connected to the network at the configured address.

Replace Text A Block 
and Ws Text Blocks 
with Irm Ws Text Block

Convert any TextA Function Block to the IRMWsTextBlock 
Function Block.

Table 11   IRM Program Actions (Continued)

Actions Description
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Control Manager View
The figures below show the areas which may need to be configured, depending on the 
controller model. After adding a new controller into the database, you can edit the 
controller model.

Open the Control Manager view:

Step 1. Expand the controller, expand IRM Program, and double-click on Control 
Manager.

Fig. 18   Control Manager View
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The following are the properties you can configure in the Control Manager.

Table 12   Control Manager Task Description

Task Description

Device Model Name Select device model from the drop-down list.

Controller Connection
Set the controller connection from the drop-down list.

• Offline 

• Bacnet

Teaching Mode

Set the teach mode from the drop-down list.

• Immediate: Changes are written to the controller 
automatically and immediately.

• On Demand: Changes are written to the controller 
manually and explicitly when the Teach to Controller 
operation is performed.

Note: For both teaching modes, only the changes are written 
to the controller; hence the process is very fast.

Measurement Type

Set engineering units from the drop-down list.

• SI-metric: To set measuring unit as SI-Metric, select 
Measurement Type as SI-Metric and Air Flow Unit as 
Cubic Meter Per Hour or Liter Per Second.

• Imperial: To set measuring unit as Imperial, select 
Measurement Type as Imperial and Air Flow Unit as 
Cubic Meter Per Hour.

Air Flow Unit Set airflow units from the drop-down list.

Drop of Bacnet Output

Set the type of reference point, reference input, or output is 
created when dropping a Bacnet output from another 
device. 

• Create Ref Output: Allows you to specify Bacnet output 
as Ref output that are shared with another controller.

• Create Ref Input: Allows you to specify Bacnet output as 
Ref input that are shared with another controller.

Drop of Bacnet Value

Set the type of reference point, reference input, or output is 
created when dropping a Bacnet value point from another 
device.

• Create Ref Output: Allows you to specify Bacnet value 
as Ref output that are shared with another controller.

• Create Ref Input: Allows you to specify Bacnet value as 
Ref input that are shared with another controller.

Custom Sensor Config 
Details

If the sensor does not meet any standard characteristics of 
the available sensors, you can select the type as a custom 
sensor and set its characteristics. 

Custom Sensor 1: 
Enable

Select true to enable the selected custom sensor 
configuration



IRM SYSTEM ENGINEERING GUIDE 42

Custom Sensor 
Config Data: 
Sensor Name

Enter the name of the sensor.

Custom Sensor 
Config Data: 
Sensor Type

Select sensor input (current, voltage, and resistive) from the 
sensor type drop-down menu.

Custom Sensor 
Config Data: 
Specification Unit

Select the specification unit option from the drop-down 
menu depends upon the data type selected while 
configuring the details on the add window.

Day Light Savings Configure the daylight setting.
Day Light Savings: 
Enable Set true to enable the day light saving feature.

Day Light Savings: 
Start Month Set the start month (January - December).

Day Light Savings 
Stop Month Set the end month (January - December).

Day Light Savings: 
Start Day Set the start week (Week Day 1 - Week Day 31).

Day Light Savings: 
Stop Day Set the end week (Week Day 1 - Week Day 31).

Day Light Savings: 
Start Time Set the start time in hours (0 - 23).

Day Light Savings: 
End Time Set the end time in hours (0 - 23).

Day Light Savings: 
Off Set Minutes Set the off set time in minutes (0 - 240).

Application Details 
Config: Application 
Type

Choose VAV Zone Terminal Single Duct Application from 
drop-down.

Note:  Must click save before you can choose the features 
required.

Application Details 
Config: Application 
Feature

Select the application feature.

Global Balancing 
Object

Map the balancing objects with Bacnet Objects.

Note:  Global balancing object are within the firmware of the  
IP/MSTP controller only. If creating a custom 
application or using a migrated venom application, 
links will need to be made from the global balancing 
object to the application to use the Honeywell global 
balancing tool.

Table 12   Control Manager Task Description (Continued)

Task Description
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Control Manager Actions
Steps to open Control Manager actions:

Step 1. Navigate to Config > Drivers > Bacnet Network.

Step 2. Expand BacnetNetwork > Controller > IRM Program > right-click 
Control Manager > Actions.

Fig. 19   Control Manager actions

Following are the actions you can perform on Control Manager.

Table 13   Control Manager actions

Action Description

Reset Live Updates If the wiresheet doesn't appear to display the latest data,
perform a Reset Live Updates.
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Application Details
The Application Details allows you to create a version for the application.

Steps to open Application Details property sheet:

Step 1. Expand BacnetNetwork > Controller > IRM Program > Control Manager > 
right-click Applications Details > Views> AX property.

Fig. 20   Application Details Property Sheet

The following are the actions you can perform on Application Details.

After configuring application details, perform Teach To Controller.

Table 14   Control Manager actions

Action Description

Application Name Enter the name of the application.

Application Version

Major Version Enter the major value between 0 and 255.

Minor Version Enter the minor value between 0 and 255.

Build Version Enter the build value between 0 and 255.

Patch Version Enter the patch value between 0 and 255.
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Flash Memory Exceeded FBs & IRM Folders
The Flash Memory Exceeded FBs & IRM Folder list the details of the Function block, Irm 
folders, or subfolders configuration that exceed the defined memory limit (900 bytes).

Steps to open Flash Memory Exceeded FBs & IRM Folders property sheet:

Step 1. Expand BacnetNetwork > Controller > IRM Program > Control Manager > 
right-click Flash Memory Exceeded FBs & IRM Folders > Views> AX property.

For more details about Flash Memory Exceeded FBs & IRM Folders, refer to the Flash 
Memory Exceeded FBs & Irm Folder on page 72.

Fig. 21   Flash Memory Exceeded FBs & IRM Folders Property Sheet
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Sylk Details
After configuring the Sylk devices on the wire sheet, you may check the power consump-
tion, Sylk proxy file size, and host Sylk config file size of the configured Sylk devices.

Steps to open Sylk Details property sheet:

Step 1. Expand BacnetNetwork > Controller > IRM Program > Control Manager > 
right-click Sylk Details > Views> AX property.

For more details about the Sylk Details, refer to the Sylk Details on page 73.

Fig. 22   Sylk Details Property Sheet

The following are the actions you can perform on Sylk Details property sheet.

Table 15   Sylk Details Actions

Action Description

Total Sylk Power 
Consumption

Perform this option in case the wiresheet does not show 
the updated values.
The accumulated Sylk power will be displayed here.

Is Sylk Configuration 
Downloaded

The flag is indicating whether Sylk configuration has 
downloaded to controller or not.

• True: When the Sylk configuration needs to download.

• False: When the modified Sylk configuration needs to 
be downloaded. 

Host Sylk Config File Size The total file size of the Sylk configuration.

Sylk Proxy File Size Only shows proxy file size, which has to be downloaded to 
the controller.
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Custom Sensor Config View
If the sensor does not meet any standard characteristics of the available sensors, you can 
select the type as a custom sensor and set its characteristics.

Steps to open Custom Sensor Config Details property sheet:

Step 1. Expand BacnetNetwork > Controller > IRM Program > Control Manager > 
right-click Custom Sensor Config Details > Views> AX property.

For more details about configuring the Custom Sensor Config Details, refer to the Custom 
Sensor Configuration Details on page 74.

Fig. 23   Custom Sensor Config Details Property Sheet

The following are the actions you can perform on Custom Sensor Config Details property 
sheet.

Table 16  Custom Sensor Config Details Property Sheet

Name Description
Enable Select true to enable the selected custom sensor configuration.
Sensor Name Enter the name of the sensor.

Sensor Type Select sensor input (current, voltage, and resistive) from the sensor 
type drop-down menu.

Sub Type Select a sensor type from the sub-type drop-down menu.

Specification 
Unit

The specification unit option in the drop-down menu depends upon 
the data type selected while configuring the details on the add window.

Linearization
The linearization field, where the linearization points are provided to 
define the characteristics of the sensor. The tabular conversion dialog 
window is displayed.

Sensor Low 
Limit

Set the lower limit the of the sensor as per project requirement.
Note: The configured lower limit should not be below than the sensor's 

manufacturer low limit.
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Sensor High 
Limit

Set the high limit the of the sensor as per project requirement.
Note: The configured high limit should not be exceed than the sensor's 

manufacturer high limit.

Sensor 
Reading 
Output Limits

Select the value for sensor reading output limits from the respective 
drop-down menus. 

• Value Is Invalid Outside High And Low Limit: when output 
crosses the limit, the output becomes invalid. 

• Clamp Value To High And Low Limits: when output crosses 
the high limit or low limit, and the output is clamped to a low or 
high limit; it doesn’t become invalid.

• Continue Linearization Without Clamp: when the user wants 
to continue sensor reading outside the high limit.

Offset Offset is the precision limit of the curve.

Validation 
Text

This field verifies the configuration of the custom sensor. If any of the 
fields are not configured, it will display a message.

Table 16  Custom Sensor Config Details Property Sheet

Name Description
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Day Light Savings View
The daylight saving setting is a part of the control manager, and it enables when Day Light 
Saving comes into effect.

Steps to open Day Light Savings View property sheet: 

Step 1. Expand BacnetNetwork > Controller > IRM Program > Control Manager > 
right-click Day Light Savings View > Views> AX property.

For more details about configuring the Day Light Savings View, refer to the Day Light 
Savings settings on page 78.

Fig. 24   Day Light Savings View Property Sheet

The following are the actions you can perform on Day Light Saving property sheet.
Table 17  Day Light Saving Property Sheet

Task Description
Enable Select true to enable the day light saving feature.
Start Month Select the start month of day light saving (January - December).

End Month Select the end month of day light saving (January - December).

Start Day Select the start week of day light saving (Week Day 1 - Week Day 31).

End Day Select the end week of day light saving (Week Day 1 - Week Day 31).

Start Time Set the start time of day light saving in hours (0 - 23).

End Time Set the end time of day light saving in hours (0 - 23).

Off Set Minutes Set the off set time for day light saving in minutes (0 - 240).
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Global Balancing Object
The Global balancing objects are part of the engineering tool. The application allows you to 
configure the balancing object according to the project requirements and generates a bal-
ancing data report. 

Steps to open Global Balancing Object property sheet: 

Step 1. Expand BacnetNetwork > Controller > IRM Program > Control Manager > 
right-click Global Balancing Object > Views> AX property.

For more details about configuring the Global Balancing Object, refer to the Global 
Balancing Object on page 370 .

Fig. 25   Global Balancing Object Property Sheet
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The following are the available balancing points in Global Balancing Object property sheet.

Table 18  Global Balancing Object Description

Balancing 
Point Name 

Object 
ID 

Point 
Type 

Object 
Mapping Description

Device 
Balance State 600 N/A No

Indicates whether or not the 
device is balanced. After balancing 
is complete, the controller sets 
this value.

K Factor 601
BACnet 
numeric 
value

Yes

Flow pickup factor, as determined 
by the field engineer. This 
parameter can be ignored if the 
Manufacturer K factor is used.
The controller's default value is 
0.813.

Damper Type 602 N/A No
The input cannot be changed by 
the user. Floating is the default 
setting.

Damper 
Control Type 603

BACnet 
Enum 
value

Yes Direct "CW" or Reverse "CCW" 
floating actuator configuration.

Drive Time 604
BACnet 
numeric 
value

Yes Drive time for a floating actuator.

Duct Area 606
BACnet 
numeric 
value

Yes Area of the VAV box duct.

Measured 
Max Flow 607 N/A No

When performing maximum 
balancing, the maximum flow is 
measured.

Measured 
Min Flow 608 N/A No When performing min balancing, 

the minimum flow is measured.

Set Point Max 
Flow 609

BACnet 
numeric 
value

Yes Setpoint for maximum flow in a 
VAV box.

Set Point Min 
Flow 610

BACnet 
numeric 
value

Yes Setpoint for the minimum flow in a 
VAV box.

Device Zeroed 
State 611 N/A No VAV Box zero balancing state. 

Temperature 
Compensatio
n

612 N/A No The input cannot be changed by 
the user.
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Balancing 
Method 613 N/A No

Method of balancing: Setpoint 
balancing, K factor balancing or 
Min-Max balancing.
In the IO terminal view, the user 
can obtain the same status for the 
Air flow sensor function block.
All the fields are Read-only. 

Set Point 
Single Flow 614 N/A No

Setpoint used by user when 
performing setpoint or K factor 
balancing. 
All the fields are Read-only. 

Measured 
Single Flow 615 N/A No

Measured air flow entered by user 
when performing setpoint, K factor 
balancing.
All the fields are Read-only. 

Corrected K 
Factor 616 N/A No

Corrected K factor for flow 
setpoint balancing.
All the fields are Read-only. 

Current 
Sensed Air 
Flow

618 N/A No Current sensed air flow.
All the fields are Read-only. 

Damper 
Manual 
Position

620 N/A No
Manual position entered by user 
to move the damper.
All the fields are Read-only. 

Damper 
Manual Flow 621 N/A No

Manual flow entered by user to 
move the damper.
All the fields are Read-only. 

Balancing 
Type 622 N/A No

Indicates balancing type 
performed.
All the fields are Read-only. 

Damper 
Position 623 N/A No

Current damper position when 
performing balancing. 
All the fields are Read-only. 

Clear Balance 624 N/A No Clear balancing command. 
All the fields are Read-only. 

Sensed Max 
Flow 626 N/A No

Maximum sensed flow when 
performing balancing.
All the fields are Read-only. 

Sensed Min 
Flow 627 N/A No

Minimum sensed flow when 
performing balancing.
All the fields are Read-only. 

Sensed Single 
Flow 629 N/A No

Sensed flow when performing 
setpoint or K factor balancing. 
All the fields are Read-only. 

Table 18  Global Balancing Object Description (Continued)

Balancing 
Point Name 

Object 
ID 

Point 
Type 

Object 
Mapping Description
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Setpoint 
Tolerance 630 N/A No

Tolerance set by user when 
performing balancing. 
All the fields are Read-only.

Sync 
Direction 631 N/A No

Sync direction 0 % or 100 % when 
synchronizing the damper before 
balancing. 
All the fields are Read-only.

Zero Process 
Status 632 N/A No Zero balancing process status.

All the fields are Read-only.

Sync Status 633 N/A No Damper sync status. 
All the fields are Read-only.

Action 
Elapsed Time 634 N/A No Action elapsed time. 

All the fields are Read-only.

Manufacturer 
K Factor 635

BACnet 
numeric 
value

Yes Manufacturer K factor.

K Factor 
Offset 636

BACnet 
numeric 
value

Optional
Offset value calculated after 
performing setpoint or K factor 
balancing.

Pressure 
Offset 637

BACnet 
numeric 
value

Optional Pressure offset value calculated 
after performing zero balancing.

Reheat Ovrd 638
BACnet 
numeric 
value

Yes
Override point used to command 
reheat valve when performing 
water balancing.

Reheat Eff 
Pos 639

BACnet 
numeric 
value

Optional Effective status read point to 
display in balancing tool.

Periphheat 
Ovrd 640

BACnet 
numeric 
value

Yes
Override point used to command 
peripheral valve when performing 
water balancing.

Periphheat 
Eff Pos 641

BACnet 
numeric 
value

Optional Effective status read point to 
display in balancing tool.

Vav Fan Spd 
Ovrd 642

BACnet 
numeric 
value

Yes Command point to override the 
fan start or stop or fan speed.

Vav Sys Type 643 N/A No

VAV system type used by 
controller to enable reheat, 
peripheral heat or fan override 
options. 
All the fields are Read-only.

Table 18  Global Balancing Object Description (Continued)

Balancing 
Point Name 

Object 
ID 

Point 
Type 

Object 
Mapping Description
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Synchronizing Controller Time
This feature sends a synchronization message from the Supervisor station to selected 
BACnet devices on the network. This resets the time of host controllers to the same time.

Open Synchronizing Controller Time property sheet: 

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.
Step 2. Select the controller from the device list and click TSynch.

Fig. 26  Database Pane

Step 3. Click Yes to confirm.

Fig. 27  Dialogue Box

As per the supervisor's workbench, the controller's time is updated.
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Teach and Learn Operation Guidelines
Synchronization can be performed in two ways:

• Teaching to Controller: Downloads the application modification from the project to 
the controller.

• Learning from Controller: Uploads the changes from the controller to the project.

When in teaching mode, application changes of the project can be written to the controller 
in two ways:

• Immediate: Changes are written to the controller automatically and immediately.
• On demand: Changes are written to the controller manually and explicitly when the 

Teach to Controller operation is performed.

Fig. 28  Teaching Mode

The explicit usage of the teaching and learning actions and the time when an action is used 
depends on the application status in the project and the connected controller, and the 
result you want to achieve.

Important: When working on the application, the control manager detects every modification and is 
indicated graphically by a yellow warning symbol that replaces the original symbols at the 
modified item on the wire sheet and in the tree. 

This feature is applicable when the Teaching mode is set to On demand. If the teaching mode 
is set to Immediate, the changes are not indicated graphically in the workbench since they are 
written instantly to the controller.

Important: If the cut-paste or copy-paste action is performed on multiple functional blocks in the 
Immediate mode, the modification causes the project to go in Out of Sync. In that scenario, 
you need to perform teach to controller. Whenever moving or copying multiple function blocks 
from one folder to another, it is advised to be in On demand mode.

Recommendations for an empty controller (factory delivery, cleared, no application) or 
controller have a history (engineered with application). Make sure to ask the following 
questions before performing engineering on the controller.

• Do you want to keep the application in the controller or the project? 
• Do you want to change the application in the project and teach it to the controller?
• Do you want to learn an application from the controller to the project?

Important: If you want to keep the application in the project, learn the controller application. Clear the 
controller histories before performing learn from controller operation; it will prevent the 
destruction of the application in the project. 

Note: If there are too many changes in the project or the controller, learn and teach operation does 
not work. The engineering tool displays appropriate messages which describe the status and 
how to proceed.
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OVERVIEW OF THE ENGINEERING 
TOOL

This chapter describes the BACnet device's properties and the control manager's compo-
nents. Additionally describes the procedure to configure and perform synchronization 
check on the periodic program, event program, and On board IO in the engineering tool.

Bacnet Device Property Sheet
Steps to configure Bacnet Device property:

Step 1. Double-click the IRM in the Nav tree.

Fig. 29  IRM device property sheet
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Table 19  IRM device Properties Details

Property Description

Status This field is read-only and displays the physical status of the port (OK or fault).

Enabled Allows the user to enable or disable the IRM NX controller.

Fault Cause Indicates why a system object (network, device, component, extension, etc.) is not 
working properly {in fault}. This property is empty unless a fault exists.

Health

Reports the status of the network, device, or component. This advisory information 
includes a time stamp and helps you recognize and troubleshoot problems, but it 
provides no direct management controls.

• Down: Displays network’s health (true or false).
• Alarm: Contains a set of properties for configuring and routing alarms when 

this component is the alarm source.
• Last OK Time: Displays the network’s last ok time.
• Last Fail Time: Displays the network’s last fail time.
• Last Fail Cause: Displays the network’s last fail cause.

Fig. 30  Controller Health Properties

Alarm Source 
Info

This container slot is available on all network and child device components. The slot’s 
properties populate the alarm record when the network or device does not respond to 
a monitor ping. This ping is configured at the network level.
Each parent and a child device object has its alarm source info slot with identical (but 
independently maintained) properties.

Address

Specifies the data link layer MAC address of the device.

Fig. 31  Address Property

For the IP devices, the address is an IP address: 0xBAC0 or 47808. 
For the MSTP devices, it is an 8-bit address (0 - 254) unique on its RS-485 trunk.

Points

The BACnet point device ext (points folder in the Nav tree) is the BACnet 
implementation of the pointdeviceext, a frozen container under every BacnetDevice. 
Its primary view is the Bacnet Point Manager.
BACnet proxy points are similar to other driver proxy points. 

Virtual
A virtual gateway is a component located under the station's component space and 
provides access to the station's virtual component space. 
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Alarms

Each BACnet device has an alarms device extension. This extension applies to BACnet 
event notifications (alarms) sent to the station by that device.

Fig. 32  Alarms Property

To view the alarm properties, expand BacnetNetwork > Sypder Model 5 or Sypder 
Model 7 Device > double-click on the Alarms in the Nav tree.

Schedules

This component is the implementation of a schedules device extension. 
A device’s schedules extension is the parent container for imported schedules 
components with a ScheduleImportExt (the schedule imports events from the remote 
station). The imported schedule is read-only. By default, the schedules extension 
contains a Retry Trigger.

Fig. 33  Schedule Property

• Retry Trigger: Appears in the Nav tree but not in any manager view. The Retry 
Trigger is unique because it requires no linking of its output for operation. If the 
schedule import descriptor fails, the Retry Trigger defines show frequently to 
attempt the import again (the default value is every 15 minutes). This continues 
until successful execution occurs.

• Subscribe Window: Sets up a period of time during which the subscription is 
possible.

• Skip Write On Error: Configures what happens when an error occurs, true skips a 
write when an error occurs, and false always write the record.

Table 19  IRM device Properties Details (Continued)

Property Description
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Trend Logs

This component is a frozen device extension under every BACnet device and the 
container for “Bacnet History Import” components. The default view is the Bacnet 
History Import Manager, used to import data from trend log objects in the device into 
the station as histories.
The directory under the BacnetNetwork > BacnetDevice node in the Nav tree serves 
as the container for BACnet history objects, which you import from a device into a 
station.
A BACnet device must contain trend log objects (and/or trend log multiple objects) to 
use histories. A discover command determines this. The trend logs extension has no 
practical application if it finds no such objects.
This component also has a Retry Trigger for automatic usage as needed by default. 
The default view of this component is the Bacnet History Device Ext.

Fig. 34  Trend Logs Property

Config

This frozen device extension under every BACnet device functions as the container for 
config-type objects, representing individual BACnet objects in the device. By default, it 
contains a BACnet object.

Fig. 35  Config Property

Table 19  IRM device Properties Details (Continued)

Property Description
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Enumeration 
List

Contains the list of the BACnet properties that can be exported to configure the data 
exchange. The list provides access to each property's configuration facets.

• To check the Enum list, expand the Bacnet Network and double-click on Bacnet 
Device. 
In the BACnet device property sheet, you can check the Enumeration List

Fig. 36  Enumeration List

Use Cov

Enables and disables a device’s support for COV (change of value) as a way to monitor 
proxy point values.
True triggers the driver to attempt the necessary updates (proxy subscriptions) to the 
value of each point. If the subscription attempt succeeds, the read status property of 
the point’s BacnetProxyExt displays the change of value. If the subscription attempt 
fails, the driver uses normal polling, and the read status property shows as polled.
When true, individual proxy points under the device may use COV subscriptions 
depending on their assigned tuning policy.
When false, the driver ignores any proxy subscription updates.
How to find: 

• Expand the Bacnet network > Bacnet device. Also available on the Device 
Manager Add window.

Table 19  IRM device Properties Details (Continued)

Property Description
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Use Cov 
Property

If enabled, and the assigned proxy points are under a BACnet device that supports 
confirmed COV notifications, the driver attempts any necessary updates (proxy 
subscriptions). If disabled (false), the driver ignores this property.
How to find: 

• Expand Config > Drivers >Bacnet network >Tuning Policies > Default Policy.

Max Cov 
Subscription

Specifies the maximum number of change of value (COV) subscriptions that the 
database attempts to use with this device. This restriction prevents the station from 
consuming all of the available subscription space in the device. Applies only if use Cov 
is true.

Cov 
Subscription Reports number of active change of value (COV) client subscriptions to the device.

Character Set
Defines the character set supported.

Location: Expand the Bacnet network > Bacnet device.

IP Setting

IP setting comprises IP Configuration and Network Time Server. The IP configuration 
operation allows to configure IP for multiple IP VAV and Unitary controllers from a 
single window. This feature enables you to perform a variety of productivity operations 
such as batch IP configuration updates, auto-increment of IP addresses, visual 
indication of IP address changes, user errors in IP configuration, and offline and 
online IP configuration.
This configuration interface is used for any wired IP connections made via one of the 
controller's Ethernet Switch primary or secondary connectors.
The Network Time Server allows you to configure the Network Time Server address. 
For more details refer, to Configure MSTP VAV Controllers on page 125.

BLE 
Configuration

BLE configuration enables batch configuration of IP controllers.
This feature allows you to perform operations such as enabling or disabling the BLE 
function. and setting the password. For more details, refer to Bluetooth Configuration 
on page 222.  

Table 19  IRM device Properties Details (Continued)

Property Description
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Control Manager
The control manager allows you to configure properties according to the controller model. 
You can edit the controller model after adding a new controller into the database.

Steps to open the Control Manager:

Step 1. In the Nav tree, expand the IRM Program folder. 

Step 2. Double-click the Control Manager icon.

Fig. 37  Control Manager property sheet

Table 20  IRM Control Manager Property 

Name Description

Author of the application Name of the controller or building.

Description Description of the controller or building.

Device Model Name Select device model from the drop-down list.
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Application Type Read-only. Type of application.

Application Details

Read-only. Displays the application name and version details.

Fig. 38  Application Details

Function Block Family Read-only. Displays the name of the function block family.

Function Block Version Read-only. Displays the function block version.

Number of Folders

Read-only. Displays the number of folders.

• Maximum 32 Irm folders overall (IRM CVAV/FCU controller).

• Maximum 100 Irm folders overall (IP/MSTP VAV controller).

Number of Function 
blocks

Read-only. Displays the number of function blocks.

Number of Links. Read-only. Displays the number of links.

Memory usage Read-only. Shows the device's memory usage, application, and parameters in 
percentage and graphically.

Flash Memory Exceeded 
FBs & IRM Folders

The Flash Memory Exceeded FBs & Irm Folder list the details of the Function 
block, Irm folders, or subfolders configuration.

Controller Hardware 
features Read-only. Displays the I/O configuration (online available in online mode).

Hardware Compatibility Read-only. Indicates whether the terminal layout of the application is 
compatible with the hardware layout of the physical controller.

Controller Connection

Allows selecting the connection type among network:

• Offline 

• Bacnet

Table 20  IRM Control Manager Property  (Continued)

Name Description
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Teaching Mode

Use the drop-down list to set the teach mode between On demand and 
Immediate, refer to Teach and Learn Operation Guidelines on page 55.

• Immediate: Changes are written to the controller automatically and 
immediately.

• On Demand: Changes are written to the controller manually and 
explicitly when the Teach to Controller operation is performed.

Fig. 39  Configuring Teaching Mode

Note: For both teaching modes, only the changes are written to the controller; 
hence the process is very fast.

Measurement Type

Use the drop-down list to set engineering units.

• SI-metric: To set measuring unit as SI-Metric, select Measurement 
Type as SI-Metric and Air Flow Unit as Cubic Meter Per Hour or Liter Per 
Second.

• Imperial: To set measuring unit as Imperial, select Measurement Type 
as Imperial and Air Flow Unit as Cubic Meter Per Hour.

Fig. 40  Measurement Type 

Air Flow Unit

Use the drop-down list to set airflow units.

Fig. 41  Air Flow Unit

Table 20  IRM Control Manager Property  (Continued)

Name Description
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Drop of Bacnet Output

Defines which type of reference point, reference input, or output is created 
when dropping a Bacnet output from another device. 

Fig. 42  Drop of Bacnet Output

• Create Ref Output: Allows you to specify Bacnet output as Ref output 
that are shared with another controller.

• Create Ref Input: Allows you to specify Bacnet output as Ref input that 
are shared with another controller.

Drop of Bacnet Value

Defines which type of reference point, reference input, or output is created 
when dropping a Bacnet value point from another device.

Fig. 43  Drop of Bacnet Value

• Create Ref Output: Allows you to specify Bacnet value as Ref output 
that are shared with another controller.

• Create Ref Input: Allows you to specify Bacnet value as Ref input that 
are shared with another controller.

Is Synchronized
Read-only. Indicates whether the project and the controller are synchronized 
(yes) or not (no).

Synchronization status

Displays the controller's or project's current synchronization status. The 
engineering tool has the following available status:

• Unknown: This status is displayed under the following circumstances:

• When the device is not connected to the internet.

• When full teach is triggered, the controller is swapped in until the full 
teach is completed.

• In Sync: This status is displayed when there is no difference between the 
station and the controller.

• Out Of Sync: This status is read-only and displayed when a modification in 
the project differs from the controller or vice versa.

Table 20  IRM Control Manager Property  (Continued)

Name Description
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• Controller differs from Project: This status is read-only and displayed 
when some changes happen in controllers, simulated by having two 
stations having the same controller. 

• From station 1, perform full teach to the controller and mark the 
controller In Sync, stop station 1 and start station 2. 

• From station 2, teach another application to the same controller. Stop 
station 2 and reopen station 1 and check the sync status.

• Project has modifications: This status is displayed when a station is 
modified.

• Project is empty: This status is displayed when the clear project operation 
is performed from the IRM Bacnet Device Manager view (only for swapped 
In) or from IRM Program.

• Controller is empty: This status is displayed when the clear project and 
clear controller operation is performed from the IRM Bacnet Device 
Manager view (only for swapped In) or from the IRM Program.

• Controller and Project empty: This status is displayed when the clear 
project and clear controller operation is performed from the IRM Bacnet 
Device Manager view (only for swapped In) or from the IRM Program.

• BACnet Object configuration changed: This status is displayed when the 
BACnet points in the application is modified.

• Project modified and BACnet Object config. changed in controller :This 
status is displayed when the project is modified and BACnet changes occur 
in the controller.

Last program change Read-only. Displays the date of the last program change.

Last Commissioned Read-only. Displays the date of the last commissioning.

Modbus Baud Rate Modbus devices must have an identical baud rate, an identical parity, and an 
identical number of stop bits, refer to Modbus Engineering on page 323.

Modbus Parity Modbus devices may have a configurable parity. For more details, refer to 
Modbus Engineering on page 323.

Modbus Stop Bits

If Modbus Parity = None, select Modbus Stop Bits = “2”.
If Modbus Parity = Even or Odd, select Modbus Stop Bits = “1”.
For more details, refer to Modbus Engineering on page 323.

Fig. 44  Modbus Stop Bits

Sylk Details Displays Sylk Device usage details. For more details, refer to Sylk Details on 
page 73.

Custom Sensor 
Configuration

If the sensor does not meet any standard characteristics of the available 
sensors, you can select the type as a custom sensor and set its characteristics, 
for more details refer to Custom Sensor Configuration Details on page 74.

Table 20  IRM Control Manager Property  (Continued)

Name Description
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Daylight Saving This feature is integrated when the daylight setting is enabled, refer to Day 
Light Savings settings on page 78.

Application Details 
Config

The “Application Details Config” allows you to configure the legacy VAV 
templates which uses standard BACnet object based of VAV balancing 
procedure. Using “Application Type” and “Application Feature” you can set up 
the VAV balancing using standard BACnet object.

Fig. 45  Application Details Config

Note:  Only the "VAVZone Terminal Single Duct Application Remaining" 
application type is available for balancing; all other application type 
options under "Application Type" are non - functional. It's there for future 
developments.

Note: It recommended not to use Application Details Config when you use 
Global balancing tool or VAV balancing mobile app for balancing Global 
balancing objects.

Example: 

• In the below example the “VAV Zone Terminal Single Duct Application” is 
selected without peripheral reheat valve override so in the balancing view 
peripheral valve override option is hidden.

Fig. 46  VAV Balancing View

Table 20  IRM Control Manager Property  (Continued)

Name Description
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• In the below example the “VAV Zone Terminal Single Duct Application” is 
selected with “Peripheral reheat valve override” and “Reheat valve Override” 
so in the balancing view both the features are displayed.

Fig. 47  Application Details Config

Table 20  IRM Control Manager Property  (Continued)

Name Description
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Memory Usage
The memory (RAM) of the controllers varies based on the memory utilized by the device, 
application, and parameters. 

You can use the memory usage parameters to check the memory consumption of the 
current application. This is an approximate calculation of the application in the tool but not 
a real-time consumption within the controller.

To check the memory usage of IRM Bacnet device.

Step 1. Expand the Bacnet Network > Irm Bacnet device > IRM Program and double-
click on Control Manager.
In the control manager property sheet, you can check the memory usage of the 
BACnet device

Fig. 48  Memory Usage parameters

The memory usage parameters also displays the application or client data's memory 
(Function Block Name, Irm Folder Name, Annotation, Subfolder Count, Composite Flash 
Memory) for the whole application. Under client data, you can see the distribution of client 
data memory usage.

• Memory Usage: Memory utilized by the application folders.

• Function Block Name/Annotation/Composite Flash Memory Usage: Memory 
utilized by the function block folders.

The sum of memory utilized by the Irm folder client data and a Irm function block client 
data is sent to the controller. 

Note: Teach time can vary based on the Client Data memory usage, irrespective of the memory 
usage.

Table 21  Controller Memory Details

Controller Maximum Memory

CVAV/FCU controller 344 KB

IP/MSTP VAV controller 2 MB

Unitary 2 MB
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The memory usage can be viewed on the property sheets of the different levels:

To check the memory usage of the IRM program:

Step 1. Expand the Bacnet Network > Irm Bacnet Device > right-click IRM Program > 
Views > AX property Sheet.
In the IRM program property sheet, you can get the sum of memory utilized by 
applications, irmfolders, and functional blocks

Fig. 49  Irm Program AX property sheet

To check the memory usage of the periodic program:

Step 1. Expand the Bacnet Network > Irm Bacnet Device  > IRM Program > right-click 
Period program > Views > AX property Sheet.
In the periodic program property sheet, you can get the sum of memory utilized 
by applications, irmfolders, and functional blocks.

Fig. 50  Periodic Program Property Sheet

To check the memory usage of the IRM folder:

Step 1. Expand the Bacnet Network > Irm Bacnet Device  > IRM Program > Period 
program > right-click IrmFolder > Views > AX property Sheet.
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In the memory usage property sheet, you can get the sum of memory utilized by 
applications, irmfolders, irmsubfolders, and functional blocks.

Fig. 51  Irmfolder Property Sheet

Each controller model has a different maximum memory capacity

Sub Folder Count: This field is read-only and displays the number of sub-folder configured 
per Irmfolder.

Function Block Count: This field is read-only and displays the number of function blocks 
configured per Irmfolder.

Note: To optimize memory usage, keep the number of folders as low as possible and the number of 
function blocks per folder as high as possible. 

The calculated memory consumption will be indicated graphically and as a percentage in 
the traffic light symbol as follows:

To check the memory usage of the functional block:

Step 1. Expand the Bacnet Network > Irm Bacnet Device > IRM Program > Period pro-
gram > right-click functional block> Views > AX property Sheet.
In the memory usage property sheet, you can get the sum of memory utilized by 
applications functional block.

Fig. 52  Function Block AX Property Sheet

• Green > 80 %
• Yellow < 80 %
• Red > 90 %
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Flash Memory Exceeded FBs & Irm Folder
The Flash Memory Exceeded FBs & Irm Folder list the details of the Function block, Irm 
folders, or subfolders configuration that exceed the defined memory limit (900 bytes). 

To check the flash memory details of Irm Bacnet Device:

Step 1. Expand BacnetNetwork > Controller > IRM Program > Control Manager > 
Flash Memory Exceeded FBs & IRM Folders.
In the description you can check the Flash Memory Exceeded FBs & Irm 
Folder details.

Fig. 53  Flash Memory Exceeded FBs

Using the details from Flash Memory Exceeded FBs & Irm Folder section, you can verify the 
property sheet and re-configure the respective function block, Irm folders, or subfolders to 
meet the design limit. 

Fig. 54  Irm Folder
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Sylk Details
You can check the Sylk device power consumption, Sylk proxy file size, and host Sylk config 
file size of the configured Sylk device after configuring the Sylk devices on the wire sheet. 
Navigate to Sylk details under the control manage to view the details.

To check the Sylk details of Irm Bacnet Device:

Expand BacnetNetwork > Controller > IRM Program > Control Manager > Sylk Details.

Fig. 55  Sylk Details

In the Sylk details, you can check the total Sylk power consumption, host Sylk config file 
size, Sylk proxy file size, and the Sylk configuration downloaded status. 
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Custom Sensor Configuration Details
If the sensor you want use is not available in the predefined list, you can configure a custom 
sensor and use in the logic. 

Note: Users can configure up to ten custom sensor configurations in the engineering tool.

Custom sensor can be configured for these 3 types: current, voltage, and resistive

• Resistive Input: A resistive input point is an analog point which configures an UI to read 
resistance from 0 to 300,000 ohms. 

• Voltage Input: A voltage input point is an analog point that configures an UI to read a 
voltage signal from 0 to 10.3 Volt. 

• Current Input: A current input point is an analog point that configures an UI to read 
resistance from 0 to 20 mA.

Note: The note below is only applicable to IRM compact VAV controller.
To perform the current sensor type connection in the custom sensor configuration, connect 
an external 500 Ohm resistor to convert current to volt to measure 0 (2) to 20 mA, which works 
without hardware change.

0 (4) ... to 20 mA (via external 499 Ω / 0.25 % resistor).

Fig. 56  Current Sensor Type Connection

The following table describes the configuration properties and their definitions.
Table 22  Custom Sensor Property

Name Description
Enable Select true to enable the selected custom sensor configuration.

Sensor Name 
Configure the name for the custom sensor. Once the custom sensor is 
configured, user can identify the custom sensor using this name when 
configuration Analog Input.

Sensor Type Select sensor input (current, voltage, and resistive) from the sensor 
type drop-down menu.

Specification 
Unit

The specification unit option in the drop-down menu depends upon 
the data type selected while configuring the details on the add window. 
This is the sensor manufacture specified unit

Linearization
The linearization field, where the linearization points are provided to 
define the characteristics of the sensor. The tabular conversion dialog 
window is displayed.

Sensor Low 
Limit

Set the lower limit the of the sensor as per project requirement.
Note: The configured lower limit should not be below than the sensor's 

manufacturer low limit.



IRM SYSTEM ENGINEERING GUIDE 75

Steps to configure Custom Sensor:

Step 1. Navigate to IRM Bacnet Device > IRM Program and expand the Control Man-
ager details.

Step 2. Select the Custom Sensor Details and configure the fields.

Fig. 57  Custom Sensor Details
Step 3. Select Sensor Type as current, resistive, or voltage.
Step 4. Enter the Sensor Name.
Step 5. Select the Specification Unit from the drop-down list. 

Sensor High 
Limit

Set the high limit the of the sensor as per project requirement.
Note: The configured high limit should not be exceed than the sensor's 

manufacturer high limit.

Sensor 
Reading 
Outside 
Limits

This is used to configure the sensor output behavior based on the low 
and high limits and what should happen when the value falls outside 
of the limits

• Value Is Invalid Outside High And Low Limit: when output 
crosses the limit, the output becomes invalid. 

• Clamp Value To High And Low Limits: when output crosses 
the high limit or low limit, and the output is clamped to a low or 
high limit; it doesn’t become invalid.

• Continue Linearization Without Clamp: when the user wants 
to continue sensor reading outside the high limit.

Offset Offset value to add on top of value measured by the sensor. This field is 
used to correct the sensor reading errors

Validation 
Text

Used to report the errors in the custom sensor configuration, to enable 
user to correct the errors

Table 22  Custom Sensor Property (Continued)

Name Description
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Step 6. Click on the edit icon  next to the Linearization field.

Fig. 58  Tabular Conversion Dialog Box
Step 7. Click Add.Update the sensor source and target values as per the manufactures 

sensor specification sheet. 

Fig. 59  Tabular Conversion Dialog Box
Step 8. Enter the low and high limit sensor values in the Sensor Low Limit (sensor value 

at 0 mA) and Sensor High Limit (sensor value at 20 mA) fields respectively, as 
per sensor data sheet.
Similarly, enter a value for the sensor resistance and sensor voltage.

Step 9. Select the Sensor Reading Output Limits from the drop-down menu.
• Value is invalid outside High Limit option: If the output exceeds the limit, 

the output is becomes invalid.

• Clamp Value as High and Low Limit option: If the output crosses the high 
or low limit, it is locked to the low or high limit and remains valid.

• Continue Linearization Without Clamp option: If the user wants to 
continue the sensor reading outside the high limit.

Step 10. Enter the Offset value.
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Step 11. Click Save after entering the required details.
If any field is not configured, the Validation Text will display the error message.

Fig. 60  Custom Sensor Config Details

Once the custom sensor is configured, you can use these custom sensor configurations 
into the UI terminals of the controller. All the custom sensor configurations are available 
under characteristic in the UI terminal.

To use the custom sensor:

Step 1. Open the UI terminal and select custom sensor from the Characteristic drop-
down list.

Fig. 61  UI Terminal
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Day Light Savings settings 
The daylight saving setting is a part of the control manager, and it enables when it comes 
into effect.
Steps to configure Day Light Savings settings:

Step 1. Navigate to the BacnetNetwork > IrmBacnetDevice > IRM Program > expand 
the Control Manager.

Step 2. Double-click Day Light Saving and set Enable field to “true”.

Fig. 62  Day Light Saving configuration

Step 3. Configure the following parameters of Day Light Savings:
• Start Month: January - December
• End Month: January - December
• Start Day: Week Day 1 - Week Day 31
• End Day: Week Day 1 - Week Day 31
• Start Time: hr [0 - 23]
• End Time: hr [0 - 23]
• Off Set Minutes: min [0 - 240]

Clear the daylight savings check box and download it to the controller for the controller to 
stop using daylight savings.
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Periodic Program
Periodic program creates the control strategy running cyclically on a fixed time base. All the 
function blocks in the root folder and its subfolders are processed. The periodic program is 
executed every 500 ms within the controller.

Fig. 63   Periodic Program property sheet

Steps to configure Periodic Program:

Step 1. Navigate to the BacnetNetwork > IrmBacnetDevice > IRM Program > Double-
click on the Periodic Program in the tree and select the wire sheet view.

Step 2. Open the honIrmControl palette.
Step 3. Add control items from the palette to the wire sheet via drag and drop and / or 

copy / paste.
Step 4. Create or change the control logic by adding, deleting, moving icons, or adding 

and deleting connections.

Fig. 64  Periodic program wire sheet
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Note: Irmfolders support a maximum of five levels of nesting. The sixth level would be the 
component in the ord.

Fig. 65  IRM Folders

Note: A Periodic Program can have up to five nested folders. If the maximum folder nesting level is 
exceeded, the engineering tool validates it. If an application with more than five nested folders 
fails the validation, the teach will fail with the controller error DDC ERR NESTING LEVEL 
EXCEEDED.

Periodic Program Synchronization Check
The control manager detects any modifications on the periodic program wire sheet 
function blocks. You can perform add, delete, move, connection deleted or added 
modifications. As a result of the modification, a yellow “warning” symbol is displayed on the 
modified function block, indicating the application is in out of sync stat.

Fig. 66  Warning

The application synchronization status depends on the teach mode configuration (On 
demand or Immediate). After synchronization, the warning symbol is removed from the 
function block, indicating the synchronized state. Synchronization happens immediately in 
the "Immediate" mode. For more details, refer Control Manager on page 62.
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Event Program
The Event program creates an event-driven control strategy. All the function blocks in the 
root folder and its subfolders are processed. 

The event program is executed:
• When the time interval of 1000 ms has elapsed.
• When a Binary Input value is changed in On board IO folder.
• If the value of any Modbus read register changes.

When the service pin is pressed.
Steps to configure Event program:

Step 1. Navigate to the BacnetNetwork > IrmBacnetDevice > IRM Program > Double-
click on the Event Program in the tree and select the wire sheet view.

Step 2. Open the honIrmControl palette.
Step 3. Add control items from the palette to the wire sheet via drag and drop or copy 

and paste.
Step 4. Create or change the control logic by adding, deleting, moving icons, or adding 

and deleting connections.

Fig. 67  Wire sheet
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Note: A Event Program can have up to five nested folders. If the maximum folder nesting level is 
exceeded, the engineering tool validates it. If an application with more than five nested folders 
fails the validation, the teach will fail with the controller error DDC ERR NESTING LEVEL 
EXCEEDED.

Event Program Synchronization Check
The control manager detects any modifications on the event program wire sheet function 
blocks. You can perform add, delete, move, connection deleted or added modifications.

As a result of the modification, a yellow "warning" symbol is displayed on the modified 
function block, indicating the application is in out of sync state. 

Fig. 68  Synchronization Check

The application synchronization status depends on the teach mode configuration (On 
demand or Immediate). After synchronization, the warning symbol is removed from the 
function block, indicating the synchronized state. Synchronization happens immediately in 
the "Immediate" mode. For more details, refer Control Manager on page 62.
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Onboard IO
Onboard IO shows the hardware configuration of the application. The hardware details 
displayed in Onboard IO can differ from the actual hardware layout of the physical 
controller. For proper operation, the project hardware properties does not have to match 
completely with the physical controller hardware. 

But, if the difference is too much, the control manager will show incompatibilities, and the 
engineering tool will tell you what to do for synchronization.

Fig. 69  On board IO

Steps to use Onboard IO components:

Step 1. Navigate to the BacnetNetwork > IrmBacnetDevice > IRM Program > Double-
click on the Onboard IO in the tree and select the wire sheet view.

Step 2. Open the honIrmControl palette and add the single physical terminals to the 
wire sheet via drag and drop or copy / paste.

Fig. 70  Physical Points
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Step 3. Create or change the control logic by adding, deleting, moving icons, or adding 
and deleting connections.

Note: When discovering points on the Bacnet Network via Irm Bacnet Device Manager, the hardware 
I/O points of the IRM NX controllers are not detected or visible by default. To expose hardware 
I/O points on the Bacnet Network, refer to the Onboard IO Links from hardware to BACnet on 
page 141.

Onboard IO Synchronization Check
Any modifications on the onboard IO wire sheet are detected by the control manager. You 
can perform add, delete, move, connection deleted or added modifications.

As a result of the modification, a yellow "warning" symbol is displayed on the modified 
function block, indicating the application is in out of sync state. 

Fig. 71  Synchronization Check

The application synchronization status depends on the teach mode configuration (On 
demand or Immediate). After synchronization, the warning symbol is removed from the 
function block, indicating the synchronized state. Synchronization happens immediately in 
the "Immediate" mode. For more details, refer Control Manager on page 62.
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Reference Datapoints Usage
The reference datapoint is used to set up communication between BACnet controllers 
using reference input and reference output points.

When more than one BACnet controller is present in the control and monitoring system, the 
devices communicate with one another using the BACnet MSTP protocol. This allows one 
controller to read values from other controllers while also setting values on other 
controllers.

This data communication is achieved through the use of reference input and reference 
output points, which are assigned to physical or value BACnet points.

• The device instance, object instance, and object ID of the physical and value Bacnet 
points are manually entered for manual creation and mapping. 

• The device instance, object instance, and object ID of the physical and value Bacnet 
points are automatically performed for automatic creation via drag and drop.

Note: The engineering tool reference input and output function is a proprietary Honeywell Bacnet 
function.

Fig. 72  Manual Mapping of Reference Input Point with Physical Point

Fig. 73  Manual Mapping of Reference Output Point with Physical Point
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Fig. 74  Automatic Mapping of Physical Input Point with Reference input

/

Fig. 75  Automatic Mapping of Physical Input Point with Reference input and output

Example

There are two controllers (BACnet device A and BACnet device B) in two different rooms on 
the BACnet MSTP bus. Controller BACnet device A has an outside air temperature sensor 
connected. The outside air temperature value sensed by controller BACnet device A should 
be provided to controller BACnet device B. 

A third-party Bacnet MSTP wall module connected to an IRM NX controller should process 
values coming from the wall module.
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Read or Write Directions
Reading a value: A reference input point (target) is used for reading a value from a physical 
or value Bacnet point (source).

Writing a value: A reference output point (source) is used for writing a value to a physical or 
value point (target).

COV and Polling
• If COV reporting is possible, the reference point's controller subscribes to the 

mapped physical or value point. 

• If COV reporting is not possible, the mapped physical or value point is polled.

There are two ways for applying reference points in the application:

• Manual creation and mapping of reference points to Bacnet points (A).

• Automatic creation and mapping of reference points via drag and drop of Bacnet 
points (B).

Manual Reference Point Creation and Mapping
Reference input point (target): Manually creating and mapping the reference input point 
(target) to the physical or value Bacnet point is used to establish the reference input Bacnet 
point connection (source).

Reference output point (source): Manual mapping of the reference output point (source) 
to the physical or value Bacnet point is used to establish the reference output connection 
(target).

In both cases, the following device and object information from the Bacnet source or target 
points must be entered during the mapping:

• Device Instance (ID)

• Object type (Bacnet point type) = object ID

• Object Instance = object ID

Automatic Reference Point Creation and Mapping (A)
Reference points are created and mapped automatically by dragging and dropping 
physical or value Bacnet points onto the wire sheet.

The corresponding device and object information is included with the corresponding 
Bacnet point and does not need to be entered manually.

Client-Server Configurations: A client-server configuration with one client controller 
connected to multiple server controllers or third-party Bacnet devices is a typical 
application scenario for using reference points. The client implements the main control 
logic, writes values to server controllers or third-party Bacnet devices, and receives values 
from server controllers or third-party Bacnet devices.
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Example:

The client controller: 

• Reads the window contact status [EffWindow] from the server controller via RefIn.

• Reads the room temperature [ExtWmRmTemp] from the external Bacnet Wall 
Module via RefIn.

• Writes the occupancy status [EffOccMd] to an external Bacnet Wall Module via 
RefOut.

The server controller: 

• Reads the fan output status [FanStage] of the staged fan (slow, medium, high) from 
the client controller via RefIn.

Fig. 76  Client-Server Configuration Using Reference Points
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Manual Mapping of Reference Points (A)
Example:

Two IRM NX controllers and a wall module are on the MSTP bus in the client-server 
configuration:

• CLME-RL6N (client)

• CLME-RS5N (server)

• External Bacnet wall module

The CLME-RL6N client controller: 

• Reads the window contact status [EffWindow] from the server controller via RefIn.

• Reads the room temperature [ExtWmRmTemp] from the Bacnet Wall Module via RefIn.

• Writes the occupancy status [EffOccMd] to an external Bacnet Wall Module via RefOut.

The CLME-RS5N server controller:

• Reads the fan output status [FanStage] of the staged fan (slow, medium, high) from the 
client controller via RefIn.

Reference Inputs
Based on the example above, the reference input functions of the CLME-RL6N client 
controller are described in the following.

The CLME-RL6N client controller:

• Reads the window contact status [EffWindow] from the server controller via RefIn.

• Reads the room temperature [ExtWmRmTemp] from the Bacnet Wall Module via 
RefIn.

Note: The device IDs of the CLME-RL6N client and CLME-RS5N server controllers. In the below 
image, "5003" and "5001" (displayed in the discovered and database pane).

Fig. 77  Discovered view

Note: The read function of the CLME-RS5N server controller is described using the automatic 
creation via drag and drop, see Automatic Creation and Mapping of Reference Points (B) on 
page 98.
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Steps to create reference input operation:

Step 1. In the Nav tree, expand the bacnet network and browse to the points directory of 
the CLME-RS5N server controller.

Fig. 78  Points

Step 2. Double-click the points directory. This action opens Hon Bacnet Point Manage 
view.

Step 3. Click Discover. This action discovers all the offline points.

Fig. 79  Irm offline Discover
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Step 4. Sort the discovered points by clicking on the Object Name column.

Fig. 80  Discovered Pane

Step 5. In the point list, scroll to the 'EffWindow' Bacnet point.
The Object ID, in this case 'multiStateValue:8'.

Step 6. In the Nav tree, expand to the CLME-RL6N client controller.
Step 7. Expand the IRM Program and double-click Periodic Program to add the 

reference input point.

Fig. 81  Periodic program folder

Step 8. Go to the honIrmControl palette, expand BacnetObjects, and drag and drop the 
RefIn to the wire sheet.



IRM SYSTEM ENGINEERING GUIDE 92

Fig. 82  Periodic program wire sheet

Step 9.  In the Name dialog box, change the name to EffWindow, and then click OK.

Fig. 83  Name dialog box

The EffWindow RefIn is added to the wire sheet.

Fig. 84  wire sheet

Step 10.  Double-click the symbol to display the property sheet for the EffWindow RefIn.
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Fig. 85  EffWindow Refin property sheet

Step 11. On the property sheet, expand device instance, object type, and object instance.

Fig. 86  EffWindow RefIn property sheet

Step 12. Enter in the values for the wall module and the EffWindow multistate value point 
as shown below.
• Device Instance: device ID = 5001

• Object Type: object ID = MultistateValue

• Object Instance: object ID = 8
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Fig. 87  EffWindow RefIn property sheet

Step 13. Click Save.
The reference input in the CLME-RL6N client controller is mapped to the 
multistate value point EffWindow in the CLME-RS5N controller which provides 
the window contact status.

Step 14. Apply the procedure in the same way for:
• Reading the room temperature by mapping a reference input from the client 

controller to the analog value [ExtWmRmTemp] of the external Bacnet wall 
module.

• Reading the fan stage by mapping a reference input from the CLME-RS5N 
server controller to the multistate output [FanStage] of the CLME-RL6N 
client controller. 

Step 15. For writing the occupancy status from the client controller to the external Bacnet 
wall module, please, see Reference Outputs on page 94 below.
Alternatively, you can use the "Automatic Reference Point Creation and Mapping 
(A) on page 87" method described in the section. Automatic Creation and 
Mapping of Reference Points (B) on page 98. This section uses fan stage reading 
as an example.

Step 16.  If desired, you can change the setting for client sync or other settings.

Reference Outputs
In the following procedure, the reference output of the CLME-RL6N client controller is 
described below. 

• The CLME-RL6N client controller writes the occupancy status [EffOccMd] to an 
external Bacnet wall module via RefOut.

Example: 

Two IRM NX controllers and a wall module are on the MSTP bus in the client-server 
configuration:



IRM SYSTEM ENGINEERING GUIDE 95

• CLME-RL6N (client)

• CLME-RS5N (server)

• External Bacnet wall module

Steps to create reference output functions:

Note: The device ID of the external Bacnet wall module is 5008 (displayed in the Discovered and 
Database pane).

Fig. 88  Controller and external Bacnet wall module

Step 1. In the Nav tree, expand the Bacnet network and browse to the points directory 
of the wall module.

Step 2. Double-click the points directory and click Discover to discover the points. 
Step 3. Sort the discovered points by clicking on the Object Name column.
Step 4. In the point list, scroll to the "EffOccMd" Bacnet point.

Note: The Object ID, in this case, for example, 'multiStateValue:13'.

Step 5. In the Nav tree, expand to the CLME-RL6N client controller. 
Step 6. Expand the IRM Program and double-click the Periodic Program to add the 

reference output point.

Fig. 89  Periodic program wire sheet
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Step 7.  In the honIrmControl palette, expand BacnetObjects, and drag and drop the 
RefOut to the wire sheet.

Fig. 90  Periodic program wire sheet

Step 8. Change the name to "EffOccMd" in the Name dialog box, and then click OK.

Fig. 91  Name dialog box

Step 9. The EffOccMd RefOut is added to the wire sheet.

Fig. 92  wire sheet

Step 10.  Double-click the symbol to display the property sheet for the reference output.
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Fig. 93  EffOccMd RefOut property sheet

Step 11. On the property sheet, expand device instance, object type, and object instance.

Fig. 94  EffOccMd RefOut property sheet 

Step 12. Enter the values of the external bacnet wall module and the EffOccMd 
multistate value point as shown in steps 1 and 4.
• Device Instance: device ID = 5008

• Object Type: object ID = multistateValue

• Object Instance: object ID = 13

Step 13.  Click Save.
The reference input in the CLME-RL6N client controller is mapped to the 
multistate value point EffOccMd in the wall module.

Step 14. If desired, you can change the setting for client sync.

Client-Server Synchronization

• If client Sync Enabled is set to true, this property will be synchronized between the 
client and the server whenever a client sync operation is performed.

• If the flag on the source device is set to false, this parameter will not be synchronized 
to all target devices.
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Automatic Creation and Mapping of Reference Points (B)
The engineering tool automatically creates reference points when Bacnet points are copied 
onto the wire sheet. Therefore, you do not have to enter the values for device instance, 
object type, an object instance of the target controller, and point manually since they 
automatically come with the Bacnet point. 

This automatic creation is always executed whenever a Bacnet point is copied onto the wire 
sheet of a different controller or an external Bacnet device. In the drop result, the type of 
reference point, input or output, is to be created are defined in the control manager as 
described in the drop settings.

Fig. 95  Irm Control Manager property sheet

In the control manager, the result for drop of a Bacnet output and a Bacnet value point can 
be selected. For both point types, either a reference output or a reference input can be 
selected as a drop result.

Fig. 96  Create Ref Output

Note: Another controller cannot override the input points. Hence, a reference input is always 
created when dropping an input onto the wire sheet, and a drop setting for inputs in the 
control manager is not provided.
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Example: Two IRM NX controller and a wall module are on the MSTP bus in the client-
server configuration:

• CLME-RL6N (client)

• CLME-RS5N (server)

• External Bacnet wall module

The CLME-RL6N client controller:

• Reads the window contact status [EffWindow] from the server controller via RefIn.

• Reads the room temperature [ExtWmRmTemp] from the Bacnet wall module via 
RefIn.

• Writes the occupancy status [EffOccMd] to an external Bacnet wall module via 
RefOut.

The CLME-RS5N server controller:

• Reads the fan output status [FanStage] of the staged fan (slow, medium, high) from 
the client controller via RefIn.

Based on the example above, the reference input function of the CLME-RS5N server 
controller is described.

Steps to create and Map of Reference Points:

Step 1. In the Nav tree, expand the Bacnet network and browse to the points folder of 
the CLME-RL6N client controller.

Step 2. Double-click the points folder and discover the points by clicking discover on the 
bottom.

Fig. 97  Bacnet Discover Points

Step 3. Sort the discovered points by clicking on the Object Name column.
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Step 4. In the point list, scroll to the 'FanStage' Bacnet point.

Fig. 98  FanStage Bacnet Point

Step 5. Add the 'FanStage' Bacnet point to the database by clicking Add at the bottom.

Fig. 99  Add dialog box
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Step 6. Click OK in the Add dialog box. The point will be added to the Database and the 
Points folder.

Fig. 100  Database

Step 7. In the Nav tree, browse to the CLME-RS5N server controller.
Step 8. Expand the IRM Program directory and double-click Control Manager.

Step 9. Select Create Ref Input for Drop of Bacnet Output property.

Note: Drop of Bacnet Output property is mandatory for outputs and value points, but not necessary 
for input points. 

Fig. 101  IRM Program Folder 
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Step 10. Double-click the control manager folder, Periodic Program or Event Program, 
to which you want to add the FanStage Bacnet point.

Fig. 102   wire sheet

Step 11. Navigate to the points directory of the CLME-RL6N client controller and copy 
the FanStage bacnet point to the wire sheet of the CLME-RS5N server controller.

Step 12. In the Name dialog box, click OK.

A reference input point with the name of the FanStage, is created. 

Fig. 103  FanStage RefOut function block
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Step 13. Double-click the symbol of the reference input point to display the FanStage 
RefOut property sheet.

Fig. 104  FanStage RefOut property sheet

In the property sheet, you can see that the reference input is already mapped to 
the Bacnet multistate output point indicated by the values for device instance, 
object type, and object instance.

Step 14.  If desired, you can change the setting for client sync.

Client-Server Synchronization

• If client Sync Enabled is set to true, this property will be synchronized between the 
client and the server whenever a client sync operation is performed.

If the flag on the source device is set to false, this parameter will not be synchronized to all 
target devices.
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CONFIGURE IRM NX 
CONTROLLERS

This chapter describes the steps to configure the new IRM NX controller, controller MAC 
address assignment, IP settings, linking of controller IO points to the BACnet points, and 
terminal assignment view.

Configure Air Flow Measurement Units
Before starting the application in the engineering tool, it is important to define the correct 
air flow measurement type.

Steps to configure air flow measurement units:

Step 1. In the Nav tree, go to BacnetNetwork > Irm Bacnet Device > expand IRM Pro-
gram folder.

Step 2. Double click on the Control Manager.
Step 3. Select the desired Measurement Type and Air Flow Unit from the drop-down 

list.

Fig. 105  Measurement Types

• For SI-Metric set Air Flow Unit as “Cubic Meter Per Hour or Liter Per Second.

• For Imperial set Air Flow Unit as “Cubic Feet Per Minute”.
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New Controller Configuration
Configure Irm Config

Before engineering a IRM NX controller on a BACnet Network, you must configure the 
IrmConfig settings as per requirement.
Steps to configure Irm Config:

Step 1. Expand the BACnet Network folder.
Step 2. Double-click the IrmConfig folder in the BACnet Network to display the property 

sheet.

Fig. 106  Irm Config Property Sheet

Step 3. Configure the IrmConfig properties.

Table 23  IrmConfig Property Sheet

Property Value Details

Id Range Min 0 - 4194302
1000 (default)

Set the minimum Id value assigned to a device during 
discovery.

Id Range Max 0 - 4194302
9999 (default)

Set the maximum Id value assigned to a device during 
discovery.

Teach Modified 
Controller

Deny (default)
Allow

• Deny (Default value): Do not allow overwriting an existing 
application in the controller. While trying to teach a 
different application to a controller an error message is 
generated which requires to clear the controller.

•  Allow: Allows the unconditional overwriting of an existing 
application.

Note:  Do not change this setting.
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Inconsistent 
Program Check True (default)

False

If the inconsistent program check property is true, the 
engineering tool checks the application for inconsistencies 
and displays a message. If you move or copy the application 
to an external location, such as changing the palette at the 
external location and then including it again, inconsistencies 
may occur.

Note: Copying-pasting parts of an application of another 
controller from an external location does not generate 
inconsistencies.

Last Selected 
Teach Option

Overwrite BACnet 
object values in 
Application 
(default)

This option displays the last teach option used while 
performing or full teach application to the controller.

• Overwrite BACnet objects values in Device: This option 
overwrites BACnet object values and directly teaches 
application in the controller.

• Overwrite BACnet object values in Application: This 
option first performs an update for all BACnet object 
values from controller to the application. It then performs 
a teach application operation in the controller.

Swap In Heap 
Memory Usage 
Limit

0 - 100 %
70 % (default)

You can configure the heap memory limit for the controller or 
supervisor station with this option.

• While working on the HAWK-8000 controller, the memory 
utilization should not exceed 70 %.

• While working on the supervisor station, the memory 
utilization should not exceed 90 % to 95 % .

Auto Swap Enable
True
False (default)

Using this feature, a swap-in device can be swapped-out 
automatically if the user forgets to do so. This allows to 
optimize the station memory usage.

Table 23  IrmConfig Property Sheet (Continued)

Property Value Details
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Resource Recommendations
While performing application teach to IRM NX controllers from HAWK-8000, EAGLEHAWK 
or Advanced plant controller following two factors impact the performance.

• CPU of the HAWK-8000 or EAGLEHAWK.

• Available heap memory of HAWK-8000 or EAGLEHAWK.

To check the available CPU and heap memory usage of HAWK-8000 or EAGLEHAWK, check 
to the station resource monitor

Fig. 107  Station Resource Monitor View

CPU Load Recommendation
The HAWK-8000 or EAGLEHAWK cpu.usage should not go higher than 70 %.

Fig. 108  CPU Load Recommendation
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Memory Load Recommendation
It is advised not to load more than 50 % of the HAWK-8000 or EAGLEHAWK heap.used 
memory. 

Fig. 109  Memory Load Recommendation

Important: Before initiating the batch operation, disable all the configured points, histories, and alarms. 
Disabling points, histories and alarms will help reduce the load on the BACnet network and 
help commission the application faster. After the batch operation completes, enable all the 
configured points, histories, and alarms.

Based on the available memory, select the controllers. If more than 50 % of the memory 
space is utilized, perform the batch operation in slots. For example, select ten devices or 
(determine the number of devices based on the load). Perform the batch teach to the con-
troller (refer to Teach to Multiple Controllers on page 173), then swap out. Similarly, select 
the next ten devices and perform the same steps.
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Configure IP VAV Controllers
Using the engineering tool, you can discover and configure the IP VAV controllers on the 
CentraLine-N4 workbench.

Note: It is recommended that you use the EAGLEHAWK or HAWK-8000 controller as an IP router to 
host and run a station while commissioning the IP VAV controller.

Note: When commissioning the IRM NX controller via a third-party router (non-CentraLine branded 
HAWK), the user must ensure that the HAWK is licensed with the DR-SPYDERTOOL option.

IP VAV Controller System Architecture

Fig. 110  IP VAV Controller System Architecture
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Prerequisites

Step 1. Connect to the HAWK-8000 or EAGLEHAWK controller with the CentraLine-N4 
Supervisor via ethernet cable.

Step 2. Connect the IP VAV controllers to the HAWK-8000 or EAGLEHAWK controller via 
BACnet IP network.

Steps to setup IP VAV controller
Follow the steps below to configure the IP VAV controller.

1. Configure the BACnet Network

2. Configure the IP Port in CentraLine-N4 Workbench

3. Commission the station

4. Transfer the station to a HAWK-8000 or EAGLEHAWK controller

Configure the BACnet Network
Steps to configure the BACnet Network:

Step 1. Open CentraLine-N4 workbench and connect the platform to the localhost.
Step 2. Create a station using the New Station Wizard.
Step 3. Select the CIPer50.ntpl as station template.

Fig. 111  New Station Wizard

Step 4. Enter the desired station name.
Step 5. Start and connect to the station.
Step 6. Expand the Station > Config, and double-click on Drivers.
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Step 7. Click New, select BacnetNetwork from the drop-down list, and click OK. 
This adds the Bacnet Network under Nav tree.

Fig. 112  Bacnet Network

Step 8. Expand BacnetNetwork. 

Fig. 113  Expand BacnetNetwork
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Configure the IP Port in CentraLine-N4 Workbench
Configure the Ip Port in the CentraLine-N4 workbench to access the IP VAV controllers via a 
HAWK-8000 or a EAGLEHAWK controller. 

Steps to configure the IP Port:

Step 1. Expand Bacnet Comm > Network > double-click on Ip Port.

Step 2. Select Ip Port, right-click Action, and select Enable.
Step 3. Expand the Ip Port, select Link, right-click Actions, and select Query for 

Adapters.

Fig. 114  Performing query for adapters.

Step 4. Select the Bacnet ethernet adapter from the drop-down list. Make sure the 
station and the Bacnet ethernet adapter are on the same subnet on the 
computer.

Fig. 115  Ip Port Configuration

Step 5. Click Save. 
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Step 6. Go to Local Device property, check the Character Set. Make sure the character 
set of the Bacnet Network is Iso10646_UTF8.

Fig. 116  Local Device property

Important: All the IRM NX controller support the UTF-8 format. When configuring the device name using 
the device object, the tool should write the data in UTF-8 format. 

Step 7. Click Save.

Note: If any configuration settings change during operation, you must restart the IP router (HAWK-
8000 or EAGLEHAWK controller).

Commission the Station
Steps to Commission the station:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Click on Discover. All of the online IP VAV controllers displayed. 

Fig. 117  Irm Bacnet Device Manager view

Step 3. Select all controllers and click Add. You will need to configure each highlighted 
controller within the Add view.

Fig. 118  Add view 
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Step 4. Enter the following details:
• Name: Rename the device name.

• Type: Select the device type from the drop-down list.

• Device ID: Enter the device ID.

• Network address: Enter the network address.

• MAC Address: Enter the MAC address.

• Enabled: Select true or false from the drop-down.

• Use Cov: Select true or false from the drop-down. Refer to the Tuning Policies on 
page 231. 

• Use Cov property: Select true or false from the drop-down.

• Keep Max Cov Subscriptions as max.

Step 5. Perform the desired engineering operations in the controller.

Note: Perform a Swap Out operation on all the controllers before transferring the local database to 
a HAWK-8000 or EAGLEHAWK station. Swap Out saves RAM space and reduces processor 
load and bus traffic. The state of a swapped-out device is frozen and saved to a project 
repository on the PC disk. The swapped-out device is indicated by a proxy that inherits and 
shows the minimum information about the device.

Important: For seamless performance, it is strongly recommended to Swap Out the HAWK-8000 or 
EAGLEHAWK controller after finishing the engineering in online or offline mode in the station.

Step 6. Go to the Irm Bacnet Device Manager view, select the controllers from the 
database, and click Swap Out. This action displays the Swap Out dialog box.
For more details refer to the Swap on page 187.

Fig. 119  Database View

Step 7. Click Yes.

Fig. 120  Swap Out Dialog Box 

Step 8.  Save the station.
Important: It is recommended to keep a station backup after making any change in the controller or 

station. 

Step 9. Go to the Platform and run Station Copier. This opens the station copier 
window.
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Step 10. Select the saved station from localhost section and click Copy to the computer. 
This action copies saved station from localhost of CentraLine-N4 workbench to 
the computer.

Transfer the station to a HAWK-8000 or EAGLEHAWK controller
Steps to transfer the station to a HAWK-8000 or EAGLEHAWK controller:

Step 1. Open the HAWK-8000 or EAGLEHAWK platform and select Station Copier. This 
opens station copier window.

Step 2. Select the saved station from the computer section and click Copy to the 
localhost. This action copies the saved station from the computer to the 
localhost of the HAWK-8000 or EAGLEHAWK controller.

Keep all the IRM NX controllers in the swapped-out mode in the HAWK-8000 and 
EAGLEHAWK controller station to ensure seamless performance.
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IP Settings
IP setting comprises IP Configuration on page 117 and Network Time Server on page 120.

Fig. 121  IP Settings

IP Setting feature is supported by following controllers:

When you add IRM device into Bacnet Network, the IP Setting option is hidden by default. 

Steps to activate the IP Setting:

Step 1. Navigate to the IRM Program > double-click Control Manger. This open Con-
trol manager property sheet.

Step 2. In Device Model Name, select the IP Setting supported model from the drop-
down list.

Fig. 122  Device Model Name
Step 3. Click Save.
Step 4. Right-click IRM device and select Refresh Tree Node. This activates the IP 

Setting feature.

• VA75I24NM

• VA00IB24NM

• VA75IBWA24NM

• VA75IBWB24NM

• VA75I24NS

• VA75IB24NS

• VA75IBWA24NS

• VA75IBWB24NS

• UN-RS0844ES24NM

• UN-RS0844ESB24NM

• UN-RS0844TS24NM

• UN-RS0844TSB24NM

• UN-RL1644ES24NM

• UN-RL1644ESB24NM

• UN-RL1644TS24NM

• UN-RL1644TSB24NM
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IP Configuration
IP Config operation is provided to ease IP configuration for multiple IP VAVs from a single 
window. This feature allows users to perform many productivity operations like a batch 
update of IP configuration, auto-increment of IP addresses, visual indication of 
modifications to IP addresses, user errors in IP configuration, offline and online IP 
configuration.

Whenever a factory default or new controller is discovered on a station, it searches for the 
available IP address on the DCHP server or local Ethernet IP address. 

For the factory out controller, the DHCP mode is enabled.

• On power-up, for the first 15 seconds, the controller will search for a DHCP server to 
acquire an IP address.

• If a DHCP server (switch) is not found, the controller will switch to Auto IP mode, in which 
it follows linklocal addressing for address resolution.

• It will acquire an IP address in the range 169.254.1.0 - 169.254.254.254. The controller 
will use the last two characters of its serial number as the last octet for starting address 
search. For example, if the serial number ends with 36 (Conversion HexToDec = 54), the 
IP address is set to 169.254.1.54).

• If the controller has link-local addressing, the controller will periodically (every 1 minute) 
search for the DHCP server. If a server is found, the controller will acquire a new IP 
address from the server and start using it immediately.

Note: If a controller has the Link-Local Addressing, it will periodically search for the DHCP server 
(every 1 minute). If the server is found, the controller acquires the new IP address from the 
server and starts using it immediately.

Steps to check IP Settings details:

Step 1. Navigate to the BacnetNetwork > IRM device (IP controller) > IP Settings.

Fig. 123  IP Controller

Step 2. Double-click IP Settings. This action opens the IP Settings property sheet view.
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Fig. 124  IP Settings property sheet

Table 24  IP Settings Property Description

Properties Description

Status Read-only. Display the status of the IP Configuration.

Fault Cause Read-only. When the IP configuration enters a fault state, this 
function displays the fault cause information.

IP Interface Read-only. Displays the supported interface. The current 
engineering tool version supports Ethernet only.

Configuration 
Sync Status

Read-only. Displays the following configuration sync status.

• Configuration Insync

• Configuration modified

• Configuration OutOfSync

Ethernet

IP Address Type

Allows you to set the IP Address type as DHCP or Static.

DHCP IP Address Type (Default): Displays available IP address for 
the controller from the DHCP server.

Fig. 125  DHP IP Address Type 
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If the controller is connected via ethernet cable, you can change the IP address 
of the controller.

Step 3. Navigate to BacnetNetwork > IRM device (IP controller) > double-click IP 
Settings. This action opens the IP Settings property sheet view.

Step 4. Click Save.

Static IP Address Type: Displays IP address for the controller when 
connected to the local ethernet port.

Fig. 126  Static IP Address Type

IPv4 Settings

Allows you to configure the following settings:

• Enter IP Address 

• Enter Subnet Mask address

• Enter Default Gateway 

When configuring an IP address, the engineering tool checks the 
following validation conditions:

• For IP address, subnet mask, and default gateway, the Octet 
cannot be zero.

• For IP address, subnet mask, and default gateway, the first 
Octet cannot begin with 0.

• The address should be properly formatted, and the Octet 
value for IP address, subnet Mask, and default gateway 
should be between 1 and 255.

• The IP address and default gateway must not be the same.
• All of the bits in the IP address's host address cannot be 0.
• All of the bits in the IP address's host address cannot be 1.
• The default gateway does not belong to the same network 

segment as the IP address and subnet mask.
• Invalid subnet mask, the subnet mask has to be contiguous.
• All of the bits in the IP address's network address cannot be 0.
• IP addresses are not unique (IP Address validation within the 

network).
• The first octet of IP addresses should be between 1 and 223 

characters (Class D IP address is not accepted).

Table 24  IP Settings Property Description (Continued)

Properties Description
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Write and Read IP configuration

Write IP Configuration to Controller
This feature sends modified IP configuration details to controller.

Steps to Write IP Configuration to Controller:

Step 1. Right-click on IP Configuration, select Action and click Write IP Configuration 
to Controller.

Fig. 127  Write IP Configuration To Controller

Read IP Configuration from Controller
If the user wants to read the IP Configuration from the controller platform, use Read IP 
Settings from Controller.

This feature retrieves IP configuration information from the controller platform and 
updates the information in the engineering tool's IP configuration.

Steps to Read IP Configuration from Controller:

Step 1. Right-click on IP Configuration, select Action and click Read IP Settings from 
Controller.

Fig. 128  Read IP Settings from Controller

Network Time Server

Fig. 129  Network Time Server

Allows you to add the Network Time Server address. You can enter the supported IP address 
(example: 129.6.15.28) or server URL link (time.googel.com).
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Write NTS Configuration to Controller
This feature sends modified Network Time Server (NTS) details to controller.

Steps to Write NTS Configuration to Controller:

Step 1. Right-click on Network Time Server, select Action and click Write NTS 
Configuration to Controller.

Fig. 130  Write NTS Configuration to Controller

Read NTS Configuration from Controller
This feature retrieves Network Time Server (NTS) information from the controller platform 
and updates the information in the engineering tool's Network Time Server configuration.

Steps to Read NTS Configuration from Controller:

Step 1. Right-click on Network Time Server, select Action and click Read NTS 
Configuration from Controller.

Fig. 131  Read NTS Configuration from Controller.
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Write and Read IP Setting to Controller

Write IP Settings to Controller
After you've configured the IP Settings, use Write IP Setting to Controller to save the 
changes to the controller. This action sends the IP configuration and Network Time Server 
changes from the station to the controller platform.

Steps to Write IP Settings to Controller:

Step 1. Right-click on IP Settings, select Action and click Write IP Settings To 
Controller.

Fig. 132  Write IP settings to Controller

Read IP Settings from Controller
This feature collects the IP configuration details of the controller as well as the controller's 
Network Time Server (NTS) details from the controller platform and updates the IP Setting 
in the engineering tool.

Steps to Read IP Settings from Controller:

Step 1. Right-click on IP Settings, select Action and click Read IP Settings from Con-
troller.

Fig. 133  Read IP Settings from Controller.
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Configuring IP Settings for Multiple Controllers
The engineering tool allows you to configure IP settings on multiple controllers in a batch 
process. 

Steps to configuring IP Settings for Multiple Controller:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the IP controllers from the device list.

Note: Selecting the Bacnet IRM device from the device list will inactive the IP Config option. 

Step 3. Click IP Config.

Fig. 134  Database

Step 4. This displays the IP Config batch window, which consists of Ethernet and 
Network Time Server settings.

Fig. 135  IP Configuration

Note: All the listed devices belong to one network in the IP Config window, which is determined while 
selecting the first device from the Irm Device Manager view. 

Step 5. Set the IP Address type as DHCP or Static (default IP address type) for all the 
listed IP VAV controllers from the IP Config batch window. 
• For Static IP address type: Any change in the ethernet or network time 

server setting will update the respective column in the device list.

• For DHCP address type: If the DHCP IP address type is selected, the IP 
address, subnet mask, and default gateway will be auto-updated.
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Note:  After changing the IP Address type to DHCP, the static IP Address configuration data for all 
IP VAV controllers will not be deleted. Change the IP Address type to Static if you want to go 
back to using static IP addresses.

Fig. 136  IP Configuration

Step 6. Click OK.
Now, the engineering tool performs two operations: 
• Starts validating details of all the listed IRM NX controllers to determine if 

they are correct.

• Starts updating the device level component for selected controllers.

Note: The engineering tool generates an error report if any invalid configuration is discovered.

Fig. 137  Error Report

If the devices are online, perform the write IP configuration to controller. If the devices are 
offline, perform a write to device level component.

Important:
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Configure MSTP VAV Controllers
Using the engineering tool, you can discover and configure the MSTP VAV controllers on 
the CentraLine-N4 workbench.

Note: It is recommended that you use the EAGLEHAWK or HAWK-8000 controller as an MSTP 
router to host and run a station while commissioning the MSTP VAV controller.

Note: When commissioning the IRM NX controller via a third-party router (non-CentraLine branded 
HAWK), the user must ensure that the HAWK is licensed with the DR-SPYDERTOOL option.

BACnet MSTP Baud Rate 
The following are the supported baud rates for the IRM NX MSTP controllers.

After the IRM MSTP controller are powered up and connected to the BACnet MSTP bus, the 
baud rate of each IRM MSTP controller is automatically set by the defined baud rate of the 
BACnet MSTP EAGLEHAWK.

Note: Setting or changing the baud rate of a single IRM NX controller is not possible. 

When changing the Baud Rate of the BACnet MSTP bus of a running station, any 
connected IRM must be power-cycled to apply the modified baud rate.

Important: Application teach fails for baud rate 115200.

• 9600 
• 19200 (default)
• 38400
• 57600
• 76800 
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MSTP VAV Controller System Architecture

Fig. 138  MSTP VAV Controller System Architecture

Prerequisites

Step 1. Connect the HAWK-8000 or EAGLEHAWK controller with the CentraLine-N4 
Supervisor via ethernet cable.

Step 2. Connect the MSTP VAV controllers to the HAWK-8000 or EAGLEHAWK controller 
in BACnet the MSTP network connection. 
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Steps to Configure MSTP VAV Controller
Follow the below steps to configure the MSTP VAV controller.

1. Configure the BACnet Network

2. Configure the MstpPort in CentraLine-N4 Workbench

3. Commission the station

4. Transfer the station to HAWK-8000 or EAGLEHAWK controller

Configure the BACnet Network
Steps to configure the BACnet Network:

Step 1. Open the CentraLine-N4 workbench and connect the platform to the localhost.
Step 2. Create a station using the New Station Wizard.
Step 3. Select the CIPer50.ntpl as station template.

Fig. 139  New Station Wizard

Step 4. Enter the desired station name.
Step 5. Start and connect to the station.
Step 6. Expand the Station > Config, and double-click on Drivers.
Step 7. Click New, select BacnetNetwork from the drop-down, and click OK. 

This adds the Bacnet Network.

Fig. 140  BacnetNetwork Selection
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Step 8. Expand BacnetNetwork. 

Fig. 141  Expand BacnetNetwork

Configure the MstpPort in CentraLine-N4 Workbench
Configure the MstpPort in the CentraLine-N4 workbench to access the MSTP VAV 
controllers via a HAWK-8000 or a EAGLEHAWK controller. 

Steps to configure the MstpPort on CentraLine-N4 Workbench:

Step 1. Navigate to Palette, click on open palette, and type “BACnet” in the filter.

Step 2. Select the bacnet module from the search result and click OK. 
This adds a bacnet module to the Palette.

Fig. 142  Open Palette window
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Step 3. Expand the NetworkPorts folder, select MstpPort, and drag it under Drivers > 
BacnetNetwork > Bacnet Comm > Network. 
This adds a MstpPort under Network property.

Fig. 143  Add MstpPort

Step 4. Navigate to Drivers > BacnetNetwork > Bacnet Comm > double-click Network 
and expand property sheet on the Mstp Port. 

Step 5. Expand Link and enter the following details:
•  Network Number: Any number less then or equal to 65535 (for example, 56).

•  Port Name: RS485_1 (RS485_1 is only supported on the EAGLEHAWK, COM_1 is 
supported on the HAWK-8000).

•  Baud Rate: Baud_38400 (see also Tuning Policies on page 231).

•  Enabled: true.

Fig. 144  MstpPort Properties
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Step 6. Click Save.
Step 7. Go to the Local Device property and check the Character Set. Make sure the 

character set of the BACnet Network is Iso10646_UTF8.

Fig. 145  Local Device Property

Important: The IRM NX controllers support the UTF-8 format. When configuring the device name with the 
device object, the tool should write the data in UTF-8 format. Before changing the controller 
name, ensure that the BACnet network is configured for character set UTF-8, or else the VAV 
balancing app or tool will not display the controller on the discovery page.

Step 8. Click Save. This saves the MstpPort configuration on the station.

Note: If any configuration settings change during operation, you must restart the MSTP router.

Commission the station
Steps to commission the station:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Click the Discover option in the Irm Bacnet Device Manager view. This action 
will discover all of the IP VAV controllers communicating online. 

Fig. 146  Irm Bacnet Device Manager view
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Step 3. Select all the controllers and click Add.
This opens the Add property.

Fig. 147  Add property 

Step 4. Enter the following details:
• Name: Rename the device name.

• Type: Select the device type from the drop-down list.

• Device ID: Enter the device ID.

• Network addres: Enter the network address.

• MAC Address: Enter the MAC address.

• Enabled: Select true or false from the drop-down.

• Use Cov: Select true or false from the drop-down. Refer to the Tuning Policies on 
page 231. 

• Use Cov property: Select true or false from the drop-down.

• Keep Max Cov Subscriptions as max.

Step 5. Perform the desired engineering operations in the controller.

Note: Perform a Swap Out operation on all the controllers before transferring the local database to 
a HAWK-8000 or EAGLEHAWK station. Swap Out saves RAM space and reduces processor 
load and bus traffic. The state of a swapped-out device is frozen and saved to a project 
repository on the PC disk. The swapped-out device is indicated by a proxy that inherits and 
shows the minimum information about the device. 

Important: For seamless performance, it is strongly recommended to Swap Out the IRM NX controllers in 
HAWK-8000 or EAGLEHAWK controller after finishing the engineering in online or offline 
mode in the station.
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Step 6. Go to the IrmBacnetDeviceManager view, select the controllers from the 
database, and click Swap Out. This action displays the Swap Out dialog box.
For more details, refer to the Swap on page 187.

Fig. 148  Database View

Step 7. Click Yes.

Fig. 149  Swap Out Dialog Box 

Step 8. Save the station.
Important: It is recommended to keep a station backup after making any changes.

Step 9. Go to the Platform and click on Station Copier. This opens the station copier 
window.

Step 10. Select the station from the localhost section and click Copy to the computer. 
This action copies the saved station from the localhost of the CentraLine-N4 
workbench to the computer.

Transfer the station to HAWK-8000 or EAGLEHAWK controller
Steps to transfer the station to a HAWK-8000 or EAGLEHAWK controller:

Step 1. Open the HAWK-8000 or EAGLEHAWK platform and select the Station Copier. 
This opens the station copier window.

Step 2. Select the saved station from the “station on this computer” section and click 
Copy. This action copies the station from the “station on this computer” section 
to the “station on local host” section of the HAWK-8000 or EAGLEHAWK 
controller.

Important: Keep all the IRM NX controllers in the swapped-out mode in the HAWK-8000 and 
EAGLEHAWK controller station to ensure seamless performance.
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Controller MAC Address Configuration

Automatic MAC Address Configuration
When new devices are connected to the network, the Auto MAC functionality allows the 
controller to automatically assign the MAC address. On factory default controllers, the Auto 
MAC function is enabled by default.

Important: Auto MAC feature is only supported for MSTP controllers and not applicable for IP controllers.

The Device ID for factory default controllers is 4194302. On every power cycle, these 
controllers will activate the Auto MAC feature and may obtain a new MAC address. The Auto 
MAC option can be enabled or disabled to eliminate network connectivity issues caused by 
MAC address conflicts on an existing bus. 

Disabling the Auto MAC option allows you to do the following:
• The controller's MAC address will be locked and can only be changed manually.
• It is the responsibility of the user to avoid any possible an address conflict.
• If the Auto MAC feature is disabled, assign that controller a unique MAC address.

Note: If the controller is restored to its factory default, the Auto MAC capability is activated for that 
controller. 

Update MAC Address Configuration from Station
You can enable or disable the Auto MAC feature for all the controllers in the station with the 
Update MAC Address Configuration option.

Steps to Update MAC Address Configuration:

Step 1. Navigate to the BacnetNetwork > IrmConfig>Actions> Update MAC Address 
Configuration.

Fig. 150  Update MAC Address Configuration
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Step 2. This opens the confirmation message box.

Fig. 151  Message box

Step 3. Click Yes. This opens Update MAC Address Configuration option.
Step 4. Enter the Max Master value.

Fig. 152  Max Master value 

Step 5. Enable or disable the Auto MAC option.

Fig. 153  To enable or disable Auto MAC option.

Click OK.



IRM SYSTEM ENGINEERING GUIDE 135

Auto MAC Configuration for multiple Controllers 
You can enable or disable the Auto MAC feature for single or multiple controllers from the 
IrmBacnet Device Manager view.

Steps to Auto MAC Configuration for multiple Controllers:

Step 1. Navigate to the Irm Bacnet Device Manager view and click on MAC Config.
This opens the confirmation message box.

Fig. 154  Database pane

Fig. 155  Confirmation message box

Step 2. Click Yes. This opens Update MAC Address Configuration window.

Fig. 156  To update MAC Address Configurations
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Step 3. Enter the Max Master value.

Fig. 157  Max Master value 

Step 4. Enable or disable the Auto MAC option.

Fig. 158  To enable or disable Auto MAC option

Click OK.

Automatic MAC Address 
In contrast to other controllers, the IRM MSTP controllers feature automatic MAC 
addressing.

The following properties are writable and can be changed:

• Max Master

• Min MAC

• Max MAC

• MAC address.

The property Max Master specifies the highest allowable address for client nodes. Max 
Master is set to 64 by default, which means that it can support up to 62 BACnet MSTP VAV 
controllers, one supervisor, and one BACnet client (tool) per BACnet MSTP network.

Note: When the dip switches are set to all-ON or all-OFF, the controller will run in Auto MAC mode. 
Do not attempt to program a MAC address outside of Min MAC and Max MAC (0 to 60).

If any of the following events occur, the permanent MAC address changes automatically:

Table 25  Default Values

Default Max Master Default MinMAC Default MaxMAC Default Baudrate

64 1 60 38400
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• If the controller's MAC address is set to 0xFF (255), it will attempt to find a new address. 
Auto MAC will be automatically triggered after controller powered on.

• When devices with the same MAC address cause a network conflict.

• A reset to factory delivery is performed if the service pin is pressed and the controller is 
switched on (while the service pin is still pressed). Auto MAC is triggered, and the 
controller tries to find a new address.

Note: The particular MAC addresses 0 and 64 are designated for Auto MAC addressing. Depending 
on the real performance needs and connection speed, connecting fewer BACnet MSTP 
devices per network is recommended. 

It is recommended to connect 40 BACnet MSTP VAV controllers, with one supervisor, and one 
BACnet client (tool) per BACnet MSTP network with a Max Master of 64.

Setting the MSTP MAC Address
On an MSTP network segment, each device's MSTP MAC address must be set to a unique 
value in the range of 1 to 64. The MAC address of the MSTP VAV BACnet controller is set 
using seven DIP switches. 

Note: DIP settings of all-ON or all-OFF (MAC address = 0) activate the Auto MAC mode in the 
controller and prevent the dip switches from being utilized for MAC addressing. 

Fig. 159  MSTP MAC Address Details

Steps to set the MAC address:

Step 1. Identify an available MAC address on the BACnet MSTP network to assign the 
MSTP VAV controller.

Step 2. Locate the DIP switch bank on the MSTP VAV for addressing.
Step 3. Power off the BACnet MSTP and set the DIP switches for the desired MAC 

address.
Step 4. Determine the MAC address using the table below. For example, if DIP switches 

1, 3, 5, and 7 are on, the MAC address would be 85 (1 + 4 + 16 + 64 = 85). 

Fig. 160  Calculating the MAC address

Table 26  DIP switches

DIP 1 2 3 4 5 6 7

VALUE 1 2 4 8 16 32 64

1 432 5 76

ON

1 432 5 76

ON

All ON All OFF

1 432 5 76

ON

1 4 16 64+ + + = 850 + + 0 0 +
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Manually Changing MAC Addresses
You might want to change the MAC addresses in some cases. Assume a network is 
connected to a small number of controllers. In this case, the controller's Auto MAC feature 
may cause significant gaps in the assigned MAC addresses.

Example: The bandwidth will not be optimized if addresses 2, 7, 23, and 31 are used. This 
type of MSTP network is not optimal for bandwidth utilization. To improve the network, 
manually adjust the MAC addresses of the controllers in workbench. Make sure that each 
controller should have a unique MAC address. For more details refer to MAC Address 
Configuration on page 139. 

Important: After you've changed all of the controllers' desired MAC addresses, it's an advisable to set the 
controllers' Max Master to the highest MAC address (Max MAC) among all of them. As a result, 
the MSTP bus works properly. 
MSTP functionality will be unaffected if the Max Master option is not set to the Maximum MAC 
value, however MSTP performance may suffer.

Swapping MAC Addresses
The user can swap the MAC address of a controller (A) with controller (B).

Fig. 161  Assign MAC address

Steps to swap the MAC address:
Step 1. Reassign an available MAC address in the range of 1 to 126 to controller B, 

thereby blocking the required MAC address.
Step 2. Assign the reserved MAC address (old address of controller B) to controller A.
Step 3. Assign the next desired MAC address to controller B (optional step).
Step 4. The previous procedures can be repeated to assign required MAC addresses to 

other controllers. 
Step 5. Change the Max Master setting to the controller with the highest MAC address 

(Max MAC).
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MAC Address Configuration
The MAC address and Max Master setting of the IRM NX controller can be changed using 
the engineering tool.

Steps to configure MAC address:

Step 1. Open the property sheet of the IRM NX controller.

Fig. 162  Controller property sheet

Step 2. In Address property, change the MAC Address. 

Fig. 163  Assign MAC address

Note: In the BACnet MSTP network, the MAC addresses for the individual IRM NX controllers are not 
assigned in sequential order. 

Note: The assigned MAC address for the individual IRM NX controllers in the BACnet MSTP network 
are not assigned in sequential order.
The min MAC to max MAC is available as the proprietary properties id 1028 (min MAC) and 
1029 (maxMAC) under the device object. The MAC Address "0" is reserved for the router/plant 
controller by default.

Step 3. Click Save.
If the new address is the highest address on the MSTP network, make the 
following changes to the maxMaster setting:
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Step 4. Expand the Config or Device Object view.

Fig. 164  Device Object area

Step 5. Enter the highest MAC address of all network controllers in the maxMaster field.

Fig. 165  maxMaster address

Step 6. Click Save.
Step 7. In all network controllers, enter the same maxMaster value.

Note: If the Max Master Setting on the controller is not working. Before attempting to establish the 
maxMaster configuration, the user must first clear the alarm and ensure that the device is 
operational.
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Onboard IO Package 

Onboard IO Links from hardware to BACnet 
When discovering data points on the Bacnet network via the Irm Bacnet device manager, 
the I/O hardware points of the IRM NX controllers are not detected and visible by default.

To expose hardware, I/O points on the Bacnet network must be prepared individually to 
make them discoverable. This is performed by adding a Bacnet function block, for example, 
a Bacnet numeric input, to the periodic or event-driven program and link it to the hardware 
I/O point function block you want to expose on the Bacnet network.

Steps to link controller hardware points:

Step 1. Navigate to the BacnetNetwork > IRM Bacnet Device > IRM Program > 
double-click on the On board IO in the tree.

Fig. 166  On board IO
Step 2. On the wire sheet, identify the I/O hardware point you want to expose to the 

Bacnet network and note its type and name, for example, an analog output with 
the name “AO4 – HwAoFanSpeedCtl”.

Fig. 167  Wire sheet
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Step 3. Right-click the I/O hardware datapoint on the On board IO wire sheet, then click 
Link Mark in the context menu.

Fig. 168  On board IO Wire sheet
Step 4. Double-click Periodic Program in the nav tree and select the wire sheet view. 
Step 5. Add a 'Bacnet Numeric Input' Bacnet function block from the honIrmControl 

palette to the wire sheet. 
Step 6. Change the default name to the name of the hardware I/O point you want to 

expose, for example, 'AO4 – HwAoFanSpeedCtl'. 

Fig. 169  Change the Default Name
Step 7. Click OK. The Bacnet Numeric Input is added to the wire sheet. 

Fig. 170  Wire sheet
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Step 8. Right-click the Bacnet Numeric Input, and click Link Mark From <numeric 
input> or Link Mark To <numeric input> in the context menu.

Fig. 171  Link Mark
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Composite View
The composite view is an interface that allows you to virtually link control points, function 
blocks, and folders that contain control logic. When you create a composite, you create 
slots of child components in the parent component that link the configuration and run the 
control logic.

This interface allows you to group the application using the IrmFolder and IrmSubfolder. 
That contains control logic that is virtually configured with control points, function blocks, 
and folders present in different folders.

Important: Whenever configuring more than 32 Irm folders, it is recommended to divide your application 
and add logic in their folders statically. Use IrmSubFolders to configure items or folders for 
major applications and minor grouping. It will help to better memory management for the 
unitary controller. 

Steps to perform Composite operation:

Step 1. Add Irmfolder from palette to the Periodic program or Event program wire 
sheet.

Step 2. Double-click the Irmfolder and drag the function block to Irmfolders wire sheet.
Step 3. Right-click on the function block and select Composite.

Fig. 172  Function block

Step 4. Add the input and output slots in the composite editor and click OK. 

Fig. 173  Composite Editor
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Step 5. Drag and drop the Const1 Numeric function block to Irmfolder wire sheet, add 
value to the Const1 Numeric, and click Save.

Fig. 174  Property sheet

Step 6. Connect the output slot of Const1 Numeric to the input slots of IrmFolder.

Fig. 175  Irm Folder wire sheet

If the maximum number of IrmFolders is used in the wire sheet, you can add 
IrmSubFolders.

Note: IrmSubFolder cannot be added directly into the Periodic program or Event program. 
IrmSubFolder can only be added inside IrmFolder.
Step 7. Double-click on configured IrmFolder and drag and drop the IrmSubFolders 

function block to wire sheet. After adding the IrmSubFolders function block, 
configure the Const1Numeric function block. 

Fig. 176  honIrmControl Palette

Step 8. Connect the output slot of Const1Numeric to input slots of IrmSubFolders.

Fig. 177  IrmSubFolders

Note: Character renaming of IrmFolder and IrmSubFolder is restricted to up to 20 characters. 
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Terminal Assignment View
The Terminal Assignment View allows users to assign or swap IO terminals without opening 
the On board IO configuration. It also allows changing the IO terminal assignment even if 
the device is swapped. 

Note: Any changes to the online controller terminal assignment view led to a change in sync status 
of the IP/MSTP, Compact VAV, or Unitary to project has modifications in both swap-out and 
swap-in mode.

Note: When the controller is in the swap-in state and the teach mode is set to Immediate any 
changes to the terminal assignment view are instantly taught to the controller and the project 
status is in-sync.

Fig 178. IP/MSTP Controller Terminal Assignment View
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Fig. 179  Compact VAV Controller Terminal Assignment View
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Fig. 180  Unitary Controller Terminal Assignment View
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Configure Terminal Assignment View
Steps to assign the physical points in terminal assignment view:

Step 1. Navigate to the honIrmControl palette and copy the physical point from the 
palette to the Onboard IO wiresheet. Refer to the Onboard IO on page 83 sec-
tion for more details.

Fig. 181  Adding Physical point to Onboard IO wire sheet.

Step 2. Navigate to the Station > Config > Drivers > BACnetNetwork > IRM device.
Step 3. Right-click on the IRM device > Views > select Terminal Assignment View.

Fig. 182  Terminal Assignment View Option

This action displays the Terminal Assignment view of a selected controller.
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Fig. 183  Terminal assignment view zoom options

Step 4. You can perform the zoom operations as explained below:

• Zoom-in: Click on the Zoom-in ( ) icon (the view size will increase by 10 % 
each time you click the Zoom-in icon).

• Zoom-out: Click on the Zoom-out ( ) icon (the view size will decrease by 10 
% each time you click the Zoom-out icon).

• Reset Zoom: Click on the Reset Zoom ( ) icon to set the view to the default 
size (100 %).

• Custom Zoom: Enter a value in the Custom Zoom field ( ) to view the 
controller (by default, the view size will be 100 %, you can customize the size 
by entering the value in the Custom Zoom field). 
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Step 5. Assign the pins to the required terminal pins.

Fig. 184  Assigning UIO or BO Points

The physical points configured in the On board IO wire sheet are displayed in the 
terminal pin drop-down in the Terminal Assignment view.

Step 6. Click Save. The terminal pins are configured with the respective physical points.

Step 7. Check the On board IO wire sheet to verify the changes.

Fig. 185  Onboard IO wire sheet
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Change Terminal Assignments
Example: In the image below, the user has changed the SSR 2 physical point in the 
terminal to the UIO 2 physical point and clicked save. After clicking save, the UIO 2 and SSR 
2 physical points will switch the terminal position between UIO and BO. The change is 
successful because both UIO 2 and SSR 2 physical points have the same In-Type 
characteristic (physical point function block property).

Fig. 186  Swap between UIO and BO terminal

Steps to change the terminal in Terminal Assignment View:

Step 1. Open Terminal Assignment View.

Step 2. Select any previously configured terminal and modify the physical point from 
the drop-down list.

Step 3. Click Save.

After performing the change, check the physical point properties in the Onboard IO wire 
sheet. The pin and pin characteristics of the changed physical point are updated.

Fig. 187  Onboard IO wire sheet

Note: If you perform a swap between unsupported In-Type characteristics UIO or BO terminal, the 
configured UIO or BO terminal changes to unassigned.
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Example: In the below image, if you swap between UIO_1 terminal with SSR_1 terminal and 
click save. 

Fig. 188  Change between UIO_1 terminal with SSR_1 terminal

A message will pop up for confirmation of swapping for unsupported characteristics. 

Fig. 189  Confirmation of swapping

Click yes, the UIO_1 terminal changes to the SSR_1 terminal, and the SSR_1 terminal will 
be changed to unassigned. 

Fig. 190  Unassigned Terminal

After performing the change, check the physical point properties in the onboard IO wire 
sheet. The pin and pin characteristics of the changed physical point are updated. 

Note: The physical points with the fault cause will not appear in the terminal assignment view drop-
down list.
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For example, UIO_6 has a fault cause in the AO terminal and it will not be shown in the UIO 
terminal drop-down list.

Fig. 191  Fault state in the UIO terminal

Note: If the In-Type, In Characteristic, or both properties of UIO physical points are linked to any 
function block, the UIO physical points will not appear in the Terminal Assignment View drop-
down list.

For example, UIO_7 has a link to In-type, and it will not be shown in the BO terminal drop-
down list.

Fig. 192  In-Type property of UIO terminal

Modify the Terminals in Swap-Out Condition
You can modify the assigned terminal in the terminal assignment view when the controller 
is in the swapped-out state. After making changes in the terminal assignment view, save 
the changes. When the controller is swapped-in, you can verify the changes in the onboard 
IO wire sheet.

Important: Only the physical points with the same In-Type characteristic can switch between UIO and BO 
terminals or vice versa.

Steps to modify the terminals in the swapped out condition: 

Step 1. Open Terminal Assignment View and modify the required terminals. Refer to 
the Change Terminal Assignments on page 152.

Step 2. Click Save.

When the controller is swapped-in, you can see the changes in the Onboard IO wire sheet.

Note: The unassigned terminals will not appear in the terminal assignment view.
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ENGINEER THE CONTROLLERS 
(ENGINEERING MODES)

Add Controller Setup with Service Pin
Use this procedure when you do not have the controller's serial number. 

Steps to setup controller without using serial number:

Step 1. Double-click the BacnetNetwork folder in the Nav tree, select the Irm Bacnet 
Device Manager view, and click New.

Fig. 193 Irm Bacnet Device Manager View
Step 2. In the New dialog box, select Irm Bacnet Device from the drop-down list and 

click OK.

Fig. 194 New Window
Step 3. This opens the device property sheet.

If require you make the following changes:
• Name: Rename the device. 
• Type: Change the device type.
• Network address: Enter the network address.
• MAC Address: Enter the MAC address.
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• Enabled: Select the required option from the drop-down, true (default) or 
false.

• Use Cov: Select the required option from the drop-down, true or false 
(default).

• Use Cov Property: Select the required option from the drop-down, true or 
false (default).

• Keep Max Cov Subscriptions as max.

Fig. 195 Irm Bacnet Device Property Sheet
Step 4. Click OK.

The IRM is created and added to the database.

Fig. 196 Database Pane
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Step 5. Expand the IRM and configure the IRM Program. 

Fig. 197 IRM Program 
Step 6. Visit the site and connect to the Bacnet network to get online.
Step 7. Go to the Irm Bacnet Device Manager view and click Discover. All the devices 

communicating will be discovered. 

Fig. 198 Database Pane
Step 8. Press the service pin to match an offline IRM NX controllers with a online IRM NX 

controller. Perform the same procedure for all devices that need to be matched. 
This action will discover and list the devices in the discovered section as per 
service pin rank. 

Note: In the service pin rank column, the service pin action is indicated by consecutive numbers 
depending on when the service pin was pressed on the device.

Fig. 199 Service Pin Rank
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Step 9. In the Discovered view, select the online device, and in the Database view, select 
the offline device.

Fig. 200 Discovered Pane
Step 10. Click Match. 

The properties of the online BACnet device are matched to the offline BACnet 
device in the database pane. The properties of the following devices are updated:

Step 11. If desired, you can change the name, device id, network number, and MAC 
address, and enable Use Cov by selecting “true” from the drop-down list.

Step 12. Click OK.

Fig. 201 Irm Bacnet device Property

Fig. 202 Database View

• Name • Firmware Revision • Irm Sync Status
• Type • Serial Number • Irm Last Change
• Device ID • Irm Family • Irm Master Sync

• Status • Irm Program Name

• Model • Irm Application Type
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Step 13. Perform the hardware compatibility check to ensure that the application is 
appropriately designed to run seamlessly in the created device. To perform 
hardware compatibility, refer to Check Hw Compatibility on page 179.

Step 14. Click Teach Full Application to Controller. 
If you want to match a BACnet device to a new IRM controller, or if you want to 
clear all previous configurations from the IRM controller and download the new 
configuration.

Or

Click Teach to Controller. 
If you want to modify an existing program in the IRM controller. 

Note: If a large application is created in the controller, it is recommended to perform Teach Full 
Application To Controller.

A notification message will appear. If there are any application inconsistencies between the 
offline and online devices, the control manager will indicate the relevant synchronization 
status.

To resolve any inconsistencies, synchronize the applications by performing any of the 
following actions:

• Clear Project • Learn from Controller
• Clear Controller • Check Application Compatibility

• Teach To Controller
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Controller Setup using Serial Number
Before working on this procedure, make sure you have the device name, serial number, and 
device id of the controller, which needs to be matched.

Steps to setup controller using serial number:

Step 1. Expand the BacnetNetwork in the Nav tree.

Step 2. Right-click the IrmConfig > Action > click Add Serial Number.

Fig. 203 Add Serial Number
Step 3. Enter the Device Name, Serial No and Device Id. If a barcode scanner is 

available, use a barcode scanner to get the barcode data, copy and paste the 
data in the respective field. 

Fig. 204 To Add Device Name and Serial Number
Or
Enter the data manually:
• Enter 0000 in the serial number field. The serial number is case-sensitive 

and should match the serial number printed on the product label.

• Enter the correct device name and device id as per the online IRM NX 
controller you wish to configure. For example,

Fig. 205 Service Pin Device
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Step 4. Click OK. The device gets added to the IrmConfig property sheet.

Fig. 206 IrmConfig Property Sheet
Repeat the steps 2 to setp 4 to add all the controllers to the IrmConfig property 
sheet.

Step 5. Go to the Irm Bacnet Device Manager view and click Discover. All of the offline 
devices will display in discovery view.

Fig. 207 Discover Pane
Step 6. Select the device from the discovered view and click Add. 

Fig. 208 Device Property Sheet
If desired, you can change the Name, Device ID, Network number, and MAC 
Address, and enable Use Cov by selecting “true” from the drop-down list.

Step 7. Click OK. This adds an offline controller to the Database.

Fig. 209 Discover Pane and Database Pane
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Step 8. Expand the device and create the IRM Program by adding control strategy, 
hardware layout, and alarm settings (optional). 

Fig. 210 Offline Device Add under Bacnet Network
Visit the site, go online by connecting to the Bacnet network.

Step 9. Go to the Irm Bacnet Device Manager view and click Discover. In the discovered 
view, all the offline devices will be displayed.

Fig. 211 To Discover the Controllers

The engineering tool discovers the controllers having the same serial numbers issued 
offline.

Or

Press the service pin to match an offline IRM NX controller with a online IRM NX controller. 
Perform the same procedure for all devices that need to be matched. This action will 
discover and list the devices in the discovered section as per service pin rank. 

Note: In the service pin rank column, the service pin action is indicated by consecutive numbers 
depending on when the service pin was pressed on the device.

Step 10. Select the online device in the Discovered section and the offline device in the 
Database section.
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Fig. 212 Irm Bacnet Device Manager View
Step 11. Click Match. 

The online device properties are matched to the offline Bacnet device indicated 
in the Database section. Following device properties are updated:

Step 12. If desired, you can change the name, device id, network number, and MAC 
address, and enable Use Cov by selecting “true” from the drop-down list.

Step 13. Click OK. 

• Name • Irm Family
• Type • Irm Program Name
• Device ID • Irm Application Type
• Status • Irm Sync Status
• Model • Irm Last Change
• Firmware Revision • Irm Master Sync
• Serial Number 
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Fig. 213 Discover and Database view
Step 14. Perform the hardware compatibility check to ensure that the application is 

appropriately designed to run seamlessly in the created device. To perform 
hardware compatibility, refer to Check Hw Compatibility on page 179.

Step 15. Click Teach Full Application to Controller. 
If you want to match a BACnet device to a new IRM controller, or if you want to 
clear all previous configurations from the controller and download the new 
configuration.

Or

Click Teach to Controller. 
If you want to modify an existing program in the controller. 

Note: If a large application is created in the controller, it is recommended to perform Teach Full 
Application To Controller.

A notification message will appear. If there are any application inconsistencies between the 
offline and online devices, the control manager will indicate the relevant synchronization 
status.

To resolve any inconsistencies, synchronize the applications by performing any of the 
following actions:

• Clear Project • Learn from Controller
• Clear Controller • Check Application Compatibility

• Teach To Controller
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Discover Online Controller
Use this method when the controller is online.

Steps to discover online controller:

Step 1. Connect to the Bacnet Network.

Step 2. Navigate to the Irm Bacnet Device Manager view and click Discover. All the 
available controllers in the Bacnet Network are discovered.

Fig. 214 Discovered Controller

Note: In the Service Pin Rank column, the rank of the service pin is indicated by consecutive 
numbers depending on the sequence when the service pin was pressed on the controller. The 
service pin rank will not be available until the user presses the service button on the controller. 

Step 3. Select the controller you want to add to the database and click Add.

Fig. 215 Adding Controller to Database
Step 4. If desired, you can change the name, device id, network number, and MAC 

address, and enable Use Cov by selecting “true” from the drop-down list.
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Fig. 216 Device Property Sheet
Step 5. Click OK. This action adds the controller to the database, and the controller 

properties are updated.

Fig. 217 Database view

Step 6. Verify the following properties of the added controller.

Step 7. Add the logic or application to the controller such as adding function block to 
wiresheet and creating logic or application.

Step 8. Perform the hardware compatibility check to ensure that the application is 
appropriately designed to run seamlessly in the created device. To perform 
hardware compatibility, refer to Check Hw Compatibility on page 179 and Check 
Application Compatibility on page 180.

Step 9. Click Teach Full Application to Controller. 
If you want to match a BACnet device to a new IRM controller, or if you want to 
clear all previous configurations from the controller and download the new 
configuration.

Or

Click Teach to Controller. 
If you want to modify an existing program in the controller. 

Note: If a large application is created in the controller, it is recommended to perform Teach Full 
Application To Controller.

A notification message will appear. If there are any application inconsistencies between the 
offline and online devices, the control manager will indicate the relevant synchronization 
status.

To resolve any inconsistencies, synchronize the applications by performing any of the 
following actions:

• Name • Irm Family
• Type • Irm Program Name
• Device ID • Irm Application Type
• Status • Irm Sync Status
• Model • Irm Last Change
• Firmware Revision • Irm Master Sync
• Serial Number 

• Clear Project • Learn from Controller
• Clear Controller • Check Application Compatibility

• Teach To Controller
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Common Operations of IRM Program
This section explains the common operations you can perform during application 
engineering on IRM NX controller.

Fig. 218 Common operation of IRM Program

Following are the operation you can perform in IRM Program.

Table 27  Common operation of IRM Program

Operations Descriptions

Reset Overrides To fix override issues in the function block.

Ping To check the connectivity between engineering tool 
and controller.

Teach To Controller Downloads changes in the application of the project 
to the controller.

Teach Full Application To 
Controller

Downloads full application of the project to the 
controller.

Learn from Controller Uploads current application from the controller to 
project.
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Check Hw Compatibility
Checks hardware compatibility Verifies the hardware 
configuration defined for the controller in the 
application is compatible with the physical controller.

Check Application 
Compatibility

Validates and compiles Sylk devices and checks 
application compatibility.

Clear Controller Deletes the application from the controller.

Clear Project Deletes the application from the project.

Take Snapshot Backup the application.

Restore Snapshot Restore the backup application to the project

Swap
Swap In- Restores saved application to RAM
Swap Out- Makes app backup and swaps application 
out of RAM.

Set Controller Password Set controller Password.

Reset Tool Password Reset the password for a controller.

Ping Sylk Devices
Sylk ping verifies and displays
status based on the connected Sylk device connected 
to the network.

Validate Sylk Device It is used for validating the Sylk configuration in the 
application.

Toggle Parameter Default 
Action Visibility To hide or show parameter default action. 

Update All Bacnet Object 
Values from Controller to 
Application

Synchronize the controller values with the application 
values.

Replace Text A Block and Ws 
Text Blocks with Irm Ws Text 
Block

Convert any TextA Function Block to the 
IRMWsTextBlock Function Block.

Table 27  Common operation of IRM Program (Continued)

Operations Descriptions
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Reset Overrides
Reset overrides fix the override issue in the function blocks. Any function block that have 
multiple links to the same slot can fall into override state, this is a Niagara behavior. Reset 
Overrides removes the multiple links from the same slot of the function blocks.

Steps to perform the Reset Overrides:

Step 1. Expand the Station > Config > Drivers > Irm Bacnet device > IRM Program. 

Step 2. Right-click on the IRM Program > Actions > select Reset Overrides. 
This action will remove the override state of the function block.

Fig. 219  Reset Overrides

Note: In the latest tool, when adding a new link to the function block through the composite method, 
you will be notified by a popup message suggesting to delete either of the links if a link already 
exists in the slot. 

Fig. 220 Confirmation Dialog Box

Note: Perform reset overrides before performing the full teach operation to avoid override issues in 
the function block.
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Remove the Links for a Single Function Block
This procedure allows you to remove the links for a single function block by performing the 
reset override operation.

Steps to perform the Reset Overrides for a single function block:

Step 1. Open the function block in the wire sheet view.

Step 2. Right-click on the function block > Actions > select Reset Overrides.

Fig. 221 Reset overrides for single function block

Remove the Links Manually
Steps to remove the link manually in the relation sheet:

Step 1. Open the function block in the wire sheet view.

Step 2. Right-click on the function block > Views > select Relation Sheet.

Fig. 222 Open the Relation sheet 
Step 3. Find the repeated link, right-click on one of the links and click Delete.

Fig. 223 Relation sheet
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Ping
To check the connectivity between engineering tool and controller.

Steps to perform Ping:

Step 1. Right-click on IRM Program, click Actions > Ping.

Fig. 224 Ping
Step 2. Click OK.

Fig. 225 Warning Message
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Teach To Controller
Teach to controller downloads the changed application of the project to the controller. This 
can happen in two ways:

• Immediate: Changes are written to the controller automatically and are effective 
immediately.

Note: When working in “Immediate” teach mode, no messages are displayed, and no changes are 
graphically indicated while changing applications.

• On demand: Changes are written to the controller manually and are effective after 
“Teach to Controller” action.

Steps to perform Teach To Controller:

Step 1.  Right-click on IRM Program > Actions > and then click Teach to Controller.

Fig. 226 Teach to Controller
Step 2. Select Overwrite BACnet objects values in Device or Overwrite BACnet object 

values in Application.

Fig. 227 Teach To Controllers Dialog Box
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• Overwrite BACnet objects values in Device: This option overwrites Bacnet object 
values in the controller and teaches application to the controller.

• Overwrite BACnet object values in Application: This option update all Bacnet 
object values and default values from controller to application and, then it teaches 
the application to the controller.

Step 3. Click OK.
The changes are written to the controller, and the applications are synchronized. 
The successful action displays in the workbench job service.

Note: Teaching full application to the controller may be required if the maximum APDU size and 
segmentation supported under device object properties are not updating in the controller, 
resulting in commissioning failures.

Teach to Multiple Controllers 
Perform “Teach to Controller” operation from “Irm Bacnet Device Manager” view to teach to 
changes of application to the multiple controller.

Steps to perform Teach on multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the controllers from the device list.
Step 3. Click Teach to Controller. This action opens teach to controller dialog box.

Fig. 228 Teach to Controller Dialog Box
Step 4. Select Overwrite BACnet objects values in Device or Overwrite BACnet object 

values in Application.

Fig. 229 Teach to Controllers dialog box
Step 5. Click OK.

The changes are written to the controller, and the applications are synchronized. 
The successful action displays in the workbench job service.
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Teach Full Application To Controller
Teach Full Application To Controller deletes all existing configurations from the controller 
and downloads the new configuration to controller.

Note: While performing teach full application to controller, it is recommended to keep a backup of 
the previous configuration.

Steps to perform Teach Full Application To Controller:

Step 1. Right-click on IRM Program > Actions > click Teach Full Application to Con-
troller in the context menu.

Fig. 230 Teach Full Application To Controller
Step 2. Select Overwrite BACnet objects values in Device or Overwrite BACnet values 

in Application.

Fig. 231 Teach to Controllers dialog box
Step 3. Click OK.

The changes are written to the controller, and the applications are synchronized. 
The successful action displays in the workbench job service.
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Application Full Teach to Multiple Controllers
Perform “Application Full Teach to Controller” operation from “Irm Bacnet Device Manager” 
view to downloads the new configuration to the multiple controller.

Steps to perform Application Full Teach on multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the controller from the device list.
Step 3. Click Application Full Teach to Controller. This action opens Teach To 

Controller dialog box.

Fig. 232 Application Full Teach to Controller
Step 4. Select Overwrite BACnet objects values in Device or Overwrite BACnet object 

values in Application.

Fig. 233 Teach to Controllers dialog box
Step 5. Click OK.

The changes are written to the controller, and the applications are synchronized. 
The successful action displays in the workbench job service.
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Overwrite Application Teach
Overwriting an application is permitted for all the controllers on Bacnet network.

Fig. 234 Teach Modified Controller
• Deny (Default value): Do not allow overwriting of an existing application in the 

controller. While trying to teach a different application to a controller, an error 
message is generated, requiring clearing the controller.

• Allow: Allows to overwrite an existing application.
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Learn from Controller
Learn from Controller uploads the current application from the controller in the project. 

Steps to perform Learn from Controller:

Step 1. Right-click on IRM Program > Actions > and then click Learn From Controller 
in the context menu.

Fig. 235 Learn from Controller

The applications are uploaded to the controller, and the applications are synchronized. The 
successful action displays in the workbench job service.

Note: When Learning From Controller is completed, the project's application is deleted.

If the synchronization status is different, a message recommends either clearing the 
project (discard modifications) or teaching the controller (discard modifications in the 
controller).

Fig. 236 Warning Message
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Learn from Multiple Controllers 
Perform “Learn from Controller” operation from “Irm Bacnet Device Manager” view to 
uploads all the changes of application from multiple controller to the project.

Steps to perform Learn from multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the controller from the device list.
Step 3. Click Learn from Controller. This action opens the learn from the controller 

dialog box.

Fig. 237 Database Pane
Step 4. Click Yes.

Fig. 238 Learn from Controller Dialog Box

The applications are uploaded to the controller, and the applications are synchronized. The 
successful action displays in the workbench job service.
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Check Hw Compatibility
Using this option, you can check the hardware configurations and the hardware defined for 
the controller in the application. Any differences are indicated on the Hw compatibility job 
log.

Steps to perform Check Hw Compatibility:

Step 1. Right-click on IRM Program > Actions > and click Check Hw Compatibility.

Fig. 239 Check Hw Compatibility

Fig. 240 Error message
Step 2. Click OK, then remove the incorrect or unused terminals.
Step 3. Perform Teach the controller.

The successful action displays in the workbench job service.
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Note: The user can view the error details by double-clicking on the job log.

Fig. 241 Job Log and Log Details

Check Application Compatibility
Check the application's compatibility for the IRM NX controller.

Steps to perform Check Application Compatibility:

Step 1. Right-click on IRM Program > Actions > and click Check Application Compati-
bility.

Fig. 242 Check Application Compatibility
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Clear Controller
The clearing controller deletes the entire project from the controller.

Note: While clearing the controller and loading the Sylk configuration to the controller (proxy file to 
the controller), 20 VDC output will turn off for 30 seconds. All I/O terminals will be down for 
30 seconds. It will only happen when CentraLine-N4 changes the Sylk application or deletes 
the application from the controller. It will not happen once the application teach completes 
and the controller is running.
Steps to perform Clear Controller:

Step 1. Right-click on IRM Program > Actions > and then click Clear Controller in the 
context menu.

Fig. 243 Clear Controller
Step 2. Click Yes to delete the project from the controller.

Fig. 244 Clear Controller confirmation
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Clear Multiple Controllers
Use the "Clear Controller" operation from the "Irm Bacnet Device Manager" view to delete 
the entire project from the multiple controllers.
Steps to perform Clear multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the controllers from the device list.
Step 3. Click Clear Controller. This action opens the clear controller dialog box.

Fig. 245 Database Pane
Step 4. Click Yes.

The application is removed from all the selected controllers. Workbench job 
service displays the successful action.
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Clear Project
The clear project operation removes all engineering programs from the project of the 
controller.

Steps to perform the Clear Project:

Step 1. Right-click on IRM Program > Actions > and then click Clear Project in the 
context menu.

Fig. 246 Clear Project
Step 2. Click Yes to clear the engineering project from the controller.

Fig. 247 Clear Project confirmation 
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Clear Project from Multiple Controller
Use the "Clear Project" operation from the "Irm Bacnet Device Manager" view to clear the 
engineering  project from the multiple controllers.

Steps to perform Clear Project on multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the controllers from the device list.
Step 3. Click Clear Project. This action opens the clear controller dialog box.

Fig. 248 Database Pane
Step 4. Click Yes.

Fig. 249 Clear Controller Dialog Box

The application is removed from all the selected controllers. Workbench job service 
displays the successful action.

Fig. 250 Job Log
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Take Snapshot
The Take Snapshot feature allows back up the current application's state and can be 
restored later.

Steps to perform Take Snapshot:

Step 1. Right-click on IRM Program > Actions > click Take Snapshot in the context 
menu.

Fig. 251 Take Snapshot

The application is backed up. Workbench job service displays the successful action.
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Restore Snapshot
The Restore Snapshot feature allows you to restore the backup. It allows you to restore an 
application if you want to discard changes.

Steps to perform Restore Snapshot:

Step 1. Right-click on IRM Program > Actions > and click Restore Snapshot.

Fig. 252 Restore Snapshot
Step 2. Select the required backup file (.bog file) and click OK.

Fig. 253 Selecting backup file

The application is restored. Workbench job service displays the successful action.
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Swap
The Swap features allows to reduce the processing load of the station. 

Important: It is strongly recommended to swap-out the application after finishing the engineering in 
online or offline mode.

Note: Synchronization does not work for swap-out devices. The devices must be swapped-in again 
to synchronize. You can swap single devices or multiple devices at once.:
Steps to perform Swap on a controller:

Step 1. Right-click on IRM Program > Actions > and click Swap.

Fig. 254 Swap

The device displays the minimum information when an online or offline device is swapped 
out. In swap-out state, the controller data is saved on the PC disk.

Fig. 255 Swap-out State
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To swap-in the device, right-click on IRM Program > Actions > and click Swap in the 
context menu.

Fig. 256 Swap-In State

After performing the swap-in on the device, all of the device's properties are displayed in 
the IRM Program.

Swap Out Multiple Controllers
If you want to “Swap Out” multiple controllers under Bacnet network, follow the below 
steps.

Steps to perform Swap Out on multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select desired controllers from the device list.
Step 3. Click Swap Out.This action displays Swap Out dialog box. 

Fig. 257 Database pane
Step 4. Click Yes.

Fig. 258 Swap Out Dialog Box
The successful swap-out is displayed in the workbench job service.
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To “Swap In” multiple controllers under Bacnet network, follow the below steps.

Steps to perform Swap In on multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select the desired controllers from the device list.
Step 3. Click Swap In. This action displays Swap In dialog box. 

Fig. 259 Database pane
Step 4. Click Yes.

Fig. 260 Swap In dialog box

The devices are swapped in. The successful swap-in is displayed in workbench job service.
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Swap Out All Controllers
If you want to “Swap Out” all the controllers under Bacnet network, follow the below steps.

Steps to perform Swap Out on all controllers:

Step 1. Expand the Bacnet network.

Step 2. Right-click on IRM Program > Actions > click Swap Out.

Fig. 261 Swap Out

To “Swap In” all the controllers under Bacnet network, follow the below steps.

Steps to perform Swap In on all controllers:

Step 1. Right-click on the IrmConfig folder > Actions > click Swap In.

Fig. 262 Swap In
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Set Controller Password
The Set Controller Password allows you to set tool and controller passwords for secure 
commissioning communication.

Secure commissioning communication is introduced for IRM NX controller commissioning, 
beginning with controller firmware version 1.0.1.9 and engineering tool version 1.0.1.7. The 
controller and engineering tool version 1.0.1.7 use an invisible default password in the 
initial state (default factory setup).

Note: Resetting the controller password means conducting a manual factory reset for every 
controller. The engineering tool and the IRM NX controller must share the same password to 
communicate. 

Note: When switching projects or discovering IRM controllers, the passwords may need to be re-
entered on one or both sides. Passwords may be set using the engineering tool's set password 
for function. The password can be set just for the “Tool” or the “Tool And Controller”.

Fig. 263 Set Password Option

Steps to Set Password for single controller:

To set the password, right-click on BacnetNetwork > Views > Set Controller Password. 

Fig. 264 Set Controller Password
Step 2. In the Set Controller Password window, enter the New Password, Repeat New 

Password, and select the Tool or Tool And Controller option.
While creating password follow the password requirement mentioned in the 
Hint.
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Click OK

Fig. 265 Set Controller Password

Setting Password for all Controllers
If you want to set the password for all of the controllers, follow the steps below.

Steps to Set Password for all controllers:

Step 1. Expand the BacnetNetwork.

Step 2. Right-click on IrmConfig > Actions > click Set Controller Password.

Fig. 266 Set Controller Password
Step 3. Click Yes.

Fig. 267 Change Global Controller Password dialog box
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Step 4. Enter the Old Password, New Password, Repeat New Password, and Set 
Password for the tool or tool and controller.

Fig. 268 Set Controller Password
Step 5. Click OK.

To ensure that the password in the controller and the engineering tool is same, use Set 
Password for function to select where the password should be changed. 

Note: If you are creating a password for the first time, the old password field should be empty.
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Reset Tool Password
The Reset Tool Password feature allows to reset the controller password.

Steps to reset controller password:

Step 1. Navigate to the Station > BacnetNetwork > IrmBacnetDevice > select IRM 
Program.

Step 2. Right-click on IRM Program > Actions > Reset Tool Password.

Fig. 269 Reset Tool Password
Step 3. Enter the Old Password and click OK.

Fig. 270 Reset Tool Password

Note: A controller password can only be reset by performing a factory reset. Refer to Reset to 
Factory Default on page 352.
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Reset Password for all Controllers
If you want to reset the password for all of the controllers, follow the steps below.

Steps to reset password for all controllers:

Step 1. Navigate to BacNetwork and right-click on IRMConfig > Actions > Reset Tool 
Password.

Fig. 271 Reset Tool Password
Step 2. Enter the Old Password and click OK.

Fig. 272 Reset Tool Password

Note:  A controller password can only be reset by performing a factory reset. Refer to Reset to 
Factory Default on page 352.
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Password reset use cases
The table below depicts many use cases for changing setting the controller's password.

Table 28  Use Cases for Password Reset

Use Case Firmware version
≥ 1.0.1.9

Engineering Tool
≥ 1.0.1.7 Description

User 
commissioning 
the controller for 
first time

New controller 
connected to 
Bacnet network.
 
The device is 
discovered and 
added to the Irm 
device manager 
view for the first 
time. 

The device is 
discovered and 
added to the Irm 
device manager 
view for the first 
time. 

The default 
password is used 

The default password is used for teach /
learn / ping / clear controller. 

For commissioning, use the default 
password and then input the user-
defined password. Keep the user-defined 
password secure for future use.

Without a user-defined password, it is 
impossible to read / learn the 
application logic from the controller. 

Set a user-defined password in the 
Bacnet program actions menu by 
selecting set controller password. 
Reset the user-defined password to the 
default password using the set controller 
password option in the Bacnet program 
actions menu.

Set common user 
defined password 
for all controller 

New controller 
connected to 
Bacnet network. 

Default Password 
is set from the 
factory. 

The device is 
discovered and 
added to the Irm 
device manager 
view for the first 
time. 

In the engineering 
tool and all 
controllers, the 
default password is 
automatically 
assigned.

The default password is used for teach /
learn / ping / clear controller. 

The user can set the user-defined 
password in the engineering tool and all 
controllers.

Users should use the set controller 
password actions menu of IrmConfig in 
Bacnet network. 

When a user-defined password is 
created for the first time, the Old 
Password field remains empty.

Change common 
user defined 
password for all 
controllers 

Existing 
controllers. 

The user previously 
specified the 
password during 
commissioning. 

The engineering 
tool has the same 
user-defined 
password as all 
controllers. 

The users want to 
change the user-
defined password 
in all controllers. 

The existing user-defined password is 
used for teach /learn / ping / clear 
controller.  

Users can change the user-defined 
passwords in all controllers. 

Users should use the set controller 
password actions menu of IrmConfig in 
Bacnet network. The old and new 
passwords must be entered. 
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Application 
modification in 
the controller by 
another user 

Existing 
controllers. 

The user previously 
specified the 
password during 
commissioning.  

All the controllers 
have a user-
defined password. 

User 2 discovers 
the devices and 
add them devices 
into the Irm device 
manager. 

• The user-defined password is set by 
User 1. 

• User 2 uses the different user-
defined passwords and gets the error 
message (There is an error in 
controller communication. It could 
be a password mismatch in the 
controller and station).

User 2 can not teach / learn / ping /clear 
the controller until the user-defined 
password from user 1 is set in the 
engineering tool. 
All engineering operations can be 
performed after entering User 1 defined 
password.

Important: If the user-defined password 
is forgotten, the controller must be factory 
reset and re-commissioned.

Modify 
application in 
existing controller 
with the same 
station 

Existing 
controllers. 

The user-defined 
password is already 
set 

Existing station. 

The user-defined 
password is already 
set. 

All engineering operations can be 
performed. 

Modify 
application in 
existing controller 
with other station 

Existing 
controllers. 

User-defined 
password is already 
set 

Another station. 

The user-defined 
password is already 
set. 

The user-defined 
password does not 
match with the 
password set in the 
controller. 

The user gets an error in the job log and 
dialog box while performing teach / ping 
/ learn.
 
There is a problem with controller 
communication. There may be a 
password mismatch between the 
controller and the station. 

Solution: In the engineering tool, reset 
the user-defined password. Set the user-
defined password that will be used in the 
controller and the engineering tool. 

Table 28  Use Cases for Password Reset (Continued)

Use Case Firmware version
≥ 1.0.1.9

Engineering Tool
≥ 1.0.1.7 Description
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Modify 
application with 
the new station 

Existing 
controllers. 

The user-defined 
password is already 
set.

New station 
devices are 
discovered and 
added into station 
database. 
Default user 
password is set in 
the engineering 
tool.

The user gets an error in the job log and 
dialog box while performing teach / ping 
/ learn. 

There is a problem with controller 
communication. There may be a 
password mismatch between the 
controller and the station.

Solution: Reset user-defined password 
in the engineering tool. Default user 
passwords will be used in the 
engineering tool. 

Replace the 
damaged 
controller with the 
new controller 
from the factory. 

New controller 
Default user 
password is set 
from the factory. 

Users use the same 
station to 
configure the 
controller again. 

In station, the user-
defined password 
is set. 

User cannot perform teach /learn / ping 
/ clear controller. 
Solution 1: Reset the user-defined 
password in the engineering tool. 
Default user passwords will be used in 
the engineering tool. 
Then do the match between the 
controller in the engineering tool and the 
new controller added in the network. Set 
user-defined password again. 

Solution 2: Backup of the application 
logic using engineering tool. Delete the 
controller from the database within the 
engineering tool. Add the newly 
discovered device into the station 
database and restore the backup. 

Note: After replacing a damaged 
controller with the new controller, you can 
either commission the application already 
present in the station or replace the 
database device with backed-up device 
data.
When restoring the application using the 
device already present in the station, 
please ensure you put the device in the 
database into the "Swapped In" mode. 
After swapping logic backed up in the 
controller, the repository will be made 
available in the station database. The 
user can commission the newly replaced 
device. To learn more about device 
swapping, refer to Swap on page 187.

Table 28  Use Cases for Password Reset (Continued)

Use Case Firmware version
≥ 1.0.1.9

Engineering Tool
≥ 1.0.1.7 Description
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Password Status
The Irm Bacnet Device manager now includes a Password Status column, which allows 
users to quickly monitor the status and detect issues when creating a password for the IRM 
NX controller.

The following status will be shown in the password status column:

• Not supported: If the firmware version is below 1.0.2.2.

• Default password: If no password is entered.

• User password: When the password is be set or changed.

• Password mismatch: If the tool password does not match with the controller password.

Fig. 273 Password Status

User want to reset 
controller to 
factory-default 

Existing 
controllers. 

User-Defined 
Password is set.

Existing station. 

A user-defined 
password is set. 

Perform a factory reset at the controller. 

Reset the user-defined password in the 
engineering Tool. Discover and match 
with the controller in the engineering 
tool. Set the user-defined password and 
do the commissioning. 

Copy device on the 
new controller in 
the network 

New Controller 
added to the 
network. 

Default user 
password is set 
from the factory 

Copy from the 
controller in the 
station having a 
user-defined 
password set. 

User matching the 
cloned device with 
a new controller 
added to the 
network. 

The copy function will copy the password 
from the existing device. 

Solution: Reset the user-defined 
password in the engineering tool. The 
default user password will be used. Set 
the user-defined password used in the 
old controller. 

Clone application 
from one 
controller to 
another controller

Clone application 
logic from one 
controller to 
multiple controllers 
or single controller 
in Irm device 
manager view

The clone operation in the Irm device 
manager view does not alter the 
password in the target controllers. 
Furthermore, the password will not be 
copied from the source controller to the 
target controller.

Table 28  Use Cases for Password Reset (Continued)

Use Case Firmware version
≥ 1.0.1.9

Engineering Tool
≥ 1.0.1.7 Description
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Ping Sylk Devices
Perform the “Ping Sylk Devices” operation to verify and displays the status of the 
connected Sylk device to the network.

Note: The duration of the Sylk Device ping is two minutes.

Steps to Ping the Sylk Devices:

Step 1. Navigate to the Station > BacnetNetwork > IrmBacnetDevice > IRM Program.
Step 2. Right-click on IRM Program > Actions > Ping Sylk Devices.

Fig. 274 Sylk Device Ping
• If no device is connected at the set address, the “Status” displays Down; in this case, the 

“Fault Cause” displays No device identified, and Sylk device suspends read-write 
operations.
All Sylk parameters associated with the Sylk device will also be updated with the same 
status and fault cause.
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• If the user has configured TR75 and connected TR42 at the configured address, the 
“Status” displays down. In this case, “Fault Cause” shows 'Incompatible device found 
and Sylk device stops read-write operation. 

Fig. 275 Sylk Device Function Block property sheet
• If the device configured matches the device connected to the network, the “Status 

displays (ok), and the Sylk device resumes read-write operation.

Note: The user should open the property sheet for each Sylk device and verify the Sylk device fault 
cause if they ping multiple Sylk devices at the same time.
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Validate Sylk Device
The “Validate Sylk Device” is used for validating the Sylk configuration in the application. 
Also, the validation action confirms any incorrect value entered in parameters or limitations 
for the configured Sylk device. For more details, refer to Validate Sylk Device on page 286.

Steps to perform Validate Sylk Device:

Right-click on IRM Program > Actions > click Validate Sylk Device

Fig. 276 Validate Sylk Device
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Toggle Parameter Default Action Visibility
The Toggle Parameter Default Action Visibility is used to hide or show parameter default 
action.

Steps to perform Toggle Parameter Default Action Visibility:

Step 1. Navigate to the Station > BacnetNetwork > IrmBacnetDevice > IRM Program.
Step 2. Right-click on IRM Program > Actions > click Toggle Parameter Default Action 

Visibility.

Fig. 277 Toggle Parameter Default Action Visibility
This action open Toggle Parameter Default Action Visibility option.

Fig. 278 Toggle Parameter Default Action Visibility options
Step 3. Set it to “false”, if you want to hide the parameter default action.

Or
Set it “true”, if you want to show default parameter action to the user.
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Update All Bacnet Object Values from Controller to Application
The “Update All Bacnet Object Values From Controller To Application” option allows the 
user to synchronize the values of the controller and the application. When you perform a 
full teach to the controller, you ensure that the controller values are not overwritten by wire 
sheet values that are out of sync. It will keep the controller's object values.

Steps to perform Update all Bacnet object Values From Controller To Application:

Step 1. Navigate to the Station > BacnetNetwork > IrmBacnetDevice > select IRM 
Program.

Step 2. Right-click on IRM Program > Actions > Update All Bacnet Object Values From 
Controller To Application.
This action opens the Update All Bacnet Objects dialog box.

Fig. 279 Update All Bacnet Object values from Controller to Application
Step 3. Click Yes to update the default values for all the connected Bacnet objects.

Fig. 280 Update All Bacnet Objects
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Update BACnet object values for multiple controllers 
If you want to update Bacnet object Values for multiple controllers, follow the below 
procedure.

Steps to perform Update Bacnet object values for multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the controllers from the device list.
Click Update All Bacnet Objects. This action displays Update All Bacnet Objects 
dialog box.
This action opens the Update All Bacnet Objects dialog box.

Fig. 281 Database Pane
Step 3. Click Yes to update the default values for all the connected Bacnet objects.

Fig. 282 Update All Bacnet Objeccts dialog box

Note: Update All Bacnet Object Values From Controller To Application only works if both the 
controller and the application are in Sync mode.
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Replace Text A Block and Ws Text Blocks with Irm Ws Text Block
The “Replace Text A Block and Ws Text Blocks with Irm Ws Text Block”  allows you convert 
any Text A function block to the IRMWsTextBlock function block that supports better 
graphics for application comments.

Fig. 283 Replace Text A Block and Ws Text Blocks with Irm Ws Text Block

The IRM engineering tools supports Niagara's WsTextBlock with the object named 
IRMWsTextBlock.

Fig. 284 IrmWsTextBlock Property sheet
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Table 29  Inputs of IRMWsTextBlock 

Input Name Description

Text Enter the text for the label.

Foreground Allows to set foreground color. Null indicates no foreground fill.

Background Allows to set background color. Null indicates no background fill.

Font Allows to change font style.

Border Allows to enable the border for the label.

Selectable
When set to true, the label on the wire sheet view can be selected.

When set to false, the label cannot be selected on the wire sheet view.

Master Sync 
Enabled

When set to true, all properties sync from master to target.

When set to false, all properties from the master to the target will not 
sync.
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Master Sync
The Master Sync function is based on a large number of devices, all of which must be 
running the same application. This is referred to as a master sync group. The master sync 
group is created by copying the application of a single device (template) to multiple devices 
using the Clone Application feature.

One device designated as source, while the others serve as targets. The master sync 
command then allows the master device's current application (changes) to be rolled out to 
all target devices in a single step.

The changes are only made in the project on the target devices regardless of the teaching 
mode set (On Demand or Immediate). They are not automatically loaded into the target 
controllers, meaning that a "Teach to Controller" or a "Teach Full Application to Controller" 
is necessary.

Fig. 285 Master Sync Group including Source and Target Devices

Note: Before selecting "Set as Source" or "Set as Target," the Irm Application Type for the Source and 
Target devices must be identical and unique over all other controllers. Please refer to the 
description of "Clone Application."

Important:  It is recommended to use “Clone application” or “Master Sync” instead of Template service. 
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Applying Master Sync
This function allows rolling out the source device's application (changes) to all target 
devices per one step. The differences in all target device applications are synchronized with 
the application of the source device.

At least one device must include an application to establish a master sync group via 
cloning. If you haven't previously, clone the application as explained in the Clone 
Application on page 210.

The following procedure shows an offline engineering example with four manually-created 
controllers using the standard workbench new command. 

Steps to apply master sync:

Step 1. Double-click on the Bacnet Network to display the devices from the database. 
The Irm Application Type column must show the same name for all the master 
and target devices receiving the same application. Otherwise, perform a Clone 
Application to get unique and identical names. All other devices should have a 
different IRM Application Type.

Fig. 286 Database Pane
Step 2. Select the device you want to define as the source, and then click Set as Source.
Step 3. Select the devices you want to define as the targets, and then click Set as Target.
Step 4. Select the source device, and then click Master Sync.

Fig. 287 Master Sync
The Synchronize differences dialog box displays.

Fig. 288 Synchronize differences dialog box
Step 5. Confirm the message by clicking Yes.

The differences in all the target device applications are synchronized with the 
project's source device application.

Step 6. Perform a "Teach to Controller" or a "Teach Full Application to Controller" to load 
the changes for all the target controllers.
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Clone Application
This function allows you to clone the device application to a specific device based on a 
template (device). As a result, all devices will be synced with the same application.

Note: The master sync group is not established even if all devices have the same application type 
after cloning. The cloning can be performed before or after using the Master Sync option (see 
Applying Master Sync on page 209).

For example, the following schematic shows a master sync group consisting of four devices 
with the same application. The application is cloned using device 1 as a template, and 
devices 2 through 4 are selected for receiving this application. They form a master group 
defined by application Type-A.

Fig. 289 Cloning Application

Steps to clone application:

Step 1. Select all devices to include in the clone in the Database window. One selected 
device's application will be utilized as a template. All others will be assigned the 
application type of the chosen template device.

Fig. 290 Datasheet pane
The following message box displays.

Fig. 291 Clone Irm Application Type Message Box
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Step 2. Confirm the message by clicking Yes.
The Select Template dialog box displays.

Fig. 292 Select Template dialog box
Step 3. Select the template (device) from the drop-down list box.
Step 4. Confirm the message by clicking OK.

The chosen template will be applied to all devices in the database pane. The Irm application 
type column indicates that all devices now have the same application type in the database 
pane. The master sync group is established.

Fig. 293 Irm Application Type column 
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Excluding Function Block Items from Master Sync
The function block items can be disabled in both the master and target devices. Function 
block items can be disabled for both periodic and event programs. 

In the Master Sync function, function block values can be omitted if required. When the 
master sync command is executed, the omitted values of the function block will be 
preserved and will not be affected by the upgraded application.

• When a function block value is disabled in the master device, it is retained in all target 
devices.

• When a function block value is disabled in a target device, just that target device is 
excluded from the value update

Fig. 294 Master Sync Enabled Configuration and Function Block Value Updates

Steps to disable function Block Items from Master Sync:

Step 1. Double-click the Const2Numeric function block.

Fig. 295 Const2Numeric property sheet
Step 2. Expand the Value A and Value B. 
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Step 3. Set Master Sync Enabled property to false.

Fig. 296 Const2Numeric property sheet
Step 4. Click Save.
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Split Application
You can split the unique application of the master sync group into a new application while 
retaining the current application. For the new application, you can give it a different 
program name. The software automatically creates a new application type. The new 
application can then be cloned to from the new master sync group.

This method may be used to add new features to an existing application for use in a similar 
context. For example, a small-sized office application can be used to create an application 
for a mid-sized workplace.

Fig. 297 Splitting-Off and Cloning Application
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Steps to split the application from the master sync group:

Step 1. In the database pane, select the device you want to split, and then click Split-Off 
Application.

Fig. 298 Database Pane
The following message box displays.

Fig. 299 Split-off Irm Application Type Message Box
Step 2. Click Yes to confirm.  The following dialog box displays.

Fig. 300 Name for program dialog box
Step 3. Enter a new name for the BACnet program.
Step 4. Confirm by clicking OK.
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The specified program name displays in the “IRM Program Name” column in the database 
pane, and the new application type is displayed in the IRM application type column. You 
may now create a new master sync group with the device based on this split-off application 
type by cloning the application and setting the source and targets.

Fig. 301 Irm Application Type column
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Batch Commissioning
Steps to perform batch commission:

Step 1. Create a station. 

Note: Keep the offline controllers in Swap Out mode.

Step 2. Commission all the controllers (by default, the online controllers added in the 
database will be in swap-in mode). 

Fig. 302 Swapped In controllers
Step 3. Navigate to the Irm Bacnet Device Manager view.
Step 4. Select the first lot of online controllers from the database section. Based on the 

available memory the number of controllers in each lot decided.
Step 5. Perform the Full Teach to the Controller or Teach to Controller operation on 

the swapped in controllers. Wait until the operation is completed.
Note:  It is recommended to perform the Full Teach to the Controller on new controllers. 

Note: In batch operation you can perform Full Teach to the Controller on maximum 10 controllers 
when the applications are in Swap In.

Fig. 303  Database view



IRM SYSTEM ENGINEERING GUIDE 218

Step 6. Click Swap Out.

Fig. 304 Swapping out
Recommendation for batch commission
Select the controllers based on the available memory. It is not recommended to load more 
than 50 % of the available memory space. If you load more than 50% of the memory space, 
the controllers, then perform the batch operation in slots.

Example: Select 10 devices or (determine the number of devices based on the load). 
Perform the batch teach to the controller, then Swap Out. Similarly, select the next 10 
devices and perform the same steps.
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Rename Bacnet Objects
The Rename Bacnet Objects feature is used to customize the BACnet points by adding 
prefixes and suffixes. Adding prefixes or suffixes will only update the BACnet point name 
stored in the controller, but not the BACnet point name displayed in the application.

Note: By default Rename Bacnet Objects feature is disabled.

Fig. 305 Rename Bacnet Objects Feature

Steps to rename Bacnet objects:

Step 1. Set Enabled option to true.

Step 2. In the Prefix Pattern field, enter the prefix name.
Step 3. In the Suffix Pattern field, enter the suffix name.

The prefix and suffix pattern are both in BFormat strings. To know more details 

on BFormat click on  icon seen in the Rename Bacnet Objects view below.

Step 4. Click Save.

Fig. 306 Rename Bacnet Objects 

You can verify the updated bacnet point name in Irm Bacnet Point Manager view.
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Step 5. Expand BacnetNetwork > Controller, right-click on Points > Views> Irm Bacnet 
Point Manager and select Offline discovery.

Fig. 307 Offline Point Discovery
Step 6. Click Discover.

Fig. 308 Renamed Bacnet Points
Step 7. Run Teach To Controller or Teach Full Application To Controller to apply the 

changes to the controller.
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Also, you can rename BACnet points for multiple controllers from the Irm Bacnet Device 
Manager view.

Steps to Rename BACnet points of multiple controllers:

Step 1. Right click on BacnetNetwork > Views > Irm Bacnet Device Manager.

Step 2. Select the controllers and click Rename Bacnet Objects.

Fig. 309 Rename BACnet points from Irm Bacnet Device Manager View

Note: The Rename Bacnet Objects feature displays default settings if you select multiple 
controllers. When you select a single controller, the Rename Bacnet Objects feature will 
display the settings that existed in the controller.

Step 3. Set Enabled option to True.
Step 4. In the Prefix Pattern field, enter the prefix name.
Step 5. In the Suffix Pattern field, enter the suffix name.

That prefix pattern and suffix pattern are both in BFormat strings. To know more 

details on BFormat click on  icon.

Step 6. Click Save.
Step 7. Run Teach To Controller or Teach Full Application To Controller to apply the 

changes to the controller.     



IRM SYSTEM ENGINEERING GUIDE 222

Bluetooth Configuration
Bluetooth configuration is provided to configure Bluetooth configuration for IP and MSTP 
controller. This feature allows you to perform operations like enabling or disabling the 
bluetooth function, setting Bluetooth password, Bluetooth enabling start and end time to 
enable mobile balancing applications to connect to the devices over Bluetooth.

Fig. 310 BLE Configuration

The Bluetooth configuration feature is supported by the following controllers.

When you add IrmBacnetDevice into Bacnet network, the Bluetooth setting option is 
hidden for non-Bluetooth enabled devices. 

Steps to select the Bluetooth supported controller:

Step 1. Navigate to the IRM Program > double-click Control Manger. This opens the 
Control manager property sheet.

Step 2. In Device Model Name, select the Bluetooth supported model from the drop-
down list.

• VA423B24N

• VA00IB24NM

• VA75IBWB24NM

• VA75IB24NS

• VA75IBWA24NS

• VA75MB24NM

• VA00MB24NM

• VA75MB24NS
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Fig. 311 Device Model Name
Step 3. Click Save.
Step 4. Right-click IrmBacnetDevice and select Refresh Tree Node. This activates the 

Bluetooth Configuration feature.

Enable Bluetooth Settings
Steps to enable Bluetooth Configuration:

Step 1. Navigate to the BacnetNetwork > IrmBacnetDevice > double-click on Blue-
tooth Configuration. 

Step 2. Set Bluetooth Status to Enabled.

Fig. 312 Bluetooth Status
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Setting Bluetooth devices Passcode
The Bluetooth configuration allows you to set a passcode for the connected Bluetooth 
devices, which helps you to authenticate the correct device. The passcode is an eight-digit 
number. The default passcode is 00000000. You can set your passcode or generate a 
random passcode. Also, you can set the validity of the passcode.

Steps to set Bluetooth device passcode:

Step 1. Right-click BLE Configuration > Actions > Generate Passcode.

Fig. 313 To generate passcode

Steps to set Bluetooth device passcode validity:

Step 1. Navigate to the BLE Configuration, double-click Bluetooth Configuration to 
open the property sheet.

Step 2. Under Bluetooth Passcode Validity, select the Start Date and End Date.

Fig. 314 Bluetooth Passcode Validity

Note: The Bluetooth passcode End Date cannot be more than 90 days than the Start Date.

Step 3. Click Save.

Read and Write BLE Setting
Write BLE Configuration to Device

This feature sends all the Bluetooth configuration modifications from engineering tool to 
the controller.

Steps to perform Write BLE Configuration to Device:

Step 1. Right-click on BLE Configuration, select Action, and Write BLE Configuration 
to Device.

Fig. 315 Write BLE Configuration to Device
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Read BLE Configuration from Device

If the user wants to read the Bluetooth configuration from the device, use read BLE 
configuration from device.

Steps to perform Read BLE Configuration from Device:

Step 1. Right-click on BLE Configuration, select Action, and click Read BLE Configu-
ration from Device.

Fig. 316 Read BLE Configuration from Device

Configuring Bluetooth for Multiple Devices
The engineering tool allows the user to perform Bluetooth configurations on multiple 
controllers in a batch process. 

Steps to perform Bluetooth configuration on multiple controllers:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view. 

Step 2. Select all the IP or MSTP devices from the device list.

Note: The BLE Config option will be inactive if any unsupported device is selected from the device 
list.

Step 3. Click on BLE Config and set Generate New Passcode to True or False.

Fig. 317 BLE Configuration
Step 4. Set Bluetooth Status to Enabled. This enables Bluetooth features for all the 

selected IP or MSTP devices.
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.

Fig. 318 Bluetooth Status
Step 5.  Set Bluetooth Passcode and Bluetooth Passcode Validity.

Fig. 319 Bluetooth Passcode Validity
Step 6. Click Save.
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Onboard IO Migration 
Onboard IO migration allows the user to migrate the pre-configured terminals from a 
selected source model to the target model. The Onboard IO migration is possible with the 
terminals having the same characteristics. Onboard IO Migration is a feature that the tool 
performs in the background when the user changes the model. The user explicitly cannot 
perform this action.

Note: When the user changes the device model in control manager, the engineering tool 
automatically reconfigures the IO configuration to best suit the target model.

Fig. 320 Onboard IO migration

As part of IO Migration, the tool first finds the same IO terminal type. If the target model 
does not support the same terminal type as the source or there are no free terminal on 
target with the same pin type, the tool tries to find its supertype. For example, a BI in the 
source is converted to a type in the order BI, UI, or UIO.

Steps to perform the Onboard IO migration:

Step 1. Open the Onboard IO wire sheet for a preconfigured device model (source 
model).

For example: Open the On board IO wire sheet for the IRM NX controller model 
VA75124NM that has three SSR terminals and two UIO terminals.
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Fig. 321 Onboard IO wire sheet
Step 2. Open the Control Manager, select the Device Model Name, and select the 

target model from the drop-down list.
Step 3. Click Save. 

For example, select RL4N as your target model.

Fig. 322 Control Manager
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This action migrates the UIO or BO terminal with the same In-Type characteristics from the 
source model to the target model.

Fig. 323 Onboard IO wire sheet

Note: Review the IO conversions that the engineering tool performed during device model 
migration.

On Board IO Migration Examples

Migrating a BO terminal in VA75I24NM to RL4N model:

Scenario 1: Target has BO terminal available:

To assign BO and UIO terminals of the IRM NX controller (VA75I24NM) to the BO and UIO 
terminals of the RL4N controller, both the source and the target model terminals must have 
the same In-type characteristics. The below figure shows the migration of SSR_1 (Bo 
terminal) of VA75I24NM model to SSR_1 (Bo terminal) RL4N model, which have the same 
Binary direct characteristics for both the terminals.

Fig. 324 Onboard IO migration for same characteristics

Scenario 2: Target has BO terminal unavailable, So tool migrates the BO to a UIO with inType 
as BinaryOutput.
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Example: The source model has the BO terminals, and the target model doesn’t. In this case 
of migration, the source model configures with the next model, which has the same In-type 
characteristics. The below figure shows the migration of the UIO_2 (Bo terminal) to the 
SSR_2 (Uio Terminal) having the same In-type characteristics as BinaryOutput.

Fig. 325 Assign the terminals between different physical points

Migrating terminals between different physical blocks with different In-type characteristics 
is not recommended if you try to migrate the target model set to unassigned.
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Tuning Policies
The tuning policies configure rules for evaluating both write requests, for example, 
requests to write to proxy points and the acceptable freshness of reading requests 
resulting from polling. Tuning policies are important because they can affect the status of 
the driver’s proxy points.

Tuning policies include standard tuning policy properties and additional properties related 
to client-side usage of the BACnet Subscribe Change Of Value (COV) service.

Note: The IRM NX controllers support 20 points for COV. Since there is a limitation in the 
CentraLine-N4 framework on the COV feature, it is recommended to configure only 20 points 
and the rest of the points for polling.

The IRM NX controllers have a default tuning policy that enables the COV feature. 
Whenever you perform a BACnet Network discovery, the IRM NX controller automatically 
creates the IrmTuningPolicy.

Important: You can assign the policy points to poll the important points more frequently than less 
important points based on the importance level. This configuration helps to optimize the 
bandwidth.

Default IrmTuning Policy

The IRM controllers have a default tuning policy that enables the COV feature. Whenever 
you perform a BACnet Network discovery, the IRM controller automatically creates the 
IrmTuningPolicy.

To access default IrmTuningPolicy:

Step 1. Expand BacnetNetwork > Tuning Policies or double-click IrmTuningPolicy.

Fig. 326 IrmTuning Policy
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Assign Policy
Steps to assign a policy is a follows:

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice > double-click on Points.

Fig. 327 Points Directory
Step 2. Click New, select the point type from the drop-down and then click OK.

Fig. 328 Adding New Point
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Step 3. Configure the point and assign the tuning policy from the tuning policy name 
drop-down.

Fig. 329 Tuning Policy Name
Step 4. Click OK. This action adds a point to the database.

To access these properties is expand BacnetNetwork > Tuning Policies or double-click 
Default Policy. 

Fig. 330 Bacnet Tuning Policy Property Sheet
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Table 30   Tuning Policy Property Sheet Description

Property Value Description

Min Write Time
hours, minutes,
seconds
(defaults is zero)

Specifies the minimum amount of time allowed between writes to 
writeable points. This causes the system to write only the last 
value during this minimum time period, which serves to throttle 
rapidly changing values, improving system performance. A value 
of 0 disables this feature causing the system to attempt to write all 
values.

Max Write Time
hours, minutes,
seconds
(defaults is zero)

Specifies the maximum amount of time to wait before rewriting 
the same value to a writable point if nothing else triggers a write. 
Any write action resets this timer.
A value of 0 disables this feature resulting in no timed rewrites.

Write On Start
true 
false (default)

Determines writable proxy point behavior when a station starts.
Note: For critical proxy points false is recommended.

Otherwise, large networks may experience write-queue 
overflow exceptions.

Write On Up
true 
false (default)

Determines writable proxy point and parent device behavior .
• If true, a write occurs when the parent device transitions from 

down to up.
• If false, no write occurs.

Write On 
Enabled

true 
false (default)

Determines writable proxy point behavior.
• If true, a write occurs when the point transitions from disabled 

to enabled.
• If false, no write occurs.

Stale Time
hours, minutes,
seconds
(defaults is zero)

Defines the amount of time after which the data for a point in the 
station is considered too old to be meaningful {stale}.
• A non-zero value causes the point to become stale. The status 

will show as {stale}. If the configured time elapses  without a 
successful read, read status {ok} is indicated. 

• The default value of 0 disables the stale timer. Points become 
stale immediately when unsubscribed.

• Do not set a timer that is shorter than the poll cycle time. In the 
normal course polling, points will become stale.  Instead, set 
this time longer than the largest poll cycle expected.

Poll Frequency
Fast
Normal
Slow (default)

Provides a method to associate the tuning policy with one of 3 poll 
rates available in the network’s poll service: fast, normal, or slow 
rate. Applies to all proxy points.

Use Cov true
false (default)

• If set to true, the driver attempts (proxy subscriptions) using 
BACnet Cov subscriptions to the device. If the subscription 
attempt succeeds, the read status property of the point’s 
BACnet proxy extension displays the Cov. If the subscription 
attempt failed, the driver uses normal polling and the read 
status property shows polled.

• If set to false, the driver ignores all the proxy subscriptions.
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Use Confirmed 
Cov

true (default)
false 

• If set to true, the driver attempts for proxy subscriptions using 
BACnet confirmed Cov subscriptions to the device.

• If disabled, the driver ignores this property.

Cov 
Subscription
Lifetime

time in minutes
(default is 15 min)

Indicates the lifetime, in minutes, for which the database 
subscribes for Cov notifications, then periodically subscribes 
again. A value of zero means an indefinite lifetime, although this is 
not guaranteed to persist across resets of the server device.

Use Cov 
Property

true 
false (default)

If Use Cov Property set to true, and assigned proxy points are 
under a BacnetDevice that supports the Subscribe COV service, 
any necessary updates ( proxy subscriptions) are attempted using 
BACnet COV subscriptions to the device.

• If the subscription attempt succeeds, the “Read Status” 
property of the point’s BacnetProxyExt displays “COV”. 

• If the subscription attempt for a proxy point fails, normal 
polling is used and the “Read Status” property shows “Polled”.

Use Confirmed 
Cov Property

true (default)
false 

• If Use Confirmed Cov Property is set to true and assigned proxy 
points are under a BacnetDevice that supports Confirmed COV 
notifications, any necessary updates (proxy subscriptions) are 
attempted using BACnet Confirmed COV subscriptions to the 
device. 

• If Use Confirmed Cov Property set to false, it makes no 
difference what this property value is.

Cov Property 
Increment

number to two 
decimal places
(default is 1.00)

Defines an increment for a COV property to apply to the sending 
of COV notifications. This property applies to numeric COV values 
only.

Cov Property 
Subscription 
Lifetime

15 min (default)

Configures the lifetime, in minutes, for which the software 
subscribes to the COV property for COV notifications.
A value of 0 means an indefinite lifetime, although this is not 
guaranteed to persist across resets of the server device. 

Accept 
Unsolicited Cov

true
false (default)

Allows (true) or prohibits (false) Cov notifications to update a 
point that is being polled.
False prevents the unsolicited updates.

Table 30   Tuning Policy Property Sheet Description (Continued)

Property Value Description
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Alarms
Each BACnet Device has an Alarms device extension. This extension applies to BACnet 
event notifications (alarms) sent to the station by that device.

Fig. 331 Types of Alarms 

Steps to perform the alarm configuration and to use the notification class objects in 
BACnet points:
Step 1. Navigate to the BacnetNetwork >IrmBacnetDevice> double-click Config.

Step 2. Click Discover and select all the discovered notification classes 1,2,3 & 4.

Fig. 332  Discovered Notification Classes
Step 3. Click OK to add the notification to the database.

Fig. 333 Adding Alarm
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You can change the properties of any notification class listed in the database.

Fig. 334 Discover and Database pane
Step 4. Right-click on any of the notifications by going to Views > property sheet.

Fig. 335 Property sheet
Step 5. Right-click on Recipient List > Action > select add Elements.

Fig. 336 Add Elements
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Step 6. Select the Recipient option, configure the device ID and click OK.

Fig. 337 Add device ID

This action will configure the device Id for the alarm notification.

Fig. 338 Property sheet

BACnet alarms support the data types BacnetInput, BacnetOutput, Binaryinput, and 
Binaryoutput.

BACnet alarms do not support the enumoutput, numericvalue, booleanvalue, enumvalue, 
refin, and refout data types.

Alarm Synchronization Check
Modifications such as adding, deleting, copying, and pasting items on the alarms wire 
sheet are not allowed. You can only change the properties of the pre-defined notification 
class objects on the property sheet after double-clicking the notification class icon.

Fig. 339 Bacnet Notification Class
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SYLK DEVICE PROGRAMMING

Sylk Devices
The Sylk devices are part of the IRM family. These devices are designed to seamlessly inte-
grate with IRM NX controllers using the Sylk bus for communication. These devices 
increase the controller's ability to expand the operation, which is configured with applica-
tions that require a large amount of physical I/O. The Sylk devices are used in HVAC appli-
cations that require a programmable controller. All the devices provide flexible, universal 
inputs for external sensors.

The Sylk devices are programmable using IRM engineering tool wire sheets through the 
CentraLine-N4 workbench.

The “honIrmControl” palette supports the following Sylk devices listed below.

Fig. 340  Sylk Devices
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Note: While clearing the controller and loading the Sylk configuration to the controller (Proxy file to 
the controller), 20 VDC output will turn off for 30 seconds. All I/O terminals will be down for 
30 seconds. It will only happen when CentraLine-N4 changes the Sylk application or deletes 
the application from the controller. It will not happen once the application teach completes 
and the controller is running.

Following is the list of supported Sylk devices:

Table 31  Sylk Devices

Module-TR7x

TR75H TR75

TR71H TR71

Module-TR4x

TR42 TR42H

TR42CO2 TR42HCO2

TR40 TR40H

TR40CO2 TR40HCO2

Module-TR120x

TR120 TR120H

Sensor

Sylk sensor C7400S Sylk Sensor (Zeleny)

Sylk Actuator

Sylk Actuator

MS3103, MS3105, MS4103, MS4105, MS7403, MS7405, 
MS7503, MS7505, MS8103, MS8105 spring return.
Direct Coupled Actuators (DCA) are used within Heating, 
Ventilating, and Air-Conditioning (HVAC) systems. 
They can drive a variety of quarter-turn; final control 
elements requiring spring return fail-safe operation.
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Sylk Parameters
The “honIrmControl” palette supports following the Sylk parameters listed below.

Fig. 341    Sylk Parameters

Table 32  Sylk Parameters

Parameter Description

BypassTime To provide the bypass time to a wall module.

CO2 CO2 concentration in the space.

ControllerValue Sylk device value sent to the controller and they are reflected in the wall 
module.

FanCommand To provide commands to the fan from the wall module.

HUMIDITY Percent humidity of the space.

HomeScreen To configure the LED display of the wall module.

NetworkSetpoint To provide the setpoints to a wall module.

OccupancyOverrideCommand To override the unoccupancy mode to occupied mode.

OccupancyStatus Occupancy status in the wall module.

ROOMTEMP Temperature of the space.

SensorOffset To provide the sensor offset to a wall module.

SylkTime To configure and change the value of the Sylk module and platform time.

SystemCommand To override the system command from the wall module.
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For more information regarding Sylk parameters, refer to the IRM Function Blocks User 
Guide - EN2B-0415-GE51.

Sylk Parameters Supported by the Sylk Devices
This section describes the Sylk parameters that are supported by Sylk devices.

Sylk Parameters Supported by TR120x 

SystemStatus System status in the wall module.

TimeField To configure the time format of the wall module.

TimeOfDay Time of the day to display on the Sylk device.

ValueFromWallModule To provide the value from the wall module to the controller.

Table 32  Sylk Parameters (Continued)

Parameter Description

Table 33  TR120x

Parameter
TR120x SBus wall modules

TR120 TR120H

ROOMTEMP Y Y

HUMIDITY N Y

OccupancyOverrideCommand Y Y

ValueFromWallModule Y Y

TimeOfDay Y Y

SystemStatus Y Y

OccupancyStatus Y Y

ValueFromController Y Y

SystemCommand Y Y

TimeField Y Y

BypassTime Y Y

SensorOffset Y Y

HomeScreen Y Y

NetworkSetpoint Y Y

SylkTime Y Y

FanCommand Y Y

EnumSchedule Y Y
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Sylk Parameters Supported by TR7x

Sylk Parameters Supported by TR40x

Table 34  TR7x

Parameter
TR7x SBus wall modules

TR75H TR75 TR71H TR71

ROOMTEMP Y Y Y Y

HUMIDITY Y N Y N

OccupancyOverrideCommand Y Y Y Y

ValueFromWallModule Y Y Y Y

TimeOfDay Y Y Y Y

SystemStatus Y Y Y Y

OccupancyStatus Y Y Y Y

ValueFromController Y Y Y Y

SystemCommand Y Y Y Y

TimeField Y Y Y Y

BypassTime Y Y Y Y

SensorOffset Y Y Y Y

HomeScreen Y Y Y Y

NetworkSetpoint Y Y Y Y

SylkTime Y Y Y Y

FanCommand Y Y Y Y

EnumSchedule Y Y N N

Table 35  TR40x

Parameter
TR40x SBus wall modules

TR40 TR40H TR40CO2 TR40HCO2 

ROOMTEMP Y Y Y Y

HUMIDITY N Y N Y

CO2 N N Y Y
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Sylk Parameters Supported by TR42x 

Sylk Parameters Supported by C7400S 

Table 36  TR42x

Parameter
TR42x SBus wall modules

TR42 TR42H TR42CO2 TR42HCO2

ROOMTEMP Y Y Y Y

HUMIDITY N Y N Y

CO2 N N Y Y

OccupancyOverrideCommand Y Y Y Y

OccupancyStatus Y Y Y Y

BypassTime Y Y Y Y

NetworkSetpoint Y Y Y Y

FanCommand Y Y Y Y

Table 37  C7400S (Zeleny)

Parameter (Zeleny)

ROOMTEMP Y

HUMIDITY Y



IRM SYSTEM ENGINEERING GUIDE 245

Steps to Configure Sylk Application
Steps to configure and install the Sylk application in Sylk devices:

Step 1. Add Sylk Device: Add Sylk device to the periodic program or event program 
wiresheet view.

Step 2. Add and Map Sylk Parameters in Sylk Device: Map the required Sylk parameters 
with a Sylk device.

Step 3. Configure Sylk Parameters: Configure the Sylk parameters as required.
Step 4. Configure Sylk Device: Configure the Sylk device as required. 
Step 5. Validate Sylk Device: Verify all the Sylk device configurations in the wiresheet 

view.
Step 6. Teach to Controller: Install the Sylk device application file in the Sylk device 

models like TR120, TR75, etc.

Add Sylk Device
Steps to add Sylk device:

Step 1. Navigate to the Station > Config > Drivers > BacnetNetwork >  
IrmBacnetDevice > Irm Program and open the Wiresheet view of the          
Periodic program.

Step 2. Navigate to the Palette section select honlrmControl > SylkDevices.

Fig. 342  honIrmControl Palette

Step 3. Select the Sylk device from the SylkDevices list and drag-drop it in the wiresheet 
view of the Periodic program.
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You can add multiple Sylk devices by holding down Ctrl and right-clicking on 
them in the palette, then dragging them into the wiresheet view of Periodic 
Programs.

Fig. 343  Wiresheet View Of Periodic Program

To view the property sheet for the Sylk device, double-click on it. You can check 
the power consumption and customize the Sylk device on the property sheet. 
You may also see if the Is configuration downloaded status is true or false.

Fig. 344  Total Sylk Power Consumption Data 
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Add and Map Sylk Parameters in Sylk Device
Once you have copied the Sylk device under the periodic program or event program, you 
can configure the parameters of the Sylk devices. Refer to the Sylk Parameters on page 241 
section for more details on supported Sylk parameters for all the Sylk devices.

Steps to map Sylk Parameters with Sylk Device:

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork >  IrmBacnetDevice > 
Irm Program and open the Wiresheet view of Periodic program.

Step 2. Navigate to the honlrmControl palette, expand Sylk folder and select 
SylkParms.

Step 3. Drag the Sylk parameters and drop onto the wiresheet.
Step 4. Once all the required parameters added in the wiresheet view, map all of the 

parameters with the Sylk device.
Step 5. Double-click on the Sylk parameters object. This action opens the property 

sheet. 
Step 6. Select the Sylk device from the sylkdevice drop-down list.

Fig. 345  List of supported Sylk devices

Also, you can create a specific group of Sylk parameters and map them with the required 
Sylk device using Irmfolder.

Steps to create a specific group of parameters: 

Step 1. Navigate to the honlrmControl palette, add the IrmFolder in the wiresheet 
view. 

Step 2. Double-click on the IrmFolder. This opens IrmFolder wiresheet view.
Step 3. Similarly, add the Sylk device and parameters from the palette to the IrmFolder 

wiresheet.
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Fig. 346  Wiresheet View

Step 4. In the Wiresheet view, right-click the Sylk Device > Actions > select Attach 
unassigned Params. All the unassigned parameters of the Sylk device are 
assigned.

Fig. 347   Attach Unassigned Parameters

Similarly, you can also create several folders and configure them with Sylk devices. The  
folders can be reused by copying and pasting them into the wiresheet view.
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Configure Sylk Parameters
Configure the required Sylk parameters after mapping the Sylk device with the Sylk param-
eters.Sylk Parameters are divided into three categories:
• Sylk In Parameters: These parameters act as input to the Sylk devices. For more details, 

refer to the Configure Sylk In Parameters on page 250.
• Sylk Out Parameters: These parameters capture input from various sensors and act as 

output for the Sylk device. For more details, refer to the Configure Sylk Out Parameters 
on page 255.

• Sylk In Out Parameters: These parameters are used as input as well as output for the 
Sylk device. For more details, refer to the Configure Sylk In Out Parameters on page 268.

Sylk In Parameters
Sylk In parameters are used as inputs to the Sylk devices.

Sylk Out Parameters
Sylk Out parameters capture input from various sensors and act as output for the Sylk 
devices.

Sylk In Out Parameters

Sylk In Out parameters are used as input and output for the Sylk device.

Table 38  Sylk In Parameters

Properties Description

ControllerValue Value from the controller to the wall module. 

OccupancyStatus Occupancy status in the wall module.

SystemStatus System status in the wall module.

TimeOfDay Displays Time of the day on Sylk device.

Table 39  Sylk Out Parameters

Properties Description

CO2 CO2 concentration in the space.

HUMIDITY Percent humidity of the space.

OccupancyOverrideCommand Allows you to override the occupied, unoccupied, 
standby mode for wall module.

ROOMTEMP Temperature of the space.

SensorOffset Provides the sensor offset to the wall module.

ValueFromWallModule Provides the Sylk device value from the wall module 
to the controller.

Table 40  Sylk In Out Parameters

Properties Description

BypassTime Provide the bypass time to a wall module.

FanCommand Provide commands to the fan from the wall module. 

NetworkSetpoint Provide the setpoints to the wall module. 

SystemCommand Override the system command from the wall module.

TimeField Configure the time format of the wall module.
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Configure Sylk In Parameters
• Controller Value Parameter Configuration: The Controller Value parameter displays 

the value from the controller to the wall module.

• Occupancy Status Parameter Configuration: The Occupancy Status parameter 
displays occupancy status in the wall module.

• System Status Parameter Configuration: The System Status parameter displays the 
system status in the wall module.

• Time Of Day Parameter Configuration: The Time of Day parameter sets the time 
format for the wall module.

For more detail about Sylk In Parameters type, refer to IRM Function Blocks User Guide - 
EN2B-0415-GE51.

Controller Value Parameter Configuration

Fig. 348  Controller Value Property Sheet

Steps to configure Controller Value parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. category: Enter the category name in the field. It helps to differentiate between 
parameters.
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Step 3. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig. 349  Parameter Permissions

Step 4. enableFD: The period until the configured Sylk device is alerted of a failure at 
this point is defined as fail detect.
• YES: If the parameter has not received an update from the BACnet network 

source in the fail detect time, an alarm is generated, and the current value is 
set to invalid.

• No: False means the object retains the last value written to it until a BACnet 
network source changes.

Note:  Fail detect time depends on the configured update rate. 

Step 5. enumerated: This field allows user to enable multiple states of the enum 
setpoint. 

Step 6. enumDefinition: If the enumerated field is “Yes,” the user can set multiple states 
of the enum setpoints.
To set the enumDefinition of the Setpoint: 

i). Click on the >> button.

Fig. 350  Enum Setpoint

ii). Set the enum definitions Ordinal, Tag, and Display as per your requirement. 

Fig. 351   Enum definitions

iii). Click OK to save. 
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Note: TR 71 and TR 75 are the enumerated options for the Sylk module type. To enable the 
enumerated option, set the parameter type to controller value, wall module value, or network 
setpoint.

Step 7. defaultEnumValue : This option displays the list of default enum values from 
the defined enum range.

Step 8. selectLabelsToShowOnScreen: This option allows the user to configure the 
Sylk device labels to the display in the Sylk wall module.

Fig. 352  Sylk Select Labels

Occupancy Status Parameter Configuration

Fig. 353  Occupancy status Property Sheet

Steps to configure Occupancy Status parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. tR7XConfig: This field allows you to choose how the override status should be 
presented on the LCD. 
• Show effective occupancy status: LCD displays the actual occupancy 

status considering the IRM application. 
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• Show the occupancy override status: LCD displays the occupancy override 
status initiated from the LCD, independent of the IRM application. 

• Do not show occupancy or override status: LCD does not display 
occupancy or override, regardless of what the user initiates and the IRM 
application. 

System Status Parameter Configuration

Fig. 354  System Status Property Sheet

Steps to configure System Status parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. systemStatusValues: This option allows configuring the system values as per 
requirement in the defined range.

Fig. 355  System Status Values
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Time Of Day Parameter Configuration

Fig. 356  Time Of Day Property Sheet

Steps to configure Time Of Day parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. category: Enter the category name in the field. It helps to differentiate between 
parameters.

Step 3. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig. 357  paramPermissions

Step 4. selectLabelsToShowOnScreen: This option allows you to customize the display 
of the Sylk device label for Sylk parameters.

Fig. 358  Configure Sylk Device Label Display

For more detail about Sylk In Parameters type, refer IRM Function Blocks User Guide - 
EN2B-0415-GE51.
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Configure Sylk Out Parameters
The following are the parameters that capture input from various sensors and act as output 
for the Sylk device:

• Humidity Parameter Configuration: The Humidity parameter shows the percentage 
of humidity in the room.

• CO2 Parameter Configuration: The CO2 parameter specifies the level of CO2 
concentration in the room.

• Occupancy Override Command Parameter Configuration: The Occupancy Override 
Command parameter allows to switch between Unoccupancy Mode to Occupied 
Mode.

• Room Temperature Configuration: The ROOMTEMP parameter displays the room 
temperature.

• Sensor Offset Parameter Configuration: The Sensor offset parameter provides the 
sensor offset to the wall module.

• Value From Wall Module Parameter Configuration: The Value From Wall Module 
parameter provides the value from the wall module to the controller.

For more detail about Sylk In Parameters type, refer IRM Function Blocks User Guide - 
EN2B-0415-GE51.

Humidity Parameter Configuration

Fig. 359  Humidity Property Sheet

Steps to Configure Humidity parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. categories: Enter the category name in the field. This helps to differentiate 
between the parameters.
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Step 3. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig. 360  Parameter Permissions

Step 4. tR7XConfig: This option allows configuring additional parameters.

Fig. 361  T R7X Humidity Param Additional Config 
• Number of Decimals: Enter the decimal accuracy.

• Default Sensor Offset Value: Enter the default value for sensor offset.

• Select Labels To Show On Screen: This option allows you to customize the 
display of the Sylk device label for Sylk parameters.

Step 5. tR4XConfig: This option allows configuring additional parameters.

Fig. 362  T R4X Humidity Param Additional Config
• Number of Decimals: Enter the decimal accuracy.

• Default Sensor Offset Value: Enter the default value for sensor offset.

CO2 Parameter Configuration

Fig. 363  CO2 Property Sheet
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Steps to configure CO2 parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. categories: Enter the category name in the field. It helps to differentiate between 
parameters.

Step 3. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig. 364  Change Parameter Permissions

Occupancy Override Command Parameter Configuration

Fig. 365  Occupancy Override Command Property Sheet

Steps to configure Occupancy Override Command parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. tR7XConfig: This option allows configuring occupancy override additional 
settings.

Fig. 366   T R7X Occupancy Override Additional settings
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Override To Occupied Settings

Fig. 367   Override to Occupied Settings

• Override Type 

• Continuous Override: The default setting, this setting disables the time 
override type options.

• Time Override in Hours (Bypass): This option enables the time setting 
details. The minimum and maximum time can be set in hours and minutes. 
The default setting is min = max = 3 hours. Ensure that the maximum time is 
greater than the minimum time or that the minimum time is lesser than the 
maximum time. If either case is not true, an error message appears 
informing that the min value is greater than the max value. The range is from 
0 to 24 hrs / 0 to 59 min. 

• Time Override in Days (Bypass): This option enables the time setting 
details, wherein the minimum and maximum time can be set in days. In this 
case, the hours and minutes options are disabled. The default setting is min 
= max = 1 day. The permissible range is 1 to 99 days.

Fig. 368  Override Type

If the range exceeds, an error message displays. 
• Use Network Bypass Time Only: If this option is selected, then all other override 

details are disabled. The application will determine the timed override. 

Note:  The Use Network Bypass Time only option applies to occupied override type settings. This 
option is not available for unoccupied and standby override type settings. 

• Override Setting

Fig. 369   Override Settings
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Override To Unoccupied Settings

Fig. 370   Override to Unoccupied

• Override Type 
• Continuous Override: The default setting, this setting disables the time 

override type options.

• Time Override in Hours (Bypass): This option enables the time setting 
details. The minimum time and maximum time can be set in hours and 
minutes. The default setting is min = max = 3 hours.Ensure that the 
maximum time is greater than the minimum time or that the minimum time 
is lesser than the maximum time. If either case is not true, an error message 
appears informing that the min value is greater than the max value. The 
range is from 0 to 24 hrs / 0 to 59 min. 

• Time Override in Days (Bypass): This option enables the time setting 
details, wherein the minimum and maximum time can be set in days. In this 
case, the hours and minutes options are disabled. The default setting is min 
= max = 1 day. The permissible range is 1 to 99 days.

Fig. 371  Override Type

• Override Settings

Fig. 372   Override Settings
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Override To Standby Settings

Fig. 373   Override To Standby

• Override Type 
• Continuous Override: The default setting, this setting disables the time 

override type options.

• Time Override in Hours (Bypass): This option enables the time setting 
details. The minimum and maximum time can be set in hours and minutes. 
The default setting is min= max= 3 hours. Ensure that the maximum time is 
greater than the minimum time or that the minimum time is lesser than the 
maximum time. If either case is not true, an error message appears 
informing that the min value is greater than the max value. The range is from 
0 to 24 hrs / 0 to 59 min. 

• Time Override in Days (Bypass): This option enables the time setting 
details, wherein the minimum and maximum time can be set in days. In this 
case, the hours and minutes options are disabled. The default setting is min 
= max = 1 day. The permissible range is 1 to 99 days.

Fig. 374  Override Type
• Override Settings 

Fig. 375   Override Settings
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Occupancy Values

Provides options to define the different values within the mentioned ranges.

Fig. 376  Occupancy Values
• Show effective occupancy status: LCD displays the actual occupancy 

status considering the IRM application. 

• Show occupancy override status: LCD displays the occupancy override 
status initiated from the LCD, independent of the IRM application. 

• Do not show occupancy or override status: LCD does not display 
occupancy or override, regardless of what the user initiates and IRM 
application.

Step 3. tR4XConfig: This option allows configuring additional parameters.

Fig. 377  tR4XConfig Additional Parameter Options

Room Temperature Configuration

Fig. 378  RoomTemp Property Sheet
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Steps to configure Room Temperature parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. categories: Enter the category name in the field. It helps to differentiate between 
parameters.

Step 3. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig. 379  Parameter Permissions

Step 4. TemperatureUnit: This option allows to select temperature unit (°F or °C).
Step 5. tR7XConfig: This option allows you configure additional parameters.

Fig. 380  tR7XConfig Additional Parameter Options
• Number of Decimals: Enter the decimal accuracy.

• Default Sensor Offset Value: Enter the default value for sensor offset.

• Select Labels To Show On Screen: This option allows you to customize the 
display of the Sylk device label for Sylk parameters.

Step 6. tR4XConfig: This option allows you configure additional parameters.

Fig. 381  tR4XConfig Additional Parameter Options
• Number of Decimals: Enter the decimal accuracy.

• Default Sensor Offset Value: Enter the default value for sensor offset.
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Sensor Offset Parameter Configuration

Fig. 382  SensorOffset Property Sheet

Steps to configure Sensor Offset parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. categories: Enter the category name in the field. It helps to differentiate between 
parameters.

Step 3. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig. 383  Parameter Permissions

Step 4. selectSensor: Select sensor displays the list of sensors that needs to be 
configured and offset. All available sensors are listed, but the selection is based 
on the selected model. The default selection is Temperature. This field is 
displayed only for a parameter of the category offset.

Fig. 384  Select Sensors

Following are the sensor selection available:
• Temperature 

• Humidity 

• CO2 



IRM SYSTEM ENGINEERING GUIDE 264

Note: If the value of the parameter types temperature, humidity, and CO2 from the wall module is 
edited and saved, the default sensor offset value of the corresponding sensor is also changed 
to the edited value.

Step 5. incrementDecrement: Depends on the number of decimal places selected.
• If the number of decimal places is 0, then select 1, 5, 10, 100.

• If the number of decimal places is 1, then select 0.1, 0.5, 1, 5, 10, 100. 

• If number of decimal places is 2, then select 0.01, 0.1, 0.5, 1, 5, 10, 100.

Note: For the TR71x and TR75x wall modules, increments of 5 and 0.5 are available for the value 
from the wall module, network setpoint, and sensor offset value (Internal) parameters.

Step 6. defaultValue: Indicates the value that initially downloads to the wall module. 
This value must be between the low and high limits. This field displays for the 
following parameter types: 
• Value from the wall module. 

• Sensor offset value. By default, it is set to 0.

Note: The default value has a limit of 5 characters.

Step 7. limitConfig: This option is to set the high & low limits of the parameter. 

Fig. 385   Set high and Low Limits of Sylk Parameters
• Low Limit From Sylk Param: To select the low limit value from the other Sylk 

parameter of respective system device. 

• High Limit From Sylk Param: To select the high limit value from the other 
Sylk parameter of respective system device.

• Low Limit: To set the low limit.

• High Limit: To set the high limit.

Step 8. numberOfDecimals: Apply to all parameter types except Time. This value affects 
the incrementDecrement options.

Step 9. selectLabelsToShowOnScreen: This option allows to configure the Sylk device 
label display for the Sylk parameter.
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Value From Wall Module Parameter Configuration

Fig. 386  ValveFromWallModule Property Sheet

Steps to configure Value From Wall Module parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. categories: Enter the category name in the field. It helps to differentiate between 
parameters.

Step 3. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig. 387  Change Parameter Permissions

Step 4. allowNullValue: Indicate whether null values can be set for the adjustable value. 
If enabled, when the LCD user reaches a low or high limit, an additional button 
press will send the null value.

Step 5. enumerated: This field allows user to enable multiple states of the enum 
setpoint. 

Step 6. enumDefinition: If the enumerated is “Yes,” the user can set multiple states of 
the enum setpoint.
To set the enumDefinition of the Setpoint: 
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i). Click on the >> button.

Fig. 388  Enum Setpoint

ii). Set the states Ordinal, Tag, and Display as per requirement. 

Fig. 389  Enum States

iii). Click OK to save. 

Note: The enumerated option applicable to the Sylk module type is TR 71 and TR 75. Select the 
parameter type as controller value, a value from wall module, or network setpoint to enable the 
enumerated option.

Step 7. defaultEnumValue: This option displays the list of default enum value from the 
defined enum range.

Step 8. numberOfDecimals: Apply to all parameter types except Time. This value affects 
the the incrementDecrement options.

Step 9. incrementDecrement: Depends on the number of decimal places selected. 
• If the number of decimal places is 0, then select 1, 5, 10, 100. 

• If the number of decimal places is 1, then select 0.1, 0.5, 1, 5, 10, 100. 

• If number of decimal places is 2, then select 0.01, 0.1, 0.5, 1, 5, 10, 100.

Note: The increment of 5 and 0.5 is available for the value from wall module, network setpoint, and 
sensor offset Value (Internal) parameters for the TR71x and TR75x wall modules.

Step 10. defaultValue: Indicates the value that initially downloads to the wall module. 
This value must be between the low and high limits. This field is displayed for the 
following parameter types: 
• Value from wall module. 

• Sensor offset value. By default, it is set to 0.

Step 11. limitConfig: This option is to set the high and low limits of the parameter. 
• Low Limit From Sylk Param: To select the low limit value from the other Sylk 

parameter of the respective system device. 
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• High Limit From Sylk Param: To select the high limit value from the other 
Sylk parameter of the respective system device.

• Low Limit: To set the low limit.

• High Limit: To set the high limit.

Fig. 390  Set High and Low Limits of Parameter

Step 12. selectLabelsToshowOnScreen: This option allows to configure Sylk device label 
display for Sylk parameter.
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Configure Sylk In Out Parameters
The Sylk device uses the following parameters as input as well as output:

• Bypass Time Parameter Configuration: provide the bypass time to the wall module.

• Fan Command Parameter Configuration: provide commands to the fan from the 
wall module.

• Network Setpoint Parameter Configuration: provide the setpoints to the wall 
module.

• System Command Parameter Configuration: override the system command from 
the wall module.

• Time Field Parameter Configuration: To configure the time format of the wall 
module.

For more detail about Sylk In Parameters type, refer IRM Function Blocks User Guide - 
EN2B-0415-GE51.

Bypass Time Parameter Configuration

Fig. 391  BypassTime Property Sheet

Steps to configure Bypass Time parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.
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Fan Command Parameter Configuration

Fig. 392  FanCommand Property Sheet

Steps to configure Fan Command parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. fanStates: Enables the fan command. The valid fan States choices will be 
enabled if this option is checked. The three eligible fan states are 2 State, 3 State, 
and 5 State.
The following are the available fan state options:
• 2 State: Auto / On. The default option is On.
• 3 State: Auto / On / Off. The default option is On.
• 5 State: Auto / Off / Low / Medium / High. The default option is Auto.

Fig. 393  Fan state Options

Step 3. fanStateValues: Set the fan state values for Auto / Off / On / Low / Medium /
High.

Fig. 394  Fan State Values
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Step 4. tR7XConfig: Set the default state of the fan command.
Step 5. setASNetworkSetpoint: This option allows you to specify whether the 

parameter should be configured as a network set point or as an output only 
parameter.
• If you select Yes, you have access to write and read values.

• If you select No, you can only read values from the Sylk device.

Note: • Set as Network setpoint is enabled by default. This option cannot be disabled by the user.

• Only the TR71/TR75/TR42 model wall modules have the Set as Network Setpoint option.

Network Setpoint Parameter Configuration

Fig. 395  Network Setpoint Property Sheet

Steps to configure Network Setpoint parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. categories: Enter the category name in the field. It helps to differentiate between 
parameters.

Step 3. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig. 396  Parameter Permissions
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Step 4. allowNullValue: Indicates whether null values can be set for the adjustable 
value. If enabled, when the user exceeds a low or high limit, an additional button 
push will deliver the null value.

Step 5. tR7XConfig: This option allows you configure additional parameters.

Fig. 397  tR7XConfig Additional Parameter Options

• enumerated: This field allows user to enable multiple states of the enum setpoint. 

• enumDefinition: If the enumerated is “Yes,” the user can set multiple states of the 
enum setpoint.

Note: The enumerated option applicable to the Sylk module type is TR 71 and TR 75. Select the 
parameter type as controller value, a value from wall module, or network setpoint to enable the 
enumerated option.

• defaultEnumValue: This option displays the list of default enum value from the 
defined enum range.

• numberOfDecimals: Apply to all parameter types except Time. This value affects 
incrementDecrement options.

• incrementDecrement: Depends on the number of decimal places selected. 

• If the number of decimal places is 0, then select 1, 5, 10, 100. 

• If the number of decimal places is 1, then select 0.1, 0.5, 1, 5, 10, 100. 

• If number of decimal places is 2, then select 0.01, 0.1, 0.5, 1, 5, 10, 100.

Note:  The increment of 5 and 0.5 is only available for the value from wall module, network setpoint, 
and sensor offset Value (Internal) parameters for the TR71x and TR75x wall modules.

• defaultValue: Indicates the value that will be initially downloaded to the wall 
module. This value must be between the low and high limits. This field is displayed 
for the following parameter types: 

• Value from wall module. 
• Sensor offset value. By default, it is set to 0.

• limitConfig: This option allows to set the high and low limits of the parameter. 
• Low Limit From Sylk Param: To select the low limit value from the other Sylk 

parameter of the respective system device. 
• High Limit From Sylk Param: To select the high limit value from the other 

Sylk parameter of the respective system device.
• Low Limit: To set the low limit.

• High Limit: To set the high limit.
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.

Fig. 398  To set high and low limits of parameter

• selectLabelsToshowOnScreen: This option allows to configure Sylk device label 
display for Sylk parameter.

Step 6. tR4XConfig: This option allows you configure additional param options.

Fig. 399  tR4XConfig
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System Command Parameter Configuration

Fig. 400  System Command Property Sheet

Steps to configure Network Setpoint parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. systemCommands: Indicate an option to enable or disable the tenants 
commanding the system. 
The following are the five valid system command options available: 
• Off / Heat (Heat only)

• Off / Cool (Cool only)

• Off / Heat / Cool (No auto changeover)

• Off / Auto / Heat / Cool (Auto changeover)

• Off / Auto / Heat / Cool / Emergency Heat (Heat Pump)

Fig. 401  Command Points

Step 3. defaultSystemCommand: Allows to set the default value for the system 
command options:
• Off: Off / Heat / Cool: 

• Auto: Off / Auto / Heat / Cool
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• Heat: Off / Heat 

• Cool: Off / Cool 

• Emergency Heat: Off / Auto / Heat / Cool / Emergency Heat

Fig. 402  Default System Command Values

Step 4. systemCommandValues: System command values display the various 
command values that are enabled based on the valid system commands that are 
selected. Incorrect values are disabled (depending on the system configuration 
options selected). You can switch between Off, Auto, Heat, Cool, and Emergency 
Heat modes.
• Off = 255

• Auto= 0

• Heat = 2

• Cool = 1

• Emergency Heat = 3.

Fig. 403  System Command State Values

Step 5. setAsNetworkSetpoint: Connect the System command block to the Network 
input or setpoint and the Network output point using this option. If this option is 
not selected, the System command block can only refer to the Network output 
point and not the Network input or set point.

Note: Set as Network Setpoint is disabled by default. The default value is No. By clicking YES or NO, 
you can enable or disable this option.

Note: Set as Network Setpoint option is available only for theTR71/TR75/TR120 model.
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Time Field Parameter Configuration

Fig.  404  Time Field Parameter

Steps to configure Time Field Parameter parameter:

Step 1. sylkDevice: Select the Sylk device from the drop-down list.

Step 2. paramPermissions: Select the permissions from the drop-down list as per the 
requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).

Fig.  405  Parameter Permissions

Step 3. timeComponent: This option allows configuring time and date format. The 
following are the available time components.
• Hours (Network Setpoint)

• Minutes (Network Setpoint)

• Day (Network Setpoint)

• Month (Network Setpoint)

• Year (Network Setpoint)
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Fig.  406  To configure Time and Date Format

Step 4. selectLabelsToShowOnScreen: This option allows to configure the Sylk device 
label display for the Sylk parameter.

Fig.  407  Sylk Device Label Display
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Map UI terminal of the controller with Sylk parameter
If you want to show any Sylk parameter data, such as temperature on the Sylk wall module 
display, then you need to map the controller UI terminal with the Sylk parameter.

Steps to Map UI terminal of the controller with Sylk parameter:

Step 1. Open the Wiresheet View, right-click on the controller’s UI terminal, and select 
Link Mark.

Fig.  408  UI Terminal

Step 2. Navigate to the Sylk application, right-click on the Sylk parameter, and select 
Link From “UI_4”.

Fig.  409  Link to UI Terminal

Step 3. Select Out from the source and In from the target.

Fig.  410  Link Windows

Step 4. Click OK. It maps the UI controller terminal with the Sylk parameter terminal. 
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Configure Sylk Device
The Sylk device's details are displayed on the property sheet. The details include Network 
number, address, status, power consumption, and other options.

Steps to configure a Sylk Device:

Fig.  411  Sylk Device Property Sheet (TR120_TR75E)

Step 1. Address: This option allows you to select a device address from the drop-down 
list. 

Note: When you add the Sylk device to the wiresheet view, it will automatically assign a unique 
address. You can change the assigned address manually.

Step 2. Time Format: Set the time format of the Sylk device (12 hours or 24 hours).
Step 3. Home Screen Options: This option allows you to configure the home screen 

settings.

Fig. 412   Home Screen Settings
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• Set As Default: Select this option if the current home screen needs to be set as 
default.

• Option Type: Select the type of screen:

• Single parameter (one value with custom eight character label): This 
option displays one label in the home screen.

• Multiple parameter (up to three values with fixed label): This option 
displays all three labels on the home screen.

• Label Name: Add the label name as per requirement.

Note: Specify the parameter you want to show (For a single parameter home screen, only the middle 
parameter will be considered).

• Left Parameter: Map the parameter that needs to be shown on the left side of the 
home screen.

• Middle Parameter: Map the parameter needs to be shown in the middle of the home 
screen.

• Right Parameter: Map the parameter that needs to be shown on the right side of the 
home screen. 
To map the parameter with home screen follow the steps below:

i). Click the Folder icon ( ) and select Component Chooser from the drop-down 
list.

Fig.  413  Component Chooser

ii). On the Select Ord window, click Drivers > BacnetNetwork >  IrmBacnetDevice 
> Irm Program > Periodic program> Humidity and click OK.
This action fetches the scheduler location to the scheduler block location filed.

Or
i). Go to nav window, navigate to the Station > Drivers > BacnetNetwork >  

IrmBacnetDevice > Irm Program > Periodic program wiresheet.

ii). Select the parameter and press Ctrl + L. This action opens the Ord window,
iii). Copy the Ord link.
iv). Navigate to the Sylk device's home screen settings option and paste the Ord 

URL into any of the parameter fields.

Fig.  414  Parameter Fields
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Note: The Sylk parameter linked to the left param displays the parameter value in the middle of the 
Sylk device. Sylk parameter linked to the middle param display the parameter value on top of 
the Sylk device, and the Sylk parameter linked to the right param display the parameter value 
on the bottom of the Sylk device.

• Select Labels To Show On Home Screen: Select the required option (room top or 
room bottom) to display the parameter on the home screen shown below:

Fig.  415  Home Screen Labels
• Labels displayed on the top with middle param – room (top), setpoint (top), 

and temperature.

• Labels displayed on the middle with middle param – room (bottom) and 
setpoint (bottom).

• Labels displayed on the bottom with middle param – humidity and 
outside.

• Only one engineering unit label is supported by the Sylk device (Ppm, Cfm, 
L/S, Cm, and inch). If you enable multiple engineering unit labels, then the 
system will consider the topmost unit label in the sequence in the home 
screen. 
Example: If you enable Cfm, L/S, and inch unit label in the home screen, then 
the Sylk device will display Cfm unit, as in topmost unit label. 

Step 4. Password Protection: The option allows you to set the password for the Sylk 
device. This feature restricts the tenants from making the changes in the Sylk 
controller.

Fig.  416  Set the Password
• Enable Password Protection: This option allows you to enable the password 

protection for the Sylk device.

• Password Label: This option allows you to add password label information. 
The label length should be eight characters.
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• Password: This option allows you to set the password. Numeric characters 
are allowed in the password.

Step 5. Categories And Parameters Node: Categories and parameters node allows 
users to reorder the Sylk categories and the Sylk parameters from the workbench 
and browser. The Sylk device will display the categories and parameters in the 
order specified in this view or object.

Fig.  417  Categories and Parameters Object

Reordering can be performed once the user completes the Sylk device and 
parameters configuration. Refer to the following section for more details on 
reordering, renaming, and disassociation categories and parameters.
• Reorder Parameters and Categories on page 283

• Rename Categories and Parameter on page 285

• Disassociate Parameter and Categories on page 285
 

Step 6. Schedule: The schedule option allows configuring the Sylk device with an 
enumerated schedule and calendar. 
Steps to configure schedule is as follows:

i). Open the Sylk device property sheet and navigate to the Schedule 
option.

Fig.  418  Schedule Option

ii). Set the Schedule Editable From Zio field to Yes.
iii). Change Param Permissions (contractor only, tenant read-only, and tenant read 

write) as per requirement.
iv). Change the Schedule Type as per requirement (8-day schedule / 7-day 

schedule / 5-2-1-day schedule / 5-2-day schedule).
v). Enter the schedule block location in the Schedule Block Location field.

Steps to add Scheduler Block Location:

i). Click the Folder icon ( ) and select the Component Chooser from the 
drop-down list.
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Fig.  419  Component Chooser

ii). On the Select Ord window, click Drivers > BacnetNetwork >  IrmBacnetDevice 
> Irm Program > Periodic program> EnumSchedule, and then click OK.
This action fetches the enum schedule object to the Scheduler Block Location 
filed.

    Or

Go to nav window, navigate to the Station > Drivers > BacnetNetwork >  
IrmBacnetDevice > Irm Program > Periodic program> EnumSchedule, and 
press Ctrl + L or copy the enum schedule and paste into the field.

iii). This action opens the Ord window, copy the location, and paste in the scheduler 
block location field.

iv). Click Save.
Step 7. Time: The time option allows you to enable the time component for the Sylk 

device. To add this time component, enable the Time editable From Zio option 
and select contractor only, tenant read only, or tenant read write from the drop-
down menu.

Fig.  420  Enable Time 
• If the contractor only is selected, only the contractor can view the time in the 

Sylk device. 
• If tenant read only is selected, the tenant can view the time but cannot 

change the time. 
• If tenant read write is selected, the tenant can view and modify the time. Time 

includes the year, month, date, hour, and minutes, enabling everything in the 
time component.

TimeField parameter allows you to customize access for contractor and tenant. For exam-
ple, the contractor is allowed to change the time but not the date. To provide this type of 
controlled access, use the timefield parameter. For more details, refer to IRM Function 
Blocks User Guide - EN2B-0415-GE51.
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Reorder Parameters and Categories
The parameters can be reordered either across and within the categories. Categories can 
also be reordered. 

Steps to perform reorder:

Step 1. Navigate to the TR75H from the nav window and double-click Categories and 
Parameters Node.

Fig.  421  Categories and Parameters
Or, Navigate to Wiresheet view > double click on TR75H Sylk device > double-
click on Categories and Parameters Node.

Fig. 422   Parameter Order
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Step 2. Right-click on Categories and Parameters Node > Actions > Load Categories 
And Parameters.

Fig.  423  Load Categories and Parameters

Step 3. This will load all the categories and parameters associated with this Sylk device.

Fig.  424  Categories and Parameters

Step 4. Right-click on Categories and Parameters Node from the property sheet and 
select Reorder.

Step 5. Use Move Up or Move Down to reorder the Category and click OK.

Fig. 425   Reorder Category

Note: Press Ctrl and click move up or move down to select multiple parameters. 
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Similarly, you can reorder parameters associated with the Category.

Fig.  426  Reorder Parameters

Once re-ordering is completed and Sylk commission is done, you can view the same order 
of categories and parameters node in the connected Sylk device.

Step 6. Categories and parameters node allows you to see all the parameters associated 
with that device. Also, it provides an option to navigate to the parameter using 
the ord.

Fig. 427   Parameter Node

Rename Categories and Parameter
The categories and parameters field allows user to rename categoriesand parameters from 
the CentraLine workbench.

Steps to rename Parameter:

Step 1. Select a parameter from the category, right-click, and select Rename.
Rename window displays, enter the new name, and click Ok.

Step 2. Navigate to Categories and Parameters node, right-click and select Actions > 
Load Categories And Parameters. This action loads the changes.

In the wiresheet, you can view the changed parameter name. Similarly, the user can rename 
the categories.

Disassociate Parameter and Categories
The categories and parameters option allows you to disassociate categories and parame-
ters from the associated Sylk Device.

• To disassociate Parameter: Select parameter from the category > right-click and 
select Delete. This action disassociates the parameter from the Sylk device, and 
none will be displayed for that Sylk parameter.

• To disassociate Category: select category > right-click and select Delete. This 
action disassociates all the parameters from the Sylk device, and none will be 
displayed for all the parameters associated with that category.
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Validate Sylk Device
After configuring Sylk Devices with the Sylk parameters, you need to validate the Sylk 
device configuration. Validate the Sylk device to verify the configuration of added Sylk 
device. Also, the validation action confirms any incorrect value entered in parameters or 
limitations for the configured Sylk device. 

Steps to validate Sylk Device:

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork >  IrmBacnetDevice.
Step 2. Right-click on the BACnet Program and select Actions > Validate Sylk Devices. 

It validates all the Sylk devices in the wiresheet view.

Fig.  428  Validate Sylk devices

Alternatively, If you want to validate a single Sylk device, follow the below steps:
Step 3. Navigate to Station > Config > Drivers > BacnetNetwork >  IrmBacnetDevice > 

Irm Program > Periodic program or Event program.
Step 4. Right-click on the Sylk Device and select Actions > Validate Sylk Devices.
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Fig.  429  Validate Sylk Device

After performing the validate Sylk device action, you can view the status of the specified 
Sylk devices in the job log window. Using the job log information, discover and resolve all 
issues. 

Fig.  430  Job Log

Validate Sylk device operations can be done in online mode or offline mode while setting 
Sylk devices on the workstation.
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Teach to Controller
After you validate the Sylk device configuration, perform Teach to Controller operation. This 
installs the Sylk device application file in the Sylk devices like TR75, TR40, etc. 

Steps to perform a teach to controller:

Step 1. Right-click on the Irm Program > Actions > click Teach to Controller.

Fig.  431  Teach to Controller

Step 2. Select Overwrite BACnet objects values in Device or Overwrite BACnet object 
values in Application.

Fig.  432  Teach to Controllers dialog box
• Overwrite BACnet objects values in Device: This option overwrites BACnet 

object values in the controller and directly teaches the application in the 
controller.

• Overwrite BACnet object values in Application: This option update all 
BACnet object values and default values from controller to application. Then 
it teaches application in the controller.

The changes are written to the controller. The applications are synchronized. The 
successful action is displayed via Irm Operations Monitor. After the Sylk application is 
installed on the controller, the Sylk device reboots and displays updated values on the Sylk 
device.

Fig.  433  Sylk device display
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Verify the Sylk device resource usage
After loading the Sylk application file into the controller, you can verify the Sylk device 
resource usage. These fields are read only. The Sylk device resource usage displays how 
many resources are utilized by each Sylk parameter as well proxy size of data by the con-
troller. 

Steps to verify the Sylk device resource usage:

Step 1. Open the workstation and navigate to the Sylk application.

Note: Ensure the controller is communicating with the station.

Step 2. Open the Sylk Device and click Sylk Device Resource Usage.

Fig.  434  Sylk Device Resource Usage

Step 3. Check that the Is Configuration Downloaded option is True. 

Important: If any configuration changes are done in the Sylk device or parameters, the Is Configuration 
Downloaded will change to false. To update the changes, perform validate Sylk devices and 
teach to controller operation on the Sylk device.

Fig.  435  Sylk Device Property Sheet
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Sylk Parameter Summary
Steps to view all the associated parameters to the Sylk device: 

Step 1. Navigate to the Irm Program > Views > select Sylk Parameter Summary.

Fig.  436  Sylk Parameter Summary

Fig.  437  Sylk Parameter Summary View

By following the procedure above, you can add and configure Sylk devices with the sup-
ported Sylk parameters. After configuring the Sylk parameters with the Sylk devices, create 
the Sylk proxy file and commission it to the controller.

To replace the TR4x device with the TR7x device.  Replace the TR42 device with the TR75 
Sylk device and re-associate all parameters with the device. The Sylk devices configuration 
must then be validated and perform teach to the controller. 
This action requires less effort to reconfigure the device. It also helps to establish a connec-
tion with the same Sylk device. However, the associated parameters vary from device to 
device.
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Sylk Configuration Examples
Users can configure the Sylk parameters according to the requirements as shown in the 
examples below:

TR75H Sylk Configuration 
In the Sylk device property sheet, the TR7x configuration would be auto-selected under the 
model tab based on the function block dropped in the wiresheet.

Check to ensure that the Wall Module’s bus address dial (located on the back of the mod-
ule) matches exactly with the setting of the configuration tool. Select 12 or 24-hour format.

Fig. 438   TR75H Property Sheet

TR75H Logic Configuration
To configure the Sylk device, drag-drop the required Sylk parameters. Make sure the Sylk 
device supports the selected Sylk parameter.

Following are the Sylk Parameter details:

• ROOMTEMP: To measure the temperature of the space.

• OccupancyOverrideCommand: To override the unoccupancy mode to occupied mode.

• OccupancyStatus: Displays the occupancy status in the wall module.

• SensorOffset: To provide the sensor offset to the wall module.

• ValueFromWallModule: To provide the value from the wall module to the controller.

• SystemCommand: To override the system command from the wall module.

• PassThru: The passthru object passes temperature inputs and transfers the value to 
network outputs.

• SavePermanent: This object is used to save values in non-volatile memory. The value is 
not lost when the supply voltage is switched off. 
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• Encode: The Encode function translates enumerations of a digital value into different 
enumeration numbers, allowing standard and custom enumerations to be combined 
and used together.

Fig. 439   TR75H Logic Configuration example
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TR71H Sylk Configuration and Logic

TR71H Logic Configuration
To configure the Sylk device, drag-drop the required Sylk parameters. Make sure the Sylk 
device supports the selected Sylk parameter.

Sylk Parameter details are as follows:

• ROOMTEMP: To measure the temperature of the space.

• OccupancyOverrideCommand: To override the unoccupancy mode to occupied mode.

• PassThru: The PassThru object passes temperature inputs and transfers the value to 
network outputs.

• SavePermanent: This object is used to save non-volatile memory values. When the 
supply voltage is switched off, the value remains unchanged.

• Encode: Enumerations of a digital value are translated into different enumeration 
numbers by the Encode function, allowing standard and custom enumerations to be 
combined and used together.

Fig. 440   TR71H Configuration
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TR120H and TR75E Sylk Configuration 
To configure the Sylk device, drag-drop the required Sylk parameters. Make sure the Sylk 
device supports the selected Sylk parameter.

Following are the Sylk Parameter details:

• ROOMTEMP: To measure the temperature of the space.

• OccupancyOverrideCommand: To override the unoccupancy mode to occupied mode.

• OccupancyStatus: Displays the occupancy status in the wall module.

• SensorOffset: To provide the sensor offset to the wall module.

• ValueFromWallModule: To provide the value from the wall module to the controller.

• SystemCommand: To override the system command from the wall module.

• PassThru: The passthru object passes temperature inputs and transfers the value to 
network outputs.

• SavePermanent: This object is used to save values in non-volatile memory. The value is 
not lost when the supply voltage is switched off. 

• Encode: The Encode function translates enumerations of a digital value into different 
enumeration numbers, allowing standard and custom enumerations to be combined 
and used together.

Fig. 441   TR120H and TR75E Logic configuration
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TR42x and TR40x Sylk Configuration
The TR40x and TR42x are temperature wall modules with basic setpoint, override, and fan 
options. TR40x and TR42x Sylk device is designed for a broad range of applications.

The TR40x and TR42x wall modules include:

• Models available with display (TR42) or without display (TR40).

• Models available with or without built-in humidity or CO2 sensors.

TR42x Sylk Configuration 
TR40 Sylk sensors do not allow to override the current schedule or remote commanding 
capabilities.

Check to ensure that the Wall Module’s bus address configured using the dip switches 
(located on the back of the module) matches exactly with the setting of the configuration 
tool.

Fig. 442   TR42HCO2 Property Sheet

TR42x Logic Configuration
To configure the Sylk device, drag-drop the required Sylk parameters. Make sure the Sylk 
device supports the selected Sylk parameter.

Sylk Parameter details are as follows:

• ROOMTEMP: To measure the temperature of the space.

• SensorOffset: To provide the sensor offset to the wall module.

• PassThru: The PassThru object passes temperature inputs and transfers the value to 
network outputs.
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• SavePermanent: It is used to save values in non-volatile memory. The value is not lost 
when the supply voltage is switched off. 

• Encode: The Encode function translates enumerations of a digital value into different 
enumeration numbers, allowing standard and custom enumerations to be combined 
and used together.

• HUMIDITY: Measures the percent humidity of the space.

• CO2: Measures the CO2 concentration in the space.

Fig. 443   TR42 Logic Configuration
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TR42 Configuration (Encode-Snap)

Fig. 444   TR42 Encode-Snap
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TR40 Sylk Configuration
To configure the Sylk device, drag-drop the required Sylk parameters. Make sure the Sylk 
device supports the selected Sylk parameter. Sylk Parameter details are as follows.

• ROOMTEMP: To measure the temperature of the space.

• HUMIDITY: Measures the percent humidity of the space.

• CO2: Measures the CO2 concentration in the space.

Fig. 445   TR40 Sylk Configuration 

C7400S Configuration
In the Sylk device property sheet, the C7400s configuration would be auto-selected under 
the model tab based on the function block dropped in the wiresheet.

Ensure that the sensor bus address is configured using the dip switches matches exactly 
with the setting of the configuration tool. No other configuration is required to be config-
ured for C7400S Sylk sensors.

Fig. 446   C7400S Configuration Logic
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Delete a Sylk Device
If you want to remove a Sylk Device from a configured station, follow the below steps:

Steps to delete a Sylk Device is as follows:

Step 1. Right-click on the Sylk Device from the nav window. 

Step 2. Select Delete.
Alternatively, 
Double-click on Periodic program, navigate to the wiresheet view, select the 
Sylk device, and press delete.

Fig.  447  Delete Sylk Device

Note: Whenever you modify any Sylk device or parameter configuration, the impacted Sylk device 
will not perform to read and write function. This modification will not impact the read and write 
function of other commissioned Sylk devices.
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Sylk Actuator
The IRM NX supports following Sylk actuator models:

MS3103, MS3105, MS4103, MS4105, MS7403, MS7405, MS7503, MS7505, MS8103, 
MS8105 Spring Return Direct Coupled Actuators (DCA) are used within heating, ventilat-
ing, and air-conditioning (HVAC) systems. They can drive a variety of quarter-turn, final 
control elements requiring spring return fail-safe operation.

Applications includes following operations:

• Volume control dampers: The volume control dampers mounted directly to the 
drive shaft or remotely (with accessory hardware).

• Quarter-turn rotary valves: The Quarter-turn rotary valves such as a ball or 
butterfly valve mounted directly to the drive shaft.

• Linear stroke globe or cage valves: The Linear stroke globe valves mounted with 
linkages to provide linear actuation.

• Available with cable on select models.

Inputs and Outputs of the Sylk Enabled Actuators
As shown in figure below, Sylk actuator has two inputs and five outputs. All the inputs and 
outputs communicate with the IRM NX controllers over a Sylk bus.

Fig. 448   Sylk Actuator Inputs and Outputs

• Actuator Command: Actuator commands are generated by the controller's output. 
An Actuator moves in response to a command.

• Actuator Travel Time: The actuator travel time is the time required by the actuator 
to travel from 0 % to 100 % open or 100 % to 0 % open. This time interval depends 
on the actuator type and varies from 0 to 500 seconds.

• Actuator Position: This is feedback from the actuator’s current position ranging 
between 0 to 100 % and can be linked into the BACnet controller for monitoring. 

• Actuator Cycle Count: It shows how many time actuators cycles from open to close 
position.

• Actuator Status: Actuator status returns a number with the following meaning:

• 0: No Error

• 1: Under Voltage
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• 2: Over Voltage

• 3: Stall

• 4: OverVoltage and Stall

• 5: UnderVoltage and Stall 

• Actuator Overridden:It provides actuator overridden status if the actuator is 
overridden externally.

• This will return “True” if the unit is in Test Mode. It occurs if the address port is 
manually turned to position 6.

• Power Report: This is a relative measurement. It is only calculated for the last 
commanded move, ranging from 0 to 100.

Add a Sylk Actuator
To configure the Sylk actuator device, you need to add it to the wiresheet.

Steps to add Sylk actuator device:

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork >  IrmBacnetDevice > 
double-click IrmProgram. This action opens periodic program wiresheet.

Step 2. Drag IrmFolder from the palette and drop onto Periodic program wiresheet.
Step 3. Navigate to the palette, select the SylkActuator from the SylkDevices list and 

drop it to Periodic program wiresheet.

Fig. 449   Adding Sylk Actuator to the Wiresheet.

Step 4. Enter the SylkActuator name and click OK. This adds the Sylk Actuator under  
IrmBacnetDevice.
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Step 5. Expand SylkActuator or double-click on SylkActuator and check the power 
consumption and configure the Sylk actuator device. 

Fig. 450   Sylk Actuator Property Sheet

Sylk Actuator Device Type
Once you have added the SylkActuator in the Periodic program folder, configure the 
parameters of the SylkActuatorDevice.

Configure Sylk Actuator Inputs
Steps to configure Sylk Actuator inputs:

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork >  IrmBacnetDevice > 
double-click IrmProgram. This opens the Periodic program wiresheet view.

Step 2. Navigate to the palette section, expand Sylk > SylkParms > select 
SylkActuatorInputParam.

Step 3. Drag SylkActuatorInputParam from the palette and drop into the Irm Folder 
wiresheet.

Table 41  Parameters Supporting Sylk Actuator

Sylk Actuator Variables Sylk Actuator Type

Status Variables

Parameter Zelix Diamond Zeus

Actuator Position Y Y Y

Actuator Cycle Count Y Y Y

Actuator Status Y Y Y

Actuator Overridden Y Y Y

Power Report Y N N

Control Variable

Actuator Timing Y Y Y

Actuator Position Request Y Y Y
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Step 4. Double-click on the SylkActuatorInputParam modules. 
Step 5. Expand SylkActuatorInputParam property sheet, select sylkDevice as 

SylkActuatorDevice, and inputType as actuator or act travel time from the drop-
down list.

Fig. 451   Sylk Actuator Input Parameter Configuration

Configure Sylk Actuator Inputs Parameter
• In: Provides the Sylkactuator value to the controller. 

• Master Sync Enabled: Enable or disable master sync. 

• sylkDevice: Select the required Sylk actuator device from the drop-down menu. 

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, 
overridden, disabled, down, stale, null, unackedAlarm). For more details see Sylk 
component status behaviors.

• faultCause: Read-only point, displays the reason for the fault parameter. This 
property is empty unless a fault exists.

• sendInterval (seconds): sendInterval is the time interval for sending data from the 
controller to the network on a regular basis. The controller will send the input 
parameter value to the Sylk device based on the user-configured sendInterval (in 
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seconds).
For example, if the sendInterval value is set to 5 seconds, the controller will send the 
value of the input parameter to the Sylk device every 5 seconds. The allowed interval 
range is 5 to 75 seconds. The sendInterval value is set to 5 seconds by default.

If sendInterval is set to Cov (change of value), the controller will only send the value 
of the input parameter to the Sylk device when it changes. With Cov selection, the 
GPU (guaranteed periodic update) feature is added. To avoid data loss due to high 
network traffic, the controller updates the input parameter value to the Sylk device 
every 60 seconds.

Note: If the Sylk device is configured at a higher address, it is possible that the Sylk device will miss 
reading the network's periodic parameter update. It is recommended that enableFD be set to 
"No." (If enableFD is set to "Yes," the Sylk parameter value will be set to default if it does not 
receive parameter updates, which may affect its behavior.)

Note: Only use Cov at critical points. Cov utilize Sylk bandwidth for communication . Excessive 
bandwidth usage may result in data loss between Sylk devices.

• senDelta: SenDelta is another name for the delta value for significant event 
notification. It allows the controller to send the input parameter value to the Sylk 
device only when the difference between the last sent value and the current value is 
greater than or equal to senDelta. Otherwise, the value change will not be 
propagated to the Sylk device.

For exmple: If the senDelta is two, the last sent input parameter value is two, and the 
current value is five. The difference in parameter values is three (5 - 2 = 3), which is 
greater than the senDelta value (two). This enables the controller to send the current 
value of the input parameter (five) to the Sylk device.
It regulates the increase in network traffic caused by the frequent changes in the 
values of input parameters. This can be used to tune the controller so that minor 
value changes do not propagate to the network. The senDelta value is set to 0.5 by 
default.

Note: The senDelta feature is only available when the sendInterval is set to "Cov." A senDelta of zero 
indicates that any value change is significant and is propagated to the network.

• enableFD: Fail Detect is the time until the controller is notified of a failure on this 
point.

• Yes: If enableFD is set to true, the Sylk device anticipates a periodic update 
to the input parameter. If it does not receive parameter updates from the 
controller, an alarm is generated and the Sylk input parameter value is set to 
the default value.

• No: If enableFD is set to false, the parameter retains the last value that was 
written to it. When it receives updated values from the controller, it will set 
the value. It does not allow parameter values to be set to their default value.

• FDInterval: FDInterval for Sylk actuator input parameter is 20 secs.

Note: To ensure proper functionality, sendInterval must be less than one-third of Fail Detect interval 
(if fail detect is enabled).

• inputType: You can use this option to select Sylk Actuator input. 
SylkActuatorInputParam can be set to one of two input actuator and act travel time 
values.
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• Actuator: The controller output is used to generate the actuator command. 
An actuator moves in response to a command.

• Actuator Travel Time: The actuator travel time is the amount of time it takes 
the actuator to travel from 0 % to 100 % open or 100 % to 0 % open. This 
time interval varies depending on the type of actuator and ranges from 0 to 
500 seconds.

Configure Sylk Actuator Outputs
Steps to configure Sylk Actuator output:

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork >  IrmBacnetDevice > 
double-click IrmProgram. This opens the Periodic program wiresheet view.

Step 2. Navigate to the palette section, expand Sylk > SylkParms > select 
SylkActuatorOutputParam.

Step 3. Drag SylkActuatorOutputParam from palette and drop into the IrmFolder 
wiresheet.

Step 4. Double-click on the SylkActuatorOutputParam modules.
Step 5. Expand SylkActuatorOutputParam Property Sheet, select sylkDevice as 

SylkActuatorDevice, and outputType as actuator position or actuator cycle 
count or actuator status or actuator overriden or power report from the drop-
down list.

Fig. 452   Sylk Actuator Output Parameter property
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Note: A separate parameter configuration is required for adding input or output point type for Sylk 
actuator.

Fig. 453   Sylk Actuator Input or Output point type

Configure Sylk Actuator Outputs Parameter
• Out: Provides the respective value to the controller from the Sylk device.

• Master Sync Enabled: Enable or disable master sync.

• sylkDevice: Select the required Sylk actuator device from the drop-down menu.

• Status: Read-only point. Shows the status of the parameter. (alarm, fault, 
overridden, disabled, down, stale, null, unackedAlarm). For more details see Sylk 
component status behaviors.

• faultCause: Read-only point, displays the reason for the fault parameter. This 
property is empty unless a fault exists.

• sendInterval (seconds): SenDelta is another name for the delta value for significant 
event notification. It allows the controller to send the input parameter value to the 
Sylk device only when the difference between the last sent value and the current 
value is greater than or equal to senDelta. Otherwise, the value change will not be 
propagated to the Sylk device.

Note: The senDelta feature is only available when the sendInterval is set to "Cov." A senDelta of zero 
indicates that any value change is significant and is propagated to the network.

• enableFD: Fail Detect is the time until the controller is notified of a failure on this 
point.

• Yes: If enableFD is set to true, the Sylk device anticipates a periodic update 
to the input parameter. If it does not receive parameter updates from the 
controller, an alarm is generated and the Sylk input parameter value is set to 
the default value.

• No: If enableFD is set to false, the parameter retains the last value that was 
written to it. When it receives updated values from the controller, it will set 
the value. It does not allow parameter values to be set to their default value.

• outputType: This option allows you to customize the Sylk actuator output. 
SylkActuatorOutputParam can be configured to produce the following outputs:

• Actuator Position: This is feedback from the actuator’s current position 
ranging between 0 to 100 % and can be mapped into the controller for 
monitoring. 
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• Actuator Cycle Count: It shows how many time actuators cycles from open 
to close position.

• Actuator Status: Actuator status returns a number with the following 
meaning:

• 0- No Error

• 1- Under Voltage

• 2- Over Voltage

• 3- Stall

• 4- OverVoltage and Stall

• 5- UnderVoltage and Stall 

• Actuator Overridden: It provides actuator overridden status if the actuator 
is overridden externally. This will return “True” if the unit is in Test Mode. It 
occurs if the address port is manually turned to position 6.

• Power Report: This is a relative measurement. It is only calculated for the 
last commanded move, ranging from 0 to 100 %.
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Enum Schedule Configuration
Steps to configure Enum Schedule:

Step 1. Navigate to Station > Config > Drivers > BacnetNetwork >  IrmBacnetDevice > 
double-click IrmProgram. This opens the Periodic program wiresheet .

Step 2. Navigate to the honIrmControl palette and expand Date_Time.
Step 3. Drag EnumSchedule from palette and drop into the wiresheet.
Step 4. Double-click on the EnumSchedule modules and expand Schedule Config.

Fig.  454  Configure Schedule properties

Step 5. Select Master Sync Enabled to true. 
Step 6. Click ConfigData to view the AX Scheduler.

Fig.  455  Config Data

Note: Before configuring the ConfigData properties of the schedule configuration, add supported 
Sylk devices to the wiresheet.

Fig.  456  Weekly Schedule

Step 7. Click Save.
Alternatively, click Refresh and click NO, if you do not want to save the changes.



IRM SYSTEM ENGINEERING GUIDE 309

Note: The Sylk wall module supports four events per day. However, the IRM NX controllers BACnet 
schedule supports more than four events per day. So, the user cannot edit the schedules in-
wall module when more than four events are configured per day.

Configure Sylk Schedule Event
Steps to configure Sylk Schedule Event:

Step 1. Open the property sheet of the Sylk wall module. 

Step 2. Set the Schedule Editable From Zio field to Yes.
Step 3. Select the permissions from the Param permission drop-down list as per the 

requirement (Contractor Only, Tenant Read-only, and Tenant Read Write).
Step 4. Change the Schedule Type as required (8-day schedule/ 7-day schedule/ 5-2-

1-day schedule/ 5-2-day schedule).
Step 5. Enter the schedule block location in the Schedule Block Location field.

Fig. 457   Sylk Schedule Configuration

Note: Schedule configuration workflow changes after changing any schedule changes in the tool, 
perform Sylk commission.
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Configure Schedule Block Location
Steps to configure Schedule Block Location:

Step 1. Click Folder icon ( ) and select the Component Chooser from the drop-down 
list.

Fig. 458   Component Chooser

Step 2. On the Select Ord window, click Drivers > BacnetNetwork >  IrmBacnetDevices 
> Irm Program > Event Program > EnumSchedule, and click OK.
This action fetches the scheduler location to the EnumSchedule Block 
Location filed. 

Step 3. Click Save Or click Refresh to cancel the changes.
Alternatively, go to nav window, navigate to the Station > Config > Drivers > 
BacnetNetwork >  IrmBacnetDevices > Irm Program > Event Program > Select 
EnumSchedule, and press Ctrl + L.
This action opens the Ord window, copy the location,

Fig. 459   Ord Window

Navigate to Schedule Config option and paste the link in the Scheduler Block 
Location field.

Fig.  460  Scheduler Block Location

Step 4. Click Save to save the changes.

Fig.  461  Enum Schedule
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Configure Global Schedule Event
BACnet Schedule Export sends schedule or calendar components to IRM BACnet schedule 
or calendar objects in the station.

Prerequisites: A operational CentraLine-N4 workbench connected to a remote host sta-
tion. To export, the BACnet device should include a schedule or calendar object.

The BACnet Schedule Export Manager view location: Go to Bacnet Network > Bacnet 
Device > Schedules.

The BACnet Schedule Export Manager view displays schedule components in the station 
as BACnet schedule objects or calendar objects. However, these server-type exported com-
ponents available for any device on BACnet networked. It does not write to specific objects 
in a BACnet device, which acts as a client.

The BACnet Schedule Export Manager view displays schedule components as BACnet 
schedule objects or calendar objects in the station. These server-type exported compo-
nents, on the other hand, are available to any BACnet networked device. It does not write to 
any specific objects in a BACnet device, which acts as a client.

Note: The IRM NX controllers does not support priorityForWriting function for Global Schedule 
event. To use the global schedule event, you need to disable priorityForWriting function.

To disable priorityForWriting function: Click Edit after selecting the global schedule event 
from the database. Click the skip writes property in the scheduling event edit box, then set the 
priorityForWriting property to True. 

Fig.  462  Disabling priorityForWriting Feature for Global Schedule Event
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Configure Enum Range
Perform the following operation to configure the Enum Range:

• Define Enum range on page 312

• Add Entry in Enum Library on page 312

• Modify Enum Library on page 313

Define Enum range
Steps to define Enum range:

Step 1. Double-click on ConfigData > Properties > Facets option, select default range 
(honIrmControl: ScheduleStatesEnum), and click (>>) icon. 

Fig.  463  Defining Enum Range

Step 2. Select the default Enum range, click the (…) icon, and click the (>>) icon. This 
action open the Enum Library.

Add Entry in Enum Library
Steps to add entry in the Enum Library:

Step 1. Select the blank fields.

Step 2. Enter the Ordinal value, display information in the respective field and click Add.
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Fig.  464  To add an Entry in Enum Library

Note:  Working with default facets configuration when the schedule is linked to the Sylk Device is 
recommended. Suppose the user configures the value of the facet other than the default 
configuration. In that case, the Sylk module may not operate correctly.

Note: In a Zio enum library maximum of 255 entries can be added.

Modify Enum Library
Steps to modify the entry in the Enum Library:

Step 1. Select the entry.

Step 2. Modify the Ordinal value, Display field, and Tag field and click Modify.
Or 

Step 3. Change the Ordinal value, Display field, and Tag field and click Add.
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Additional Configuration
The following are the additional configuration available on the Scheduler:

• Event time tuning

• Event Output

• Right-click menus

Event Time Tuning: You can specify the start and end times for each selected event by 
selecting the hours or minutes from the calendar or by entering the event start and end val-
ues in the corresponding boxes.

Fig.  465  Schedule Event Time Selection

Event Output: Select the required output value from the drop-down list.

Fig.  466  Schedule Output Value Selection
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Right-click menus: The table below describes the available right-click menus (in the 
schedule area) and their descriptions.

Fig.  467  Right-click menus 

Table 42  Right-click menus 

Options Descriptions

Delete Event Deletes the selected event.

Paste Day It appears if the copy day option was used. It copies all events into the 
selected day.

All Day Event It makes currently selected (or last entered) events extend to an entire 
day.

Apply M-F It copies all the events in the selected day to Mon, Tue, Wed, Thu, and 
Fri (and overwrites any existing events on those days).

Copy Day It copies all the events in the selected day.

Clear Day It clears all the events on the selected day.

Clear Week It clears all the events in the entire weekly schedule.
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Special Events
In the schedule view, each schedule object's special events are configured on a special 
events tab. The event times and values entered for any special event are only valid for that 
schedule.

Suppose the special event is set up as a "reference" type. In that case, the days of its occur-
rence should be specified as a reference in the calendar schedule functional block. It 
enables you to change the days of special events that occurred while editing one or more 
referenced CalendarSchedules on a global scale.

Fig.  468  Schedule - Special events

Fig. 469   Special Events Options

Table 43  Special Events

Options Descriptions

Date 
(default option) 

By various combinations of weekday, numerical date, month or 
month combinations, and year.

Date Range By start and end range, using for each a combination of day, 
month, year.

Week and Day
By the combination of day of the week, week in the month, month.

Note:  Calendar Week type will not support.

Custom

By combination of any day, month, weekdays, any week, and year.

Note:  Custom type events for Special events not supported by IRM 
Compact VAV and FCU controller.

Reference By reference to a specific Calendar Schedule component in the 
station.
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Special Events

Sylk wall module supports the following exception:

• One exception schedule to configure for a holiday.

• BACnet schedule supports more than one exception schedule. 

You can edit one of the first exception schedules in the wall module, and the second excep-
tion schedule onwards cannot be edited.

To implement this limitation, you must configure the calendar object with multiple holidays 
and use calendar references to create an exception schedule in the IRM schedule.

Note: The TR120x and TR75x wall modules can edit the schedule for one holiday.  Since IRM NX 
controller supports a unique schedule for each holiday, when you integrate TR120x and 
TR75x, the user can edit only the first holiday created in the schedule. 

When working with TR120x and TR75x wall modules, use the Calendar object to create 
multiple holidays and assign one schedule for all the holidays. When you edit the holiday 
schedule, it will apply to all the holidays.

Create Event for Multiple Days
You can create one event and apply to multiple days.

Steps to create event for multiple days:

Step 1. Add a Calendar function block in the wiresheet, define all the holidays dates, 
and date ranges on the calendar.

Note: When using the schedule and calendar function block in the application, controller time 
should be synchronized for the system time; else, the schedule function block will have wrong 
references and might not work correctly. TSYNC is the best way to synchronize time in the 
controller.

Step 2. Navigate to EnumSchedule > ConfigData > Special Events, create one 
Exception Schedule, select calendar Type as Reference, and click OK.
Now define the time events for this Exception Schedule. The schedule will 
execute these time events for all the dates defined in the Calendar.

Step 3. Wall module displays this exception schedule time events (as this is the first one) 
as Holiday time events on display. 

Table 44  Special Event options

Options Descriptions

Add Add a new special event.

Edit Edit day(s) selection criteria (but not changing special event type).

Rename Rename selected special event.

Priority (up) Move special events up in the priority list.

Priority (down) Move special events down in the priority list.

Delete Removes selected special events from the schedule component.
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Step 4. You can modify the holiday time events. These modified time events get written 
back to the first Exception Schedule, which is configured as calendar type as 
Reference. Hence same time events get applied to all the defined dates on the 
Calendar.

Scheduled Event Default Output 
The schedule block output (Out slot) will be the default value whenever a scheduled event 
(special or weekly) is not defined or effective.

The white area in listed events indicates where the default value is used and displays the 
current default value.

Fig.  470  Schedule event default value
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Configuring WmConfigHvacA using Sylk Device
The honIrmControl provides “WmConfigHvacA” function blocks that can be configured and 
used to build the required application logic that supports various wall operating device.

Note: The WmConfigHvacA function block can be placed no more than three times onto the 
wiresheet. It can only be configured as a Sylk wall module once. Instead of using the Sylk wall 
module, the function block can also be configured as a wired or external wall module (a 
Modbus wall module).

The function block supports various wallmodules (WM) Wired, Sylk TR40/42 and an exter-
nal WM. The external WM communicates e.g. via BACnet to the room controller.

For more detail about WmConfigHvacA functional block, refer to IRM Function Blocks User 
Guide - EN2B-0415-GE51.

Steps to configure WmConfigHvacA functional block:

Step 1. Expand the Irm Program and double-click Periodic Program. 

Step 2. Open the honIrmControl palette and scroll down to the Wallmodule.
Step 3. Expand Wallmodule, drag the WmConfigHvacA, and drop it onto the wiresheet.

Fig. 471  honIrmControl Palette

Step 4. Change the name if desired in the “Name” dialog box and click OK.

Fig. 472  Name Dialog Box
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Step 5. Double-click the WmConfigHvacA. This action displays the property sheet.

Fig. 473  WmConfigHvacA

Step 6. Expand General Settings, select the desired wall model from the drop-down list. 

Fig. 474  Wm Model Selection



IRM SYSTEM ENGINEERING GUIDE 321

Based on the Wall model selection, the general setting configuration varies.

Fig. 475  Configure the Sylk Wallmodule Address

• Occ Ovrd Selection: This is used to check whether the room user may or may not 
overwrite the occupancy mode from the wall module. For example, the room user 
could switch to BYPASS in UNOCCUPIED mode to get the OCCUPIED setpoint.
Accordingly, I/O slots and parameters are displayed or hidden depending on this 
parameter.
The overwrite can be done from a Wired WM with an overwrite button, a Sylk 
Wallmodule via the display, or an external WM.
Values:

• 1: No Occupancy Overwrite

• 2: Occupancy Overwrite

• Setpt Ovrd Type Par: Since this parameter is also available as an input, please refer 
to the input Setpt Ovrd Type description.
Default Value:

• 1: No Setpoint Overwrite

• Fan Ovrd Type Par: Since this parameter is also available as an input, please refer 
to the input Fan Ovrd Type description.
Default Value:

• 1: No Selection: No fanspeed selection possible from wallmodule

• Hvac Ovrd Selection: Hvac Ovrd Selection is used to select whether the room user 
may or may not overwrite the wall module's HVAC mode (Cooling or Heating). For 
example, the room user could switch to HEATING in the winter to avoid COOLING if 
the sun shines into the room. The overwrite can be done from a Sylk-TR42-
Wallmodule or an external WM (Not from a wired wallmodule). With “No HVAC 
overwrite,” the parameter Sylk Wallmodule – Show Item Bits should also be adjusted.
Values:

• 1: No HVAC overwrite

• 2: HVAC overwrite allowed

• Expert Mode: In Expert Mode, more I/O slots and parameters are displayed for 
advanced programmers, providing more functionality.
Values:

• 0: Standard (Default)

• 1: Expert
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Step 7. Expand SylkWallmodule, enter the Show Item Bites and verify the Wm 
Address. .

Fig. 476  Wallmodule Address

• Wm Address: This parameter is used to configure the Sylk Wallmodule address.
Range:

• 0-15 (1 = Default = Factory default from Sylk-TR42-Wallmodule)

• Show Items Bits: Add the bit values of the items you want the operator to see.
Bit-Values:

• 1: Show Room Temperature

• 2: Show Setpoint

• 4: Show the effective occupancy mode

• 8: Show and allow the change of the occupancy overwrite

• 16: Show and allow the change of the effective HVAC mode

• 32: Show the fan stage and allow the change of the fan stage

• 64: Show the humidity

• 128: Show the air quality

• Default: 255 (All Bits true, show all)

Note: The power supply of the controller needs to be AC (20 - 30 VAC). Otherwise, the Humidity and 
Air Quality cannot be measured and shown.

Step 8. Expand the Setpoint and configure the desire setpoint.
Step 9. Expand the SetpointOvrd and configure the desire setpoint overrides.
Step 10. Click Save.
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MODBUS ENGINEERING

PRESS RELEASE Modbus Organization Replaces Master-Slave with Client-Server July 9, 
2020 — The Modbus Organization Board of Trustees announces it is expunging all occur-
rences of inappropriate language of the query and response paradigm of Modbus communi-
cations. With recent events, all companies and individuals with the ability to make positive 
changes should do so. As the holder of the standard for an industrial network with one of the 
largest installed bases in the world, it is important to complete the replacement of the cur-
rent terminology with more thoughtful references. All instances of "master-slave" in the 
organization's literature and on its website will be removed. Current electronic content is 
being updated as of this announcement. Board Chair Todd Snide commented, "The time is 
overdue for these words to be removed. The terms are unnecessary and insensitive to the 
people who experience racism in this country and around the world. We urge our member 
companies and all those who use the Modbus protocol to take similar action to rid their doc-
umentation and communications of these terms." 

The organization is using "client-server" to describe Modbus communications, character-
ized by communication between client device (s), which initiates communication and makes 
requests of server device(s), which process requests and return an appropriate response (or 
error message). About Modbus-Organization, Inc. Headquartered in Massachusetts, the 
Modbus Organization is an association of users and suppliers of control and automation 
devices. The organization works to support the Modbus protocol, provide information and 
tools for individuals and companies using Modbus. It maintains the authoritative website for 
Modbus information. 

Additional information about the Modbus Organization can be found on the organization’s 
website, www.modbus.org. Contact information: Lenore Tracey, Executive Director Modbus 
Organization, Inc. +1 (508) 435-7170 lenore@modbus.org

The controller has a removable 2-wire with shield, non-isolated RS-485 interface that is 
Modbus compatible (terminal 16, 17, and 18). It is installed in a gray terminal block. The 
controller can only act as a Modbus client. 

The RS-485 interface suitable for Modbus communication is 2-wire with shield non-
isolated hence the following considerations apply:

• Maximum Modbus length (“L”): 4000 ft (9.6 – 78.8 kbps) or 2600 ft (115.2 kbps). It 
is recommended that you select a low baud rate (for example, 19.2 kbps) for reliable 
operation.

• Use only shielded, twisted-pair of cables and daisy chain topology.


https://nam12.safelinks.protection.outlook.com/?url=http%3A%2F%2Fwww.modbus.org%2F&data=05%7C01%7CDebanka.Maiti%40Honeywell.com%7Ccd8d5104a7824d53f3ac08da8ca81a2e%7C96ece5269c7d48b08daf8b93c90a5d18%7C0%7C0%7C637976950875822554%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=XJ9JoNZcDus9ZAQRg39zFafmT%2BXK0lfkRysTRj1Yp%2F4%3D&reserved=0

mailto:lenore@modbus.org
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• Ground noise should not exceed the EIA-485 common mode voltage limit.

• Must conform to TIA/EIA 485 cabling guidelines.

• It Should not extend beyond a single building.

The Modbus protocol is described in two documents, both of which can be found at 
www.modbus.org.

• Modbus_over_serial_line_V1_02.pdf

• Modbus_Application_Protocol_V1_1b3.pdf

Table 45   Default Modbus Details

Specification Description

Baudrate 19200

Parity Even parity

Bytesize 8 bit

Stop bits 1 stop bit


https://www.modbus.org/
http://modbus.org/docs/Modbus_over_serial_line_V1_02.pdf
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=&cad=rja&uact=8&ved=2ahUKEwjB0-P4koL2AhVkUN8KHXE-DZIQFnoECAQQAQ&url=https%3A%2F%2Fmodbus.org%2Fdocs%2FModbus_Application_Protocol_V1_1b3.pdf&usg=AOvVaw1JNxTq0cIqrVvMJL2iqA-W
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Addressing and Wiring Rules of Modbus Interface
• Use shielded twisted pair cable J-Y-(St)-Y 4 x 2 x 0.8 and connect the Modbus shield to 

a noise-free earth ground (only once per Modbus network).
Shielding is especially recommended when the Modbus cable is installed in areas with 
expected or actual electromagnetic noise. Avoiding such areas is to be preferred.
You must use three wires:

• One wire for Modbus +

• One wire for Modbus –

• One wire for the signal common

When using one pair for Modbus (+) and Modbus (-) and one wire of another pair for 
the signal common, CAT 5 cable may also be used.

• Maximum 8 Modbus devices, maximum 155 read/write data points total Overloading 
the network will impact the performance.

• Address: Can be from 1 to 247.

Fig. 477  Modbus Device address

Note: Never use the address 0 because it is used by the IRM NX controller exclusively for 
broadcasting Modbus addresses.

• Address must be unique on the Modbus.

• Dip switch setting (when available) must be correct (depending on its physical 
connection) for every Modbus device address.

• Termination and bias must be correct for every Modbus device.

• The wire connections on Modbus devices can be referred to by a different names and 
descriptions. The Modbus terminals are named as follows.

• Transmit Data: TxD, Tx, T+/R+, D1, B

• Receive Data: RxD, Rx, R-/T-, D0, A

• Signal Ground: GND, COMMON

• Terminal A and B are not clearly defined and can vary from one manufacturer to another. 
Verify the correct definition of A and B with the manufacturer of the Modbus device 
before wiring.
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Wiring Topology
Only daisy chain wiring topology is allowed.

Fig. 478   Modbus Wiring Topology

Other wiring topologies (such as star wiring and mixed star wiring) are prohibited. This is to 
avoid communication problems of the physical layer.

Fig. 479  Prohibited Wiring Topology (example)

Preliminary Checks and Configuration
It is recommended that you conduct your investigation and checks in the following order.

1. Get Modbus RTU server device documentation: It is mandatory to have the 
vendor’s documentation of the Modbus functionality for every Modbus device 
that is to be connected to the Modbus device. This will allow obtaining most of 
the required information, but most likely not all of it. Missing information can 
be obtained from the support function of the vendor.

2. Verify usage and activation of the correct Modbus device interface: Modbus 
devices may not have the Modbus interface activated by default. Activation may 
be necessary via software, for example, setting a parameter via the Modbus 
device’s user interface. In addition, activation may be necessary via hardware, 
such as shorting the Modbus device's input. While using any Modbus device, 
verify that you have the correct hardware variant which supports Modbus on 
the RS-485 interface as expected. 

3. Verify RTU Transmission Mode: All Modbus devices must use transmission 
mode RTU. No other transmission mode (for example, ASCII) is supported.
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4. Ensure only one Modbus RTU client is on the bus: Only one Modbus client is 
allowed on the bus, the IRM NX controller. It does not support "Multi-client" or 
"Modbus plus" devices, nor does it support such configurations on the Modbus. 
As per the Modbus standard, the IRM NX controller (as the client device) does 
not have a Modbus address. The IRM NX controller must be added to the 
Bacnet Network.

5. Configure Baud Rate: All Modbus devices must have an identical Baud rate, an 
identical Parity, and an identical number of stop bits. Typically, the Baud rates 
of Modbus devices are set and changed via their user interfaces or their 
separate configuration software.

Fig. 480  Modbus Baud Rate

6. Configure Parity: Modbus devices may have a configurable parity, they will not 
have a configurable number of stop bits. If a Modbus device has an un-
matching number of stop bits, this device cannot be used.

Note: Modbus devices that have implemented "no parity" may have 1 or 2 stop bits.

Fig. 481  Selecting Modbus Parity 

In most cases, select Modbus Parity as “Even.”
7. Configure Stop Bits: If Modbus Parity = “None, " select Modbus Stop Bits = “2”.

Fig. 482  Selecting Modbus Stop Bits
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Adding Modbus Device
Steps to add a Modbus device to the Bacnet Network:

Step 1. Copy a IrmBacnetDevice from honIrmControl palette to the BacnetNetwork.
Step 2. In the Nav tree, expand the IRM Program folder of the controller and double-

click Periodic program.
Step 3. Copy a ModbusDevice from the honIrmControl palette to the periodic program 

wire sheet.

Fig. 483  Adding Modbus Device

If required, you can change the Modbus device name.
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Configure Modbus Device Settings
Steps to configure Modbus Device Settings:

Step 1. Double-click on the Modbus device and check the device settings.

Fig. 484  Modbus Device Settings

• Device Address: Modbus devices have addresses ranging from 1 to 247. Every 
Modbus device must have a unique address. The third-party Modbus devices 
addresses are set and changed through their user interfaces or separate 
configuration software.

• Byte Order: he Modbus standard defines the serial bit order as least significant bit 
first and most significant bit last.

Fig. 485  Byte Order

However, the Modbus standard does not define the byte and word order of 
messages. Hence, Modbus devices will transmit most significant byte first or lower 
significant byte first. For 32-bit values, most significant word first or lower 
significant word first may be implemented.

BigEndian

Int32, 
Uint32, 
Float

Int16, 
Uint16

Single 
Bit

Byte1 Most Significant Byte Byte1 Most Significant Byte Byte1

Byte2 Second most... Byte2 Least Significant Byte

Byte3 Third most...

Byte4 Least Significant Byte
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LittleEndian

LittleEndianWithWordswap

LittleEndianWithWordswap

• Max Read Points Counts: The controller can request a single register from a 
Modbus device and receive a single value in return. In addition, the controller can 
request multiple registers (start register and number of registers) and return 
multiple values in a single response. This method reduces data traffic on the bus, 
resulting in faster communication. 

When the controller recognizes multiple registers with the same operating mode, it 
automatically requests multiple registers in a message. The Modbus device 
manufacturer, on the other hand, has limited the number of registers that can be 
requested with a single message.

In a single message, the IRM can query up to 20 consecutive registers. This 
restriction can be specified in Max Read Points Count.

Fig. 486  Max Read Points Counts

Int32, 
Uint32, 
Float

Int16, 
Uint16

Single 
Bit

Byte1 Least Significant Byte Byte1 Least Significant Byte Byte1

Byte2 Third most... Byte2 Most Significant Byte

Byte3 Second most... Least Significant Byte

Byte4 Most Significant Byte

Int32, 
Uint32, 
Float

Byte1 Second most...

Byte2 Least Significant Byte

Byte3 Most Significant Byte

Byte4 Third most...

Int32, 
Uint32, 
Float

Byte1 Third most...

Byte2 Most Significant Byte

Byte3 Least Significant Byte

Byte4 Second most...
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Step 2. Select the Read Point tab and click on Add.

Fig. 487  Read Point tab

Step 3. Enter the following details in the Modbus Read Point window.

Fig. 488  Modus Read Point Window

• Read Point Name: Enter the read point name.

• Read Point Address: Enter the read point address, the range is 0 to 65535.

Each coil or contact is 1 bit and assigned a data address between 0000 and 9998.

Each register is one word = 16 bits = 2 bytes and has a data address between 0000 
and 9998.

• Read Point Type: This function is used to read Modbus Server Register type

Fig. 489  Read Point Type

• ReadCoil: This function is used to read from 1 to 2000 contiguous status of 
coils in a remote device.

• ReadDiscreteInputs: This function is used to read from 1 to 2000 
contiguous status of discrete inputs in a remote device.

• ReadHoldingRegisters: This function is used to read the contents of a 
contiguous block of holding registers in a remote device.
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• ReadInputRegisters: This function is used to read from 1 to 125 contiguous 
input registers in a remote device.

• ReadMultipleRegister: A single message with the initial address and 
the number of registers can be used to read several registers with 
sequential addresses from a Modbus device. Then, a single message 
with all register contents is transmitted to the bus, and a single 
response is also sent. This lightens the bus's load.
For all registers with the same Read Point Type, the same Operation 
Mode (Poll rate), and consecutive Read Point Addresses, the firmware 
automatically sends just 1 message.

• Operation Mode (Poll Rate): This parameter allows adapting to the communication 
and processing performance of the Modbus device. If the Modbus device does not 
respond fast enough, increase the poll rate.

Fig. 490  Operation Mode

• DoNotRead: Output is NULL.

• Slow: Register is read after multiple of 5 seconds, one register at a time.

• Normal: Register is read after all high priority registers are read, one register 
at a time.

• Fast: Register is read every 50 ms.
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• UserDefined: This allows the user to define polling time.

Fig. 491  Operation Mode Priority

• Scaling Factor: To convert the register value to the required units, apply a scaling 
factor of 10 to it.

Example:

• Read value = 1500. With Scaling Factor -3 the calculated value = 1.5 

• Read value = 1500. With Scaling Factor +2 the calculated value = 150000

• Data Format: Determines the number of consecutive registers written and how the 
value is converted to register values.

Fig. 492  Data Format

SingleBit

Int16: -32768 to 32767

Uint16: 0 to 65535

Int32: -2147483648 to 2147483647

Uint32: 0 to 4294967295

Float: -3.4E+38 to +3.4E+38 (32 Bit)
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• Poll Time (Sec): Allows the user to define the polling time. This is a number between 
60 and 86400.

Fig. 493  Poll Time (Sec)

• Event Bit Masking: 

Fig. 494  Event Bit Masking

If the Event Program reads the Read Point, the value can be masked using the Event 
BitMask. When the masked value changes, the Event Program logic inn wiresheet is 
executed immediately. Masked value means a logical AND with the Modbus value.

Fig. 495  Example for 16 bit value

The Event Program wire sheet logic is executed on a regular basis. Furthermore, it 
can be carried out immediately (event-driven). Such an event can be triggered by a 
Modbus value.

• Masked Occupancy Sensor: When the Occupancy Sensor Bit changes, the 
Event Program wire sheet logic is immediately executed.

• Occupancy Sensor (0xFFFF) none masked: When the Occupancy Sensor or 
the Brightness Sensor changes, the Event Program wire sheet logic is 
executed immediately.

Step 4. Click OK.
Step 5. Select the Write Point tab and click Add.

Fig. 496  Write Point tab
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Step 6. Enter the following details in the Modbus Write Point window.

Fig. 497  Modbus Write Point Property

• Write Point Name: Enter the write point name.

• Write Point Address: The write point address is the data address and not the coil or 
register number of the Modbus device.

• Decimal Range: 0-65535

• Decimal format: 65535

• HEX Range: 0 – FFFF

• Hex format: 0xfff

• Write Point Type: 

Fig. 498  Write Point Type

• WriteSingleCoil: This function is used to write a single output to either ON 
or OFF in a remote device.

• WriteSingleRegister: This function is used to write a single holding register 
in a remote device.

• WriteCoils: This function is used to force each coil in a sequence of coils to 
either ON or OFF in a remote device.

• WriteMultipleResisters: The WriteMultipleRegisters is chosen as the Write 
Point Type. When the registers are set to WriteMultipleRegisters and have 
consecutive Write point Addresses, the firmware automatically transmits 
just one message for the registers.
A single message containing the initial address, the number of registers, and 
the values can be used to write many registers with successive addresses to 
a Modbus device. Then, on the bus, there is only 1 message sent, and there 
is only 1 reply. This reduces the bus's load.



IRM SYSTEM ENGINEERING GUIDE 336

Note: It is possible to select WriteRegister and WriteMultipleRegisters. 

• If WriteMultipleRegisters are selected and the addresses are consecutive, then there will 
be one message. 

• If WriteMultipleRegisters are selected and there are gaps in addresses, then there will be 
multiple messages.

• Data Format: Determines the number of consecutive registers written and how the 
value is converted to register values.

Fig. 499  Data Format

• Significant Change: A significant change for analog values is recommended to 
reduce the bus load. This ensures that values are only sent when the value has 
changed significantly from the value previously sent.

To finish the Modbus configuration, click the save icon  and then click periodic 

or event program in the nav tree.

Fig. 500  Significant Change

SingleBit

Int16: -32768 to 32767

Uint16: 0 to 65535

Int32: -2147483648 to 2147483647

Uint32: 0 to 4294967295

Float: -3.4E+38 to +3.4E+38 (32 Bit)
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Delete Modbus Device
Steps to delete complete Modbus device function block with read and write points 
configured: 

Step 1. Right-click on the Modbus Device > Actions, and select Delete Modbus 
Device. 

Note: The standard delete function is not applicable for deleting the Modbus device.

Fig. 501  Delete Modbus device
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Duplicate Modbus Device
Saving Modbus Block as a Template

When you use the “Duplicate” function in the periodic program and event program wire 
sheets, it copies only the device and not the connected function blocks. Use the “Save As 
Template” function to save a complete Modbus device configuration as a template.

Steps to save Modbus block as a template:

Step 1. Right-click on the Wire Sheet view on the item you want to reuse and select 
Save As Template.

Fig. 502  Save as template 

Step 2. Select location to save the template and click Save.

Fig. 503  File Chooser

The template saved as Modbus palette. The default name will be the name of the identified 
function block. If you want to add or update a function block to an existing modbus 
template. Insert the template into the wire sheet, then click Save As Template, select an 
existing palette file, and then click Append.

Fig. 504  Save As Template
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Open Modbus Template
Steps to open Modbus template:

Step 1. Open Palette and click Browse.

Fig. 505  Open Palette

Step 2. Select the Modbus template file and click Open. This adds Modbus template to 
the palette.

Fig. 506  Modbus Template file

Step 3. Double click on the ModbusDevice in the palette panel.

Fig. 507  Function Blocks

On the wire sheet, select each component, copy the selection and paste it to your target 
wire sheet (for example, periodic program).
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OTHER OPERATIONS

Controller Firmware Download
Before upgrading the controller firmware, check the latest software release bulletin or tech 
tip for the latest firmware for IRM NX controller.

Steps to upgrade the controller:

Step 1. Navigate to IrmBacnetDeviceManager view, select the controllers from the 
database, and click Download Firmware.

Fig. 508   Download Firmware

Step 2. Navigate to the directory where you downloaded the firmware file, select the IRM 
NX controllers firmware file (IRMN4-IMG_Vxxxx.bin), and click Open.

Fig. 509   File Chooser window
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The firmware download process begins as indicated at the top of the firmware 
download progress bar. When the firmware download is complete, a "Success" 
message appears.

Fig. 510   Irm Bacnet Device Manager view

Note: Whenever a new firmware upgrade request is initiated before the provisioning of the previous 
firmware upgrade has been completed, an invalid configuration error is encountered. 
Provisioning time is approximately 10 minutes after upgrading to a new firmware.

Solution: Retry to upgrade the firmware.

Note: The controller may become unreachable if a station or BACnet network is moved from one 
device to another while upgrading firmware on the IRM NX controller.

Solution: Reset, or power cycle the controllers, which have Ref In or Ref Out mapped to 
points to the station or BACnet network.

Important: Values updates after a controller power failure. If a controller has a power failure and the 
device restarts, it takes three to five minutes to update the values in the wiresheet. To 
accelerate the value update on the wiresheet, refresh the wiresheet by navigating to another 
page and returning to the wiresheet.
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Hide Slots 
Steps to hide function block slots:

Step 1. Right-click the function block icon, of which you want to hide slots. 

Step 2. In the context menu, click Pin Slots.

Fig. 511   Context menu
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Step 3. Click the slot you want to hide and click OK.

Fig. 512   Pin slots

The “Temperature” and “Rel Humidity” slots in the functional block figure (A) 
below were selected for hiding. Figure (b) shows the updated view of the 
functional block after performing the hide operation..

Fig. 513   Function block

Note: Any slots that are hidden manually in the Pin Slots dialog are not saved in the controller. The 
hidden slots will be visible again after performing “clearing the project” or “learning the 
application from the controller” operation.
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Bulk Operations

Change Multiple Datapoint Names
While performing a batch operation, such as changing the names of multiple datapoints in 
the same group, it is important to maintain the project's uniqueness.

Steps to change datapoint names in a batch:

Step 1. In the Nav tree, expand the Services folder and double-click on the Program-
Service.

Step 2. Click the Find Objects button. This action opens the Bql Query Builder dialog 
box.

Fig. 514   Bql Query Builder dialog box

Step 3. Click the magnifier icon to search a device. The Choose Root dialog box 
displays.

Fig. 515   Choose Root dialog box
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Step 4. Select the device and click OK.
Step 5. The Bql Query Builder dialog box appears and displays the selected device 

name.

Fig. 516   Bql Query Builder dialog box

Step 6. Select Custom Type from the Of type drop-down list. 

Fig. 517   To select Custom Type

Step 7. Select honIrmControl and Bacnet Boolean Input from the drop-down list.

Fig. 518   Bql Query Builder Dialog Box
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Step 8. .Click OK.

Fig. 519   Bql Query Builder 

The datapoints found are listed on the Batch Editor view.

Fig. 520   Batch Editor view

Step 9. On the Batch Editor view, click the Rename button. 
The rename dialog box displays.

Fig. 521   Rename dialog box

Step 10. In the Replace field, enter the desired name. For example, 'D017' should be 
added as a prefix to the existing datapoint name 'BBI.' 
If desired, select additional options Match case or Match whole word.
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Step 11. Click OK. The replacement results displays in the BatchEditor Results message 
box.

Fig. 522   Batch Editor Resultd message box

Step 12. The datapoint names on the wiresheet are changed accordingly.

Fig. 523   wiresheet

Step 13. Perform a Teach to Controller operation in the application. This action 
implements all the changes in the Bacnet points.
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Create a Backup Controller and Application 
Backup the Station

Steps to backup the station:

Step 1. Navigate to the station name.

Step 2. Right-click the Station node, and select Backup Station.

Fig. 524   Backup Station

While the station continues running, it saves the configuration and creates a backup file 
(.dist). The backup is stored in the user> userName> Niagara4.x > CentraLine > backup. 

Backup the Application
Steps to backup the application:

Step 1. Navigate to My File system in the CentraLine-N4 workbench.

Fig. 525   My File System 
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Step 2. Right-click the file system directory (sys Home, User Home or C:) where you want 
create backup > New > click PaletteFile.palette.

Fig. 526   PaletteFile.palette

Step 3. Enter the Palette name and click OK.

Fig. 527   StationBackup.palette

It adds the backup palette folder in the user local system.

Step 4. Navigate to the workbench Window > Side Bars > and select Palette.
Step 5. Type baja and double click to open baja Palette.

Fig. 528   Open baja Palette
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Step 6. Select the UnrestrictedFolder and copy under the Palette folder. 

Fig. 529   Unrestricted Folder

Step 7. Enter the name of the unrestricted folder and click OK.
The backup folder is created.

Fig. 530   Unrestricted Folder name

Step 8. Navigate to BacnetNetwork, right-click on the controller and click Copy.

Fig. 531   Copy IRM NX controller
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Step 9. Navigate to the backup folder and paste the controller configuration. This saves 
the controller configuration on the user's local system.

Note: Do not alter the controller configuration file after pasting it in the backup folder. Any change 
will damage the file. 

Fig. 532   Controller backup

This controller backup file can be restored on any station.

Steps to Restore the Backup
Steps to Restore the Controller Backup:

Step 1. Open the Palette and click browse using a file chooser. 

Step 2. Locate the backup file in the user's local system and open the file.

Fig. 533   File Chooser dialog box
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Step 3. Controller backup file in the Palette window. 

Fig. 534   Palette window

Step 4. Copy backup palette file under the new BacnetNetwork.

Reset to Factory Default
Steps to reset the controller to factory default settings:

Step 1. Power off the controller.

Step 2. Power on the device while holding the service pin button pressed.
Wait for 10-15 seconds until the communication LEDs (Rx & Tx) blinks.

Step 3. Release the service pin button.

After the factory reset, following changes occur in the controller.

• The entire configuration of the application clears from the controller.

• The controller will search for a new mac address. Auto MAC will be triggered once the 
controller receives the “you are” command.
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PRE-ENGINEERED TEMPLATES 
AND BALANCING

Templates
A template is a deployable package of Niagara objects. A template's purpose is to allow a 
group of configured objects to be encapsulated and deployed as a unit. The goal is to 
eliminate repetitive configuration steps when performing multiple installations with 
similar functionality.

Templates include a component tree with a single base component and associated support 
objects. A template is contained in a file with the.ntpl file extension. For ease of distribution, 
template files can be grouped into modules. In addition, one or more instances of a 
template may be deployed to a station.

IP/ MSTP VAV Template
The IP/MSTP VAV controllers supports the Global VAV template. The template contains an 
embedded group of configured objects that are deployed with the global VAV template.
The Global VAV template package includes two templates.
• VAV_ISF1_HX_FX_IM.ntpl
• VAV_ISF1_HX_FX_SI.ntpl 
For more information on the Global VAV template features and configuration, refer the 
Global VAV Template Design Guide - 31-00466 and Global VAV Template Engineering 
Guide - 31-00465 documentation.
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Balancing
The VAV balancing is supported by the IRM NX VAV controllers. 

The time spent starting and balancing each VAV box individually and waiting for them to 
reach the airflow setpoint is saved by balancing the controllers and calculating the flow 
calibration factors for the correspondence VAV boxes.

You can use a global balancing tool to balance setpoints, perform max-min balancing, and 
move dampers on multiple controllers.

Global Balancing Points
Following are the balancing points available in the global balancing point.

Table 46  Global Balancing Point Description

 Object 
mapping 

Object 
Name

Object 
ID

R, W, 
R/W 

Engineering 
Units

Range, States, 
etc Description

Device 
Balance 
State

600 R 0 = Not balanced 
(default)
1 = Setpoint/
Min-Max 
balanced
2 = Max balanced
3 = Min balanced

Modified by balance tool 
to indicate balance state.

Flow 
Calibration 
Factor

601 R/W Unitless 0…<+inf
0.813 (default)

Firmware balancing point. 

Damper 
Type 

602 R 0 = Floating 
(default)
1 = 0-10v,
2 = 2-10v

Modified by balance tool. 
Not currently 
implemented.

Damper 
Control 
Type

603 R/W 0 = CW (Direct) 
(default)
1 = CCW 
(Reverse)

Allows damper direction 
configuration through 
balancing tools.

Drive Time 604 R/W second 90 s (default) for 
60 hertz 
frequency
108 sec for 50 
hertz frequency

Allows damper drive time 
configuration through 
balancing tools.

CfgDuctAr
ea

Duct Area 606 R/W square feet,
square meter

0…<+inf Allows duct area 
configuration through 
balancing tools.

BalMaxM
easFlowA
ct

Measured 
Max Flow

607 R/W cfm, cmh, l/s 0…<+inf Balancing tools write field 
measured max flow to this 
point during balancing.

BalMinMe
asFlowAct

Measured 
Min Flow

608 R/W cfm, cmh, l/s 0…<+inf Balancing tools write field 
measured min flow to this 
point during balancing.
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CfgMaxFl
owSetpt

Set Point 
Max Flow

609 R/W cfm, cmh, l/s 0…<+inf Cooling max flow setpoint.

CfgMinFl
owSetpt

Set Point 
Min Flow

610 R/W cfm, cmh, l/s 0…<+inf Cooling min flow setpoint.

Device 
Zeroed 
State

611 R 0 = Not Zeroed 
(default)
1 = Zeroed

Modified by balance tool 
to indicate zeroed state.

Temperatu
re 
Compensa
tion

612 R N/A N/A Not currently 
implemented.

Balancing 
Method

613 R 0 = Double point 
(default)
1 = Single point 

Modified by balance tool 
to indicate balance 
method used.

Set Point 
Single 
Flow

614 R cfm,cmh, l/s 0…<+inf Firmware balancing point.

Measured 
Single 
Flow

615 R cfm,cmh, l/s 0…<+inf Firmware balancing point.

Corrected 
K Factor

616 R Unitless 0…<+inf Firmware balancing point.

Current 
Sensed Air 
Flow

618 R cfm,cmh, l/s 0…<+inf Firmware balancing point.

Damper 
Manual 
Position

620 R % 0…100
0 (default)

Firmware balancing point.

Damper 
Manual 
Flow

621 R cfm,cmh, l/s 0…<+inf
0 (default)

Firmware balancing point.

Table 46  Global Balancing Point Description (Continued)

 Object 
mapping 

Object 
Name

Object 
ID

R, W, 
R/W 

Engineering 
Units

Range, States, 
etc Description
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Balancing 
Type

622 R 0 = Auto mode. 
VAV operating in 
normal state
2 = Balance Max. 
Damper 
commanded to 
achieve max flow 
setpoint.
3 = Balance Min. 
Damper 
commanded to 
achieve min flow 
setpoint.
4 = Balance 
Single point. 
Device is in 
setpoint / K-
factor mode.
5 = Manual 
Position. Damper 
is overridden to 
specified 
position.
6 = Manual Flow. 
Device is 
commanded to 
achieve specified 
flow.
15 = Balance 
Zero. Not 
currently 
implemented.

Modified by balance tool 
to indicate balance 
process used.

Damper 
Position

623 R % 0…100, null Firmware balancing point.

Clear 
Balance

624 R 0 = False 
(default)
1 = True 

Firmware balancing point.

BalMaxM
easFlowS
pt

Sensed 
Max Flow

626 R cfm,cmh, l/s 0…<+inf
0 (default)

Controller sensed airflow 
during two-point 
maximum calibration.

BalMinMe
asFlowSpt

Sensed 
Min Flow

627 R cfm,cmh, l/s 0…<+inf
0 (default)

Controller sensed airflow 
during two-point 
minimum calibration.

Sensed 
Single 
Flow

629 R cfm,cmh, l/s 0…<+inf
0 (default)

Firmware balancing point.

Table 46  Global Balancing Point Description (Continued)
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Units

Range, States, 
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Setpoint 
Tolerance

630 R cfm,cmh, l/s 0…<+inf
0 (default)

Firmware balancing point.

Sync 
Direction 

631 R 0 = Close 
(default)
1 = Open 

Firmware balancing point.

Zero 
Process 
Status

632 R 0 = False 
(default)
1 = True

Firmware balancing point.

Sync 
Status

633 R 0 = False 
(default)
1 = True

Firmware balancing point.

Action 
Elapsed 
Time

634 R second 0…<+inf Firmware balancing point.

CfgKFact
or

Manufactu
rer K 
Factor 

635 R/W cfm, cmh, l/s 0…<+inf Manufactured defined K-
factor for VAV must be 
assigned by programmer 
prior to balancing.

BalKFacto
rOffset

K Factor 
Offset 

636 R/W cfm, cmh, l/s > - inf…<+inf
0 (default)

Offset applied by 
balancing tool during K-
factor calibration mode.

BalBoxZer
oOffset

Pressure 
Offset 

637 R/W In WC, pascal 0…<+inf
0 (default)

Offset applied by 
balancing tool during zero 
calibration mode.

OvrRehea
tPos 

Reheat 
Ovrd 

638 R/W % 0…100
null (default)

Balancing tool can 
override reheat through 
this point.

Reheat Eff 
Pos

639 R/W % 0…100
null (default)

Firmware balancing point.

OvrPeriph
Pos

Periphheat 
Ovrd

640 R/W % 0…100
null (default)

Balancing tool can 
override peripheral heat 
through this point.

Periphheat 
Eff Pos

641 R/W % 0…100
null (default)

Firmware balancing point.

VAV Fan 
Spd Ovrd 

642 R/W % 0…100
null (default)

Balancing tool can 
override VAV fan speed 
through this point.

Table 46  Global Balancing Point Description (Continued)
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VAV Sys 
Type

643 R 0…7 
Bit0 = Reheat
Bit1 = Peripheral 
heat
Bit2 = Fan

0 = Hide reheat, 
peripheral heat 
and vav fan 
option
1 = Show reheat 
option only
2 = Show 
peripheral heat 
option only
3 = Show reheat 
and peripheral 
heat option only
4 = Show vav Fan 
option only
5 = Show reheat 
and vav Fan 
option only
6 = Show 
peripheral heat 
and vav fan 
option only
7 = Show reheat, 
peripheral heat 
and vav fan 
option

Firmware balancing point.

Table 46  Global Balancing Point Description (Continued)
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Flow Balancing View
A Variable Air Volume (VAV) system allows a single unit to provide the appropriate amount 
of cooling to multiple zones with different cooling loads. The VAV regulates the air volume 
to the zone by opening or closing the damper. This damper is controlled by a floating motor 
installed on an integrated actuator of the IRM NX VAV controller.

The Flow balancing tool can be configured with various parameters and indicators to 
optimize the calibrations used to balance the airflow.

Important: It is recommended to use Global VAV Balancing Tool or Honeywell Connect Mobile VAV 
Balancing application to perform calibration and balancing for the IP VAV controllers. 

Prerequisites 
• The controller must be online.

• The controller must be in a commissioned and synchronous state.

• Configure the following “Application Details Config” features under control manager in 
the engineering tool.

Fig. 535  Application Details Config

• To work with flow balancer view, the user must configure the Bacnet objects according 
to the parameters listed in the table below, such as specific point name, object ID, point 
type, and respective units in the application. For details about Bacnet objects, see Flow 
Balancing View on page 361.

Application Type  Select VAV Zone Terminal Single Duct Application.

Application Feature

• Air balance supported is mandatory and other features as 
programmed in the application.

• Reheat valve override supported option to calibrate the 
reheat valve.

• Peripheral heat valve override supported option to 
calibrate the peripheral heat valve.
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Following are the balancing points available in the Flow balancing tool.

Table 47  Bacnet objects for Flow balance tool

Point Name Point Type Object ID Metric Unit Imperial Unit

CfgKFactor Analog value 1000 Liter per 
second Cubic feet per minute

CfgDuctArea Analog value 1001 Sq meter Square foot

CfgMaxFlowSetpt Analog value 1002 Liter per 
second Cubic feet per minute

CfgMinFlowSetpt Analog value 1003 Liter per 
second Cubic feet per minute

BalKFactorOffset Analog value 1004 Pascal Inches of WC

BalKFactorOffset Analog value 1005 Liter per 
second Cubic feet per minute

BalMaxMeasFlowAct Analog value 1006 Liter per 
second Cubic feet per minute

BalMaxMeasFlowSpt Analog value 1007 Liter per 
second Cubic feet per minute

BalMinMeasFlowAct Analog value 1008 Liter per 
second Cubic feet per minute

BalMinMeasFlowSpt Analog value 1009 Liter per 
second Cubic feet per minute

FlowOvrdState Analog value 1010 No unit No Unit

FlowOvrdPct Analog value 1011 Percentage Percentage

FlowOvrdFlow Analog value 1012 Liter per 
second Cubic feet per minute

BoxFlow Analog value 1013 Liter per 
second Cubic feet per minute

VelSenPress Analog value 1014 Pascal Inches of WC

DamperPos Analog value 1015 Percentage Percentage
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Note: The configuration must be completed before downloading the program to the controller.

Fig. 536  Flow Balancing View

Bacnet objects details and requirement for Air flow balancing 
 The user must configure the Bacnet objects in the application using the parameters listed 
in the Table 47, “Bacnet objects for Flow balance tool,” on page 360. 

• CfgKFactor: This data point is used to set a factory k factor value in the balancing 
tool. Currently, the tool expects a value greater than equal to 10.

• BalKFactorOffset: This data point will be set with the K Factor value sent from the 
balancing tool. After performing k factor balancing, the balancing tool will set the 
calculated k factor. 

The balancing tool makes sure that the calculated K Factor value is equal to 
CfgKFactor plus BalKFactorOffset.

• BalBoxZeroOffset: The balancing tool will set this value after performing zero 
calibration.

• CfgDuctArea: The user will set this value based on the VAV controller.

• CfgMaxFlowSetpt: The user will set the maximum flow setpoint value in the 
balancing tool. The same value will be used in the application.

• CfgMinFlowSetpt: The user will set the minimum flow setpoint value in the 
balancing tool. The same value will be used in the application.

• BalMaxMeasFlowAct: The balance maximum flow actual value will be set by the 
user in the balancing tool. The maximum flow balancing the actual measured flow 
will be set to this data point. This data point is used in a 2-point balancing ratio 
block.

If the VAV controller is k factor balanced, the balancing tool will set the maximum 
flow setpoint to this data point.
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• BalMaxMeasFlowSpt: The maximum flow setpoint value will be set by the user in 
the balancing tool. The same value will be used in an application in a 2-point 
balancing ratio block.

• BalMinMeasFlowAct: The balance minimum flow actual value will be set by the user 
in the balancing tool. When doing, the minimum flow balancing the actual 
measured flow will be set to this data point. This data point is used in a 2-point 
balancing ratio block.

If the VAV controller is K Factor balanced, the balancing tool will set the minimum 
flow setpoint to this data point.

• FlowOvrdState:

Max balancing flow override state is 7.

• The effective flow setpoint will be set to the maximum flow setpoint in the 
application, and the controller will ramp up its output and the damper will 
open until the sensed flow equals the flow setpoint.

• When the measured flow reaches the effective flow setpoint (abs 
(CfgMaxFlowSetpt – BoxFlow) < = (CfgMaxFlowSetpt * 0.05)) for at least 5 
seconds, the balancer enters the measured flow and the same value is 
assigned to data point BalMinMeasFlowAct.

Min balancing flow override state is 6.

• The effective flow setpoint will be set to the minimum flow setpoint in the 
application, and the controller will ramp down its output and the damper will 
close until the sensed flow equals the flow setpoint.

• When the measured flow reaches the effective flow setpoint (abs 
(CfgMaxFlowSetpt – BoxFlow) = (CfgMaxFlowSetpt * 0.05)) The balancer will 
enter the measured flow for at least 5 seconds, and the same value will be set 
to data point BalMinMeasFlowAct.

Zero balancing flow override state is 5

• In the application, the effective flow setpoint will be set to 0, and the 
controller's output will be ramped down and the damper closed until the 
sensed flow equals the flow setpoint.

• When the flow reaches the effective flow setpoint, the balancing tool 
calculates the offset pressure and assigns it to a data point. 
BalBoxZeroOffset.

K Factor balancing flow override state is 7

• The effective flow setpoint will be set to the maximum flow setpoint in the 
application, and the controller will ramp up its output and the damper will 
open until the sensed flow equals the flow setpoint.

• When the measured flow reaches the effective flow setpoint, the balancing 
tool calculates the offset k factor and assigns it to data point 
BalKFactorOffset.
KFactorNew = Flow Measured / (VelSenPress)

Mode to Auto flow override state is 0

• When the mode is set to Auto in the balancing view, the application is set to 
auto mode).
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Note: If the measured airflow does not reach the effective airflow setpoint within the set actuator 
travel time, verify the K Factor value and the flow control loop.

Important: Before migrating the existing controller application to the current application, the user must 
configure proper units for CfgKfactor, BalBoxZeroOffset, and BalKFactorOffset data points 
based on the measurement type (earlier, these points did not have any units).

• FlowOvrdPct: When the application sets the datapoint FlowOvrdState to 3, the 
damper is overridden to FlowOvrdPct. This is not a required data point for balancing.

• FlowOvrdFlow: When the application sets the datapoint FlowOvrdState to 2, the 
effective flow setpoint is set to FlowOvrdFlow, and the controller ramps its output to 
reach the effective flow setpoint. This is not a necessary data point for balancing.

• BoxFlow: This data point determines whether or not the flow has been attained while 
balancing. This is used in the balancing sensed flow.

• VelSenPress: This data point is used in the balancing flow pressure.

• DamperPos: This data point is used in the balancing damper position.

Flow velocity function block.

Flow calculation with metric and imperial unit.

The below metric units are calculated from VAV controller specification in imperial 
units.

• Inlet area: 1.2 sq ft = > 0.1115 sq meters

• Maximum Flow Setpoint: 1400 cfm = > 2379 m3/h

• Minimum Flow Setpoint: 700 cfm = > 1189 m3/h

• K Factor: 1400 cfm @ 1” wc = > 2379 @ 249 pa

Table 48  Pressure value in Imperial and Metric unit

Pressure Imperial Metric Unit

inch wc K Factor: 1400 cfm @ 1” wc
Area: 1.20 sq feet

K Factor: 2379 m3/h @ 249 pa
Area: 0.11 sq meter

1 Flow: 1400 cfm Flow: 2379 m3/h

2 Flow: 1979.70 cfm Flow: 3364.41 m3/h

0.25 Flow: 700 cfm Flow: 1189.5 m3/h

1.45 Flow: 1685.82 cfm Flow: 2864.70 m3/h

0.12 Flow: 484.97 cfm Flow: 824.11 m3/h
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Configuring Flow Balance Parameters
Steps configure Flow Balance Parameters:

Note: Before you start operating the flow balancer tool, you must configure the object names with 
specific object ID, object type, and respective units in the application to operate in the flow 
balancer view, see Table 47, “Bacnet objects for Flow balance tool,” on page 360.

Step 1. In the Nav tree, browse to Station > Config > Drivers> BacnetNetwork > IrmB-
acnetDevice > IRM Program > Control Manager.

Step 2. Double-click on Control Manager and configure Application Details Config. 
Step 3. Navigate to the Application Type as VAV Zone Terminal Single Duct 

Application from the drop-down list.
Step 4. Navigate to the Application Features as air balancing supported. If you want to 

calibrate the reheat and peripheral heat valves, select reheat valve override 
supported and peripheral heat valve override supported options.

Fig. 537  Application Details Config

Step 5. Navigate to the Measurement Type and select Metric or Imperial. 
The object unit must be compatible with the global measure type. If not, it will 
throw an error when you run the Flow balancer view.
When the configuration is finished, the tool is integrated into the application. 
The Flow Balancer View recognizes and validates the VAV application's 
configured data points. The Flow Balancer View uses the values from the 
configured data points to perform the balancing.

Step 6. Right-click IrmBacnetDevice and select Views > Flow Balancing View. The Flow 
Balancing View appears on the right pane.

Fig. 538  Flow Balancing View
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If the configured object ID, object type, and respective units in the application do not 
match, the Flow balancer tool identifies and generates errors. 

The application validates in five stages:

Flow Balance Operations
The following type of balancing you can be performed on the Flow balancer View.

• Zero Flow Balance Calibration on page 365

• K Factor Calibration on page 366

• Two Point Calibration on page 366

• Set Mode to Auto on page 366

• Restore to Factory Defaults on page 366

Fig. 539  Flow Balancing Actions

Zero Flow Balance Calibration
To start zero balancing, click on Start Zero Balancing.

The damper is completely closed. If any flow pressure is detected, that value is considered 
to be the flow pressure offset. After the completion of zero balancing the device, the mode 
is set to automatic operation.

Stage 1: Validates if the device supports balancing or not.

Stage 2: Validates if the device is online or offline.

Stage 3: Validates if the device is VAV application supported or not.

Stage 4: Validates if the device is commissioned or not.

Stage 5:

Validates if the object rules are correctly configured or not.

• Checks configured objects with object names.

• Checks configured objects name with object Ids.

• Checks configured objects names with object type.

• Checks configured object Ids with the object unit.
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Two Point Calibration
You can start maximum balancing in any order. The flow balance tool does not enforce any 
rules on the order of balancing.

• Maximum balancing: To start maximum balancing, click on Start Maximum 
Balancing.

The controller adjusts the damper in an attempt to achieve the maximum flow setpoint. 
When the setpoint is reached, the measured flow field becomes active, and the actual 
measured flow value can be entered. After completing maximum balancing, the device 
remains in manual mode (open maximum).
You can start minimum balancing in any order. The flow balance tool does not enforce 
any rules on the order of balancing.

• Minimum balancing: To start minimum balancing, click on Start Minimum Balancing.
The controller adjusts the damper in an attempt to achieve the minimum flow setpoint. 
When the set point is reached, the measured flow field becomes active, and the actual 
measured flow value can be entered. After minimum balancing is completed, the device 
remains in manual mode (open minimum).

K Factor Calibration
To start the K factor calibration method > click on Start K Factor Balancing.

Important: After a warning message, the minimum point calibration and maximum point calibration data 
is reset to factory defaults. 

The controller adjusts the damper in an attempt to achieve the maximum flow setpoint. 
When the setpoint is reached, the measured flow field becomes active, and the actual 
measured flow value can be entered.

The tool calculates and displays the K factor value after entering the measured flow. The 
tool prompts you to save this value to the device. You can calculate the K factor without 
using the tool and enter the calculated value in the K factor field. After K factor balancing is 
completed, the device remains in manual mode (open maximum).

Set Mode to Auto
When the device is enabled, click Set mode to auto to enable automatic operation. If the 
device is in manual mode when you exit the view, the tool prompts you to switch to 
automatic mode.

Restore to Factory Defaults
To restore the factory default value of the zero calibration, K factor calibration, minimum 
flow calibration, and maximum flow calibration values, click the Restore to factory 
defaults.
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Flow Balancing Parameters

Fig. 540  Flow Balancing Parameters

• Actuator Travel Time: The time required for the actuator to travel from 0 % to 100 % 
open or 100 % to 0 % open.The time interval varies depending on the type of actuator 
and ranges from 0 to 500 seconds.

• K Factor: Allows you to change the K Factor value from 0 to 10000 manually.

• Inlet Area: The area of the inlet duct is displayed. In this field, you can choose between 
a standard diameter and a custom area. The inlet area can range from 0 to 100 square 
feet.

• Measured Flow: Displays the actual airflow when measured by the balancer using an air 
flow hood or other T&B calibrated tool. This value can be edited.

• Maximum Flow Setpoint: This field allows you to set the flow setpoint for maximum flow 
calibration and K Factor calibration from 0 to 138850 cfm. When you set the calibration 
source value, the controller begins to stabilize the airflow.

• Minimum Flow Setpoint: This field allows you to specify the flow setpoint value, which 
ranges from 0 to 138850 cfm. To obtain minimum flow calibration, set the minimum 
flow setpoint lower than the maximum flow setpoint value. When you set the calibration 
source value, the controller begins to stabilize the airflow.

Valve Override

Fig. 541  Valve Override
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• Re-heat Valve Override: This field allows you to override the value of the reheat valve. 
This field visible when the “Reheat Valve Override Supported” feature is enabled in the 
“Application Details Config” under control manager. 

Fig. 542  Reheat Valve Override Supported

Steps to override the reheat valve position:

Step 1. Type the reheat value in percentage and click the Override.

Note: Click the auto button to set the reheat heat valve into automatic operation.

• Peripheral Heat Valve Override:  This field allows you to override the value of the 
peripheral heat valve. This field is visible when the “Peripheral Heat Valve Override 
Supported” feature is enabled in the “Application Details Config” under control 
manager.

Fig. 543  Peripheral Heat Valve Override Supported

Steps to override the peripheral heat valve position:

Step 1. Type the peripheral heat value in percentage and click the Override.

Note: Click the auto button to set the peripheral heat valve into automatic operation.

Flow Balancing Status

Fig. 544  Flow Balancing Status

• Device Mode: Displays the current device mode. 

• Damper Position: Displays the current damper position.

• Sensed Flow: Displays the actual airflow as measured by a pressure sensor.

• Flow Pressure: Displays the current flow pressure. 
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Venom Application Balancing
When the Venom balancing view is first opened, this service is automatically added to the 
station. The service is transient by default, which means that its properties are not saved to 
the station BOG file and it will not be present after a station restart. If changes to the ser-
vice's properties are made and need to be retained after restarting, the slot sheet view of 
the Services container can be used to clear the VenomBalanceService's Transient flag..

The service includes the following properties:

• Damper Full Open: True (default) = the zero calibration job will command half of the 
devices to ‘Damper 100 %’. 
False = the zero calibration job will command half of the devices to ‘Max Flow’.

• Auto Update Database: True (default) = a ‘Sync Device to Wiresheet’ will be performed 
on a IrmBacnetDevice or an ‘Upload’ will be performed on a device on successful 
completion of flow balancing. 
False = no sync or upload will occur automatically.

• Flow Cal Poll Interval: (default 5 seconds) During flow balancing, the device damper 
position and velocity pressure will be sampled at this rate. If the damper drive time is 
very slow and the calibration view drops out of its wait state too early, increasing this 
value may allow correct operation.

• Network View Device Refresh Interval: (default 5 minutes) While the Venom Balance 
Network View is active, devices values will be polled at this interval. This will detect any 
changes to device variables that occurred from a source other than the Venom tools.

• Poll Delay Between Devices: (default 100 milliseconds) This is a wait time that occurs 
between polling one device’s variables and the next. This value can be increased if more 
time is needed for other station polling to occur (i.e. proxy points), however the Venom 
Balance Network View will take longer to populate the device values.
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Global Balancing Object
The global balancing object is a part of the engineering tool. It allows you to configure the 
balancing object as per the project requirement and generates the balancing data report of 
the controller. Following are available Global Balancing Object points.

Fig. 545  Global Balancing Object property sheet
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The balancing report can be generated using the online controller or wire sheet values.

• Online Controller Values: Reads the values from the online controller only.

• Wire Sheet Values: Read the wire sheet values mapped to the online and offline 
controller.

You can perform the following operation in the Global Balancing Object:

• Map the Balancing objects with Bacnet Objects on page 371

• Teach Balancing Values to Controller on page 373

• Learn Balancing Object from Controller on page 373

• Generating Balancing Report on page 375

• Global Balancing Application Sync on page 377

Map the Balancing objects with Bacnet Objects
Steps to map the balancing objects with Bacnet objects:

Step 1. Click the Folder icon ( ) and select Component Chooser from the drop-down 
list.

Fig. 546  Component Chooser

Step 2. On the Select Ord window, navigate to the Drivers > BacnetNetwork > 
IrmBacnetDevice > IRM Program > Periodic program> select the Bacnet 
Object and click OK.
This action map the Bacnet object with the balancing object.
Or
Navigate to the Station > Drivers > BacnetNetwork > IrmBacnetDevice > IRM 
Program > Periodic program> select the Bacnet Object and press Ctrl + C.
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Navigate to the balancing object and press Ctrl + V in the Object Mapping field.

Fig. 547  Object Mapping

Step 5. Click Save. 

Step 6. Click the arrow icon ( ). This opens the Bacnet objects property sheet.

Fig. 548  Bacnet Objects property sheet

Step 7. Expand Default Value, enter the Default Value, and click Save.

To send the modified balancing object values from the workbench to controller, perform 
Teach Balancing Values To Controller. See Teach Balancing Values to Controller on page 
373.

Similarly, to bring the updated balancing object values from the controller to the 
workbench, perform Learn Balancing Object From Controller. See Learn Balancing Object 
from Controller on page 373.

You can also generate the report. For more details, see Generating Balancing Report on 
page 375.
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Teach Balancing Values to Controller
Teach Balancing Values To Controller: This allows the commission engineer to send the 
modified balancing values from the workbench to the IRM NX controller.

Note: Set the desired measurement type before configuring the Global VAV Balancing Tool.

Steps to teach balancing values to controller:

Step 1. Navigate to the BacnetNetwork > IrmBacnetDevice > IRM Program > Control 
Manager > double-click Global Balancing Object. This opens the global bal-
ancing object property sheet.

Step 2. Right-click the Global Balancing Object > Actions> Teach Balancing Object To 
Controller.

Fig. 549  Teach Balancing Object To Controller

Teach Balancing Values to Multiple Controllers
Steps to teach balancing values to multiple controllers:

Step 1. Right-click on the BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the controllers from the device list.
Step 3. Select Teach Balancing Object.

Fig. 550  Teach Balancing Object Option

Step 4. Click Yes.

Fig. 551  Popup Message Window

The Balancing value changes are updated in the controller, and the successful action is 
displayed in the workbench job service.

Learn Balancing Object from Controller
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Learn Balancing Object From Controller: This allows the commissioning engineer to bring 
the modified balancing values from the IRM NX controller to the workbench. 

Steps to learn balancing object from controller:

Step 1. Navigate to the BacnetNetwork > IrmBacnetDevice > IRM Program > Control 
Manager > double-click Global Balancing Object. 

Step 2. Right-click the Global Balancing Object > Actions> Learn Balancing Object 
From Controller.

Fig. 552  Learn Balancing Object From Controller

Note: Make sure to map the balancing components with the BACnet objects points correctly 
(BacnetNumericValue, BacnetBooleanValue, or BacnetEnumValue).

Fig. 553  Mapping The Balancing Objects

Note: The balancing objects do not support the input and output points.

Learn Balancing Values from Multiple Controllers
Steps to learn balancing values from multiple controllers:

Step 1. Right-click on the BacnetNetwork > Views > Irm Bacnet Device Manager view.

Step 2. Select all the controllers from the database.
Step 3. Select Learn Balancing Object.

Fig. 554  Learn Balancing Object to Controller dialog box
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Step 4. Click Yes.

Fig. 555  Popup message window

The Balancing values uploaded into the project and the successful action displayed in the 
workbench job service.

Generating Balancing Report
You can generate the balancing data report for the set of controllers by using the online 
controller values or the wire sheet values.

• Online Controller Values: Reads the values from the online controller only.

• Wiresheet Values: Reads the wire sheet values linked to the online and offline controller. 

Generating Balancing Report for Multiple Devices
Steps to generate a balancing report for a set of devices:

Step 1. Navigate to the Irm Bacnet Device Manager view and select the devices.

Step 2. Select Generate Balancing Report. This opens the generating balancing report 
dialog box.

Fig. 556  Generating Balancing Report dialog box

Step 3. Select From Online Controller Values or From Wiresheet Values.

Fig. 557  Generating Balancing Report

Step 4. Click OK.
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Generating Balancing Report from the Station
Steps to generate balancing report from the station:

Step 1. Navigate to the BacnetNetwork.

Step 2. Select IrmConfig, right-click the Actions > Generate Balancing Report.

Fig. 558  Actions

Step 3. Select From Online Controller Values or From Wiresheet Values.

Fig. 559  Generating Balancing Report

Step 4. Click OK.

The report is saved in the shared directory (C:\Users\User 
account\Niagara4.x\CentraLine\stations\”current station 
name”\shared\BalancingReports). Go to the BalancingReports inside the shared folder 
and open the Balancing Report CSV file.

Fig. 560  Balancing Report CSV file

File Format: Stationname_Balancing report_unique number

Fig. 561  File Format
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Global Balancing Application Sync
Steps to Sync Global Balancing Application:

Step 1. Expand the station and double-click Drivers.

Step 2. Navigate to the BacnetNetwork > IrmBacnetDevice > IRM Program > Control 
Manager > double-click Global Balancing Object. This opens the global 
balancing object property sheet. 

Fig. 562  Global Balancing Application

Step 3. Click Save to apply the changes. 

Map the balancing objects with the BACnet Objects points (BacnetNumericValue).
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Post Balancing Procedure
The Post balancing procedure is performed to sync the updated balanced data from the 
project to the controller.

You can perform the post balancing procedure for the following device conditions: 

• Empty or Factory device balancing on page 378

• Project Balancing State (In Sync) on page 378

• Project Balancing State (Project with modifications) on page 379

Empty or Factory device balancing
Steps to perform the post balancing for the Empty or Factory device:

Step 1. Perform the balancing procedure for the controller. The controller can be bal-
anced using Honeywell Connect Mobile Application or Global VAV Balancing 
Tool. For more details, see Honeywell VAV Balancing Tools User Guide EN2Z-
1086-IE67.

After performing the balancing, the balanced data will be saved in the Bacnet 
object.

Step 2. Perform the Bacnet object mapping procedure to bring the balanced values 
from the controller to the wire sheet. For more details, see Map the Balancing 
objects with Bacnet Objects on page 371. 

Important: If you perform the Teach balancing to the controller procedure before syncing the balanced 
data to the project will erase the balanced data of the controller.

Step 3. Perform the Learn Balancing Object From Controller procedure to sync the 
balanced values from the controller to the workbench. For more details, see 
Learn Balancing Object from Controller on page 373.

Step 4. Perform the Teach Full Application To Controller procedure to update the new 
configuration of the project to the controller. For more details, see Teach Full 
Application To Controller on page 174.

Project Balancing State (In Sync)
Application is already taught and controller and project status is “In Sync.”

Steps to perform the post balancing for the device application is already taught:

Step 1. Perform the balancing procedure for the controller. The controller can be bal-
anced using Honeywell Connect Mobile Application or Global VAV Balancing 
Tool. For more details, see Honeywell VAV Balancing Tools User Guide EN2Z-
1086-IE67.

After performing the balancing, the balanced data will be saved in the Bacnet 
object.

Step 2. Perform the “sync to application” operation using Honeywell Connect Mobile 
Application or Global VAV Balancing Tool to update the balanced values in the 
application Bacnet object.
After performing the “sync to application” operation, the synchronization status 
will be changed to “controller Bacnet object modified.”

Step 3. Perform the Learn From Controller procedure to sync the controller and project 
with the updated balanced values. For more details, see Learn from Controller 
on page 177.
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After performing the Learn from Controller procedure, the synchronization 
status will be changed to “In Sync.”

Step 4. Perform the Learn Balancing Object from Controller to updated balancing 
object values in the engineering tool. For more details, refer to Learn Balancing 
Object from Controller on page 373.

Project Balancing State (Project with modifications)
Application is already taught and controller and project status is “Project has 
modifications”

Steps to perform the post balancing for the device application is already taught:

Step 1. Perform the balancing procedure for the controller. The controller can be bal-
anced using Honeywell Connect Mobile Application or Global VAV Balancing 
Tool. For more details, see Honeywell VAV Balancing Tools User Guide EN2Z-
1086-IE67.

After performing the balancing, the balanced data will be saved in the Bacnet 
object.

Step 2. If you perform the “sync to application” operation, the synchronization status 
will be changed to “Project modified and controller bacnet object.”
If the ‘sync to application” operation is not performed (no sync), the 
synchronization status will remain as “Project has modifications.”

Step 3. Perform the Learn Balancing Object From Controller procedure to update the 
balanced data from the controller to the wire sheet. For more details, see Learn 
Balancing Object from Controller on page 373.

Important: Any changes in the Bacnet objects mapped to balancing will be overwritten by the values from 
the controller. 

Step 4. Perform the Teach Full Application To Controller procedure to update the new 
configuration of the project to the controller. For more details, see Teach Full 
Application To Controller on page 174.
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Using Application Library
Steps of use application library:

Step 1. Open the CentraLine-N4 workbench. 

Step 2. Navigate to the platform and connect to the station.
Step 3. Open the Palette and click the Open Palette icon.
Step 4. In the open palette dialog box, enter “honIrmAppl” and click OK.

Fig. 563  Open Palette window

Step 5. In the Palette view, expand the honIrmAppl folder.

Fig. 564  honIrmAppl Folder

Step 6. Right-click IRM Program and select Copy from the context menu.

Fig. 565  IRM Program

Step 7. Expand the IrmBacnetDevice, navigate to the IRM Program, and click Delete 
from the context menu. This action will delete the existing program.
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Fig. 566  Delete existing IRM Program

Step 8. Right-click the IrmBacnetDevice and click Paste.

Fig. 567  Adding IRM Program application

The device Nav of the station updates after pasting the IRM Program into the 
IrmBacnetDevice. Expand the IrmBacnetDevice and double-click the Control Manager. 
Examine the application's properties such as the application name, function block version, 
number of folders, and so on.



IRM SYSTEM ENGINEERING GUIDE 382

Fig. 568  Application Property
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Global VAV Template
The Global VAV template is a deployable package of CentraLine-N4 objects. These 
templates allow a set of configured objects to be encapsulated and deployed as a unit. The 
goal is to eliminate repetitive configuration steps when making multiple installations with 
similar functionality.

The template contains a component tree with a single base component and associated 
with supported objects. The file extension for the VAV template is *.ntpl.

Integrating the Global VAV Templates in the CentraLine-N4 workbench is recommended to 
work with IRM NX controller. For more details, refer to Global VAV Template Design Guide - 
31-00466 and Global VAV Template Engineering Guide - 31-00465.

Prerequisite
• Check the system requirements before performing engineering or commissioning. 

Refer to the release notes for more information.

• Make sure that the latest CentraLine-N4 workbench is installed on the computer.

• Use the latest version of the IRM engineering tool.

Deploy Global VAV Template
Deploy a Global VAV template on a station by dragging the templates from sidebar onto the 
project station. It is similar to dragging and dropping components from a palette.

Steps to Deploy VAV Template: 

Step 1. Copy and paste the application template file to the templates folder available 
under C:\Users\User Account\Niagara4.x\CentraLine\templates).

Step 2. Run the CentraLine-N4 station and navigate to Window > Side Bars > click 
Template. This opens the template sidebar.

Step 3. Select application template as per the site requirements.
• VAV_ISF1_HX_FX_IM-2.x", Version 2.x: Supports imperial units).

• VAV_ISF1_HX_FX_SI-2.x",  Version 2.x : Supports SI units). 

Fig. 569  Template
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Step 4. Select the template file and drag the template file from template to the 
BacnetNetwork. 

Fig. 570  Station

This action opens the configuration property window of the template.
Step 5. Configure the template properties as per your project requirements. For more 

details, refer to Global VAV Application Design User Guide - 31-00466. 

Fig. 571   Configuration properties
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Step 6. Click OK to save the configuration.

Fig. 572   Default Password

You can reuse the same template in another station by clicking Save As option and saving it 
with a different filename (keeping the original template unchanged).

After deployment, the VAV templates are displayed under Station > BACnetNetwork.

Fig. 573  VAV Templates

Important: Opening the template via the palette is not recommended; it will not create the PX images in 
the desired location.
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TROUBLESHOOTING

Best Practices and Troubleshooting Tips
Below are recommendations for larger sites that include more than 30 controllers per 
MSTP network. 

• After initiating the following bulk actions, ensure the Irm BACnet Device Manager view 
is closed. It will help avoid the traffic in the MSTP traffic in the network and response 
time to complete the actions will be faster.

• Teach To Controller or Teach Full Application To Controller

• Clear Controller

• Learn from Controller

• When the BACnet Points or schedule are modified over BACnet, the synchronization 
status changes to "BACnet Object Modified" state. To change it back to In-Sync, perform 
learn from controller.

• When Teach Full Application To Controller is initiated with more than 30 controllers, 
there may be a failure for one or two controllers with “app power cycle error” or “lockup 
error.” 

• Solution: Retry Teach Full Application To Controller on the failed devices.

• While performing actions like Clear Controller, Teach To Controller, or Learn from 
Controller the controller may fail with, “Transaction Id” error. 

• Solution: Retry Clear Controller, Teach To Controller or Learn from Controller.

• While performing actions like Teach To Controller or Teach Full Application To Controller, 
teach fails with buffer overflow issue, an infrequent observation. 

• Solution: Retry discover devices operation and perform Teach To Controller on page 
172 again.

• Before initiating the Controller Firmware Download on page 327, swap out the 
application to improve the firmware download time.

• It is highly recommended to swap out the IRM Program after commissioning. The 
following are the advantages of keeping the IRM Program in swap out mode.

• Improve the system traffic.

• Reduce heap usage in HAWK-8000, EAGLEHAWK, or Honeywell Plant controller.

• Quick reboot of HAWK-8000, EAGLEHAWK, or Honeywell Plant controller station.



IRM SYSTEM ENGINEERING GUIDE 387

• When you see rejection proprietary during teach, refer to the latest service bulletin to 
ensure the engineering tool and firmware versions are compatible.

Refer to the help document before configuring the special events in the Sylk wall module
ORD: local:|module://honIrmControl/doc/honIrmControl-WmConfigHvacA.html.

• Do not delete any nodes below the IRM Program if no backup is maintained. If deleted, 
you have to re-add and configure the complete IRM program.

• It is recommended to check the controller sync status from time to time. Go to Bacnet 
Network Irm Bacnet Device Manager View on page 28 or Control Manager on page 62 to 
check controller sync status. 

• It is advised to export the Irm bacnet device manager view to the local repository once 
all the necessary configurations and the device status are in sync and operational.

• You cannot downgrade the engineering tool from a higher to a lower version after 
upgrading it from a lower to a higher version.

• The user can set the higher poll time for the Bulk Teach & Bulk Firmware download, 
which could ease out the Network Traffic and help in Teach or Firmware download 
consistency.
Refer to the screenshot to navigate to the poll service for the IP network, and for the 
MSTP network, the poll service will be under the MSTP port.

Fig. 574   Poll Service
• If required, the user must set the wait time based on the network load (default is 120 

seconds).
Refer to the screenshot to navigate to the IrmConfig property sheet and set the wait 
time.

Fig. 575   IRM Config Property Sheet
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Service Button 

Fig. 576  IRM controllers service button
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The service button is used to trigger dedicated events. It is important to distinguish 
different controller behaviors which are elicited depending upon whether the service 
button is pressed when the controller is powering up or when it is in normal operation.

Press Service Button during controller power up
The controller is reset to factory settings when you press the service button and turn it on 
(while the service button is pressed). The factory defaults are as follows:

Note: Press the service button until the green power LED goes out at least twice and returns to its 
normal state. 

Following changes happen in the controller after a factory reset: 
• The application is cleared from the controller.
• The MAC address will be set to 0xFF (255), meaning that the controller will now 

search for a new MAC address (Auto MAC will be automatically triggered after 
controller power-up).

• The Max Master setting will revert to its default value.
• The max info frames will revert to 10.
• The device instance will revert to its default of 4194302.
• The device name will revert to CLME-VAxxxx or UNI-Rxxxxxxxxxxx [model name].
• The values of Auto MAC, Min MAC, and Max MAC will be reset to default.
• The Modbus, Ethernet, and Bluetooth settings will revert to their factory settings. 

The user settings for Modbus and BLE will be erased, the IP address will be reset to 
default, and the device will enter DHCP IP configuration.

Note: 0 and 127 mac address reserved for auto mac addressing.

Press Service Button during Normal Operation
During the regular operation of the controller, a short press (< 1 sec) of the service button 
will cause a service pin message (BACnet WhoAmI as a Private Transfer (SerialNo. = 130)) to 
be sent.

Default Max Master Default Min MAC Default Max MAC Default Baud rate

64 1 64 38400
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Synchronization Status
The synchronization status feature displays the status between the project and the 
controller in the Bacnet network. The engineering tool performs a synchronization check 
between the project and controller whenever the controller or project parameters are 
updated.

Fig. 577  Synchronization Status on Control Manger

This is the list of available synchronization status engineering tool displays is as follows:

Important: The engineering tool displays appropriate messages or notifications while 
performing any action or change in the controller’s status. Read all the messages to 
avoid misleading or incorrect actions, resulting in the deletion or loss of application 
data.

• Unknown • Controller differs from Project • Controller is empty

• In Sync • Project has modifications • BACnet Object configuration 
changed

• Out Of Sync • Project is empty • Project modified and BACnet Object 
config. changed in controller
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Synchronize applications between project and controllers
If inconsistencies occurs between project and controller, the synchronization status 
displays Out Of Sync. 

To synchronize the application perform any of the following actions:
• Teach To Controller: Teach the changes from the project to the controller.
• Learn from Controller: Learn the changes from the controller to the project.
• Check Hw Compatibility: Checks the hardware configuration of the physical 

controller and the hardware configuration defined in the controller project. Any 
differences are indicated graphically on the terminals on the wiresheet.

• Check Application Compatibility: Checks the application compatibility in the project 
and in the controller. See the BACnet device property details.

• Clear Project: Clear the application from the controller.
• Clear Controller: Clear the controller from the database.

Note: If the “Synchronization Status” goes into unknown, perform IrmProgram > Actions > 
Ping.
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Device Object Rename
After adding the BACnet device to the network, you can rename the device’s name.

• When the controller is online: When you rename a controller, the engineering tool 
automatically updates the controller name in the Nav tree. You will get the controller's 
updated name if you run the discover operation.

• When the controller is offline: When you rename an offline controller, the engineering 
tool keeps track of the changes. Whenever the controller comes online, the engineering 
tool automatically updates the controller name in the Nav tree.

Steps to rename the device is as follows:

Step 1. Navigate to the Station > Config > Drivers > BACnetNetwork > IrmBacnetDe-
vice.

Step 2. Right-click on the IrmBacnetDevice > select Rename.

Fig. 578  Device Rename

Step 3. Enter the required name and click OK.

Fig. 579  Rename dialog box
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Rename Bacnet Objects
The Rename Bacnet Objects feature is used to customize the BACnet points by adding 
prefixes and suffixes. Adding prefixes or suffixes will only update the BACnet point name 
stored in the controller, but not the BACnet point name displayed in the application.

Note: By default Rename Bacnet Objects feature is disabled.

Fig. 580 Rename Bacnet Objects Feature

Steps to rename Bacnet objects:

Step 1. Set Enabled option to true.

Step 2. In the Prefix Pattern field, enter the prefix name.
Step 3. In the Suffix Pattern field, enter the suffix name.

The prefix and suffix pattern are both in BFormat strings. To know more details 

on BFormat click on  icon seen in the Rename Bacnet Objects view below.

Step 4. Click Save.

Fig. 581 Rename Bacnet Objects 

You can verify the updated bacnet point name in Irm Bacnet Point Manager view.
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Step 5. Expand BacnetNetwork > Controller, right-click on Points > Views> Irm Bacnet 
Point Manager and select Offline discovery.

Fig. 582 Offline Point Discovery
Step 6. Click Discover.

Fig. 583 Renamed Bacnet Points
Step 7. Run Teach To Controller or Teach Full Application To Controller to apply the 

changes to the controller.
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Also, you can rename BACnet points for multiple controllers from the Irm Bacnet Device 
Manager view.

Steps to Rename BACnet points of multiple controllers:

Step 1. Right click on BacnetNetwork > Views > Irm Bacnet Device Manager.

Step 2. Select the controllers and click Rename Bacnet Objects.

Fig. 584 Rename BACnet points from Irm Bacnet Device Manager View

Note: The Rename Bacnet Objects feature displays default settings if you select multiple 
controllers. When you select a single controller, the Rename Bacnet Objects feature will 
display the settings that existed in the controller.

Step 3. Set Enabled option to True.
Step 4. In the Prefix Pattern field, enter the prefix name.
Step 5. In the Suffix Pattern field, enter the suffix name.

That prefix pattern and suffix pattern are both in BFormat strings. To know more 

details on BFormat click on  icon.

Step 6. Click Save.
Step 7. Run Teach To Controller or Teach Full Application To Controller to apply the 

changes to the controller.     
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Irm Controller Diagnostics
The Irm controller diagnostics primarily monitors the activity in the control engine, BACnet, 
Modbus trace, and Sylk trace. 

Important: The tool's default setting hides the Irm controller diagnostics feature. You must unhide Irm 
controller diagnostics in order to use this feature.

Fig. 585  Irm Program property sheet

• Control Engine: To collect logs for the function blocks. These logs are utilized to 
identify the functionality issues in the function block.

• Bacnet: To monitor the BACnet network traffic between engineering tool to 
controller or vice-versa.

• Modbus Trace: To monitor Modbus RS-485 connection activity.

• Sylk Trace: To monitor configured Sylk device activity. 

Note: You should enable one of the parameters (control engine or BACnet or Modbus trace or Sylk 
trace) at a time for diagnostic.

Steps to access Irm Controller Diagnostics option:

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice.

Step 2. Right-click IRM Program > Views > select AX Slot Sheet and locate 
irmControllerDiagnostics property in the Slot Sheet.

Step 3. Right-click irmControllerDiagnostics property and select Config Flags.
Step 4. In the Config Flags, uncheck the Hidden option. 
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Fig. 586  Slot Sheet

Step 5. Click Ok.
The Irm controller diagnostics feature is visible in the IrmProgram property 
sheet.

Steps to use Irm Controller Diagnostics:

Step 1. Navigate to BacnetNetwork > IrmBacnetDevice.

Step 2. Right-click IRM Program > Views > select AX Property Sheet. This opens the 
Bacnet Program property sheet.

Step 3. Right-click Irm Controller Diagnostics > Action > Start Diagnostics. This action 
starts the diagnosis of the selected a parameter. 

Step 4. Right-click Irm Controller Diagnostics > Action > Stop Diagnostics. This action 
stops the diagnosis process and generates a Diagnostics report.

Step 5. Right-click Irm Controller Diagnostics > Action > Read Diagnostics. This action 
generates the diagnostics file. 

Fig. 587  Irm Controller Diagnostics

Step 6. Open the CentraLine-N4 console, check the location of the Diagnostics file and 
navigate to the location. 

Fig. 588  Console

Share that Diagnostics file with the technical support team to resolve the issue in the 
controller. 

Note: Currently, you can generate diagnostics reports for a single controller at a time.
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Modifications and Consistency Check
When working on the application, the control manager detects every modification and is 
indicated graphically by a yellow warning symbol that replaces the original symbols at the 
modified item on the wire sheet and in the tree. 

Important: This feature is applicable when the Teaching mode is set to On Demand. If the Teaching mode 
is set to Immediate, the changes are not indicated graphically on the wire sheet in the 
workbench since they are written instantly to the controller.

Fig. 589  Teaching Mode

Note: If you perform a cut and paste or copy and paste action on multiple functional blocks in 
Immediate mode, the controller will go out of sync. If this happens, you must perform Teach 
To Controller. When moving or copying multiple function blocks from one folder to another, 
On demand mode is recommended.

On the property sheet of the controller manager, the synchronization status switches 
accordingly. 

Fig. 590  Synchronization Status

Fig. 591  Non-synchronous States

Depending on where the application is created (station) or changed (station or controller), 
the application must be taught to the controller or learned from the controller to achieve 
synchronization. In both cases, if required, the controller or the project must be cleared 
first.
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Configure the Character Set 
Steps to set the Character Set to ISO 10646_UTF8:

Step 1. Go to BacnetNetwork property sheet.

Step 2. Under Local Device property, set the Character Set to ISO 10646_UTF8.

Fig. 592  Character set

Bluetooth configuration is applicable for IP/MSTP VAV controllers.

Important: Ensure to check the following points before performing Bluetooth configuration.

• All IP and MSTP controllers support the UTF-8 format. Therefore, when a user sets the 
device name using the device object, the tool will write the data in the UTF-8 format.

• If the “Character Set” is not set to UTF-8, the controller will not displayed in the “Device 
Discovery page” of the VAV Balancing app.

Before changing the controller name, ensure that the Bacnet network is configured for char-
acter set UTF-8, or else the VAV balancing app device discovery page will not display the con-
troller.
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Bacnet Object limits in the Application 
Unsupported linking within the Irm Bacnet Device may result in unintended outcomes. 
According to a reasonable “thumb rule” all slots accessible by default when adding an 
function block to the wire sheet are suitable for linking. 

The function blocks in the honIrmControl palette provide a lot of flexibility when developing 
control applications.

For example, if a user wanted to change the lowLimit and highLimit parameters of a Sylk 
NetworkSetpoint block from the network, the link would be unsupported. These issues are 
not displayed in the function block by default. They can, however, be made to appear as 
composite slots, as shown in Fig. 594 . After compositing, external data can be attached to 
them, as shown in Fig. 401 on page 401. 

Fig. 593  TR42 limit slots used as Composite slots

Fig. 594  Linking to Composite slots
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The configuration displayed in Fig. 400 on page 400 and Fig. 595 is invalid. Changes to the 
limitations made during runtime via the BACnet objects will not be propagated to the 
controller. Furthermore, if you use Maser Sync to change the limitations in the RoomSpt 
property sheet, the property values will not be sent to the target devices.

In most cases, alternate logic that does not rely on unsupported linkages can be used to 
satisfy the required sequence. On the Room Spt block, Fig. 595 shows how to enforce 
setpoint relationships without using composites.

Fig. 595  Enforce setpoint without using composites

The IrmFolder and IrmSubFolder components only provide partial support for the 
composite feature. When using them to expose a function block slot, a good "thumb rule" to 
follow is to only make slots visible at the function block's top level. It is not required to drill 
into the child objects underneath a function block. For example, In and Out slots of Room 
Spt appearing in and out are eligible for usage in a composite. However, the lowLimit and 
highLimit values shown in Fig. 596  are invalid.

Fig. 596  Valid composite slots for IrmFolder and IrmSubFolder
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Fig. 597  Invalid composite slots for IrmFolder and IrmSubFolder
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Download Bluetooth Firmware
Steps to download Bluetooth Firmware:

Step 1. Right-click on BacnetNetwork > Views > Irm Bacnet Device Manager view. 

Step 2. Select all the IP or MSTP devices from the device list.

Note: Download BLE Firmware option will not be available, if any unsupported device is selected 
from the device list.

Step 3. Select Download BLE Firmware.
Step 4. Navigate to the firmware file and click open.

Fig. 598  Download Bluetooth Firmware

Step 5. Check the job log to get the status of the Bluetooth firmware download.

Fig. 599  Job Log

Step 6. Click OK.
Step 7. Power cycle the controller.
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Troubleshooting Modbus Communication
For a first communication test, connect only one Modbus device using a short cable (cable 
less than 10 feet in length).

Steps to verify Modbus communication:

Step 1. Create one read point, and the read point should have a known value that can 
be verified.

Step 2. Verify that the T2 and R2 LEDs are flickering (indicating data communication). 
Use the engineering tool to verify that the Modbus data can be read and written.

Step 3. T2 LED indicates sending a request message to a Modbus Device, and R2 LED 
indicates receiving an answer message from the Modbus Device.

Possible error causes could be wrong settings for Baud rate, Parity, and Stop bits.

The function block Modbus Read Point has two outputs.

• Out: Received value from the Modbus device.

• Out Cause: Error code. 0 = no error; Further values are listed in the Niagara 
Guide Help of the Modbus Read Point function block. Out Cause pin slot is 
not visible by default and needs to be enabled.

Possible error causes:

• Reverse Modbus polarity. 

• The polling interval defined in Operation Mode is too short (Out Cause = Timeout = 
8). Some devices do not support fast polling and, therefore, might not respond in 
time.

Note: Modbus device failure behavior: If a Modbus device does not respond to a register poll 
command, the register is entered into the list of  "Failed Registers." After that, the IRM NX 
controller polls this single register only every 10 seconds. If the register could be read 
successfully, the register is read again in the defined interval.

• Read/Write Point Address Offset +1/-1

• Device Setting Byte order

Step 4. Once this is working properly, add the next Modbus device. 
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Flow Balancing Troubleshooting
• If you run the flow balancing tool without configuring the VAV application, the 

application will generate an error.

Fig. 600  Error message for unconfigured flow balancing tool
• If you run the flow balancing tool with an incorrect network interface, the application 

displays error.

Fig. 601  Error message for incorrect network interface

• If you run the flow balancing tool, the application will generate an error when the device 
is offline.

Fig. 602  Error message for offline device

• If you run the flow balancing tool, when the tool doesn't have enough objects to balance, 
the application will generate an error.

Fig. 603  Error message for insufficient objects to balancing
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APDU Size and Segmentation Errors
A Teach full application to controller may be required if the maximum APDU size and 
segmentation supported under device object properties are not updating in the controller, 
resulting in commissioning failures.

Fig. 604   APDU Size and Segmentation Supported

Important: Application Download Failure: A download of an application may fail for a different reason. 
In the Jobs Sidebar, an error message appears. Parts of the application may have already been 
downloaded to the controller during a failed application download. The IRM controller could 
be started and operated using such application parts. This can cause damage the controllers.

Solution: If the application download fails, clear the controller and re download the 
application to avoid damage to the controller or the environment.
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Value Updates after Device Power Failure 
If a device had a power failure and the device is restarting, it will take 3 - 5 minutes until the 
values will be updated in the wire sheet. To accelerate the value update on the wire sheet, 
please manually refresh the wire sheet by navigating to another page and returning to the 
wire sheet. 

RJ45 Connector for BACnet WiFi Adapter
A BACnet Wifi Adapter can be connected to the controller's RJ45 connector in order to 
establish wireless communication with a PC with COACH NX so that the application engi-
neer can commission the controller.

Recommendation:

• Maximum10 devices connected to the controller's BACnet MSTP interface.

• Max Master for all the controllers which is connected to the Adapter via MSTP has to be 
35,since BAC-A Adapter Max Master is 35.

Note: When the BACnet Wifi Adapter is connected to the controller's RJ45 connection, it is powered 
by the controller. It is then prohibited to simultaneously power the BACnet WiFi Adapter via a 
wall adapter. When, on the other hand, the BACnet WiFi Adapter is instead connected to the 
controller's BACnet MSTP interface, it is prohibited to simultaneously use an RJ45 plug; 
instead, the BACnet WiFi Adapter must then be powered by a wall adapter (standard 5-V USB 
wall adapter with micro USB connector).

Note: When using the BACnet WiFi Adapter (BACA-A) to commission the controllers, the following 
steps should be followed:

1) Set the property maxMaster to a value of 35 for all controllers on the MSTP bus to which the 
BACnet WiFi Adapter is to be connected.

2) Ensure that one of the following MAC addresses is free on this MSTP bus: 31 or 32 or 33 or 
34.

3) Connect the BACnet WiFi Adapter to the MSTP bus.
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Caution:  It is permitted to connect only the BACnet WiFi Adapter to this RJ45 connector. Do not 
connect IP.

For more details on install BACnet Wifi Adapter, refer BACnet Wifi Adapter (BACA-A) - 
Mounting / Operating Instructions guide - MU1B0592-GE51.

Steps to configure BACnet WiFi Adapter

Step 1. Run Niagara Workbench and add BacnetNetwork under supervisor station.

Step 2. Expand BACnetNetwork.
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Step 3. Expand Bacnet Comm > Network > double-click on IP Port.

Step 4. Select the BACnet Wifi adapter from drop-down list. Make sure the Station and 
BACnet Wifi adapter in same subnet in the computer.

Step 5. Click Save. 
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Fixing Function Block Link Issue
Links are the primary mechanism of execution flow in the CentraLine-N4 Framework. Links 
allow components to be wired together graphically by propagating an event from one slot 
to another slot. 

A link is used to establish an event relationship between the source link and the target link. 
The source link generates an event when the output slot value gets modified and the value 
propagated to the input slot of the target link.

Note: Connecting a target function block slot from two different source function blocks is not 
supported by the engineering tool. By enabling the "FanIn" flag, users can override the default 
CentraLine-N4 behavior and connect from more than one source slot. But this is invalid 
procedure for creating invalid links in the engineering tool. The background verification 
process in the engineering tool prevents the user from enabling the fan-in flag.

Fig. 605  Link Creation

To resolve this issue, the user must install the most recent engineering tool. This prevents 
the user from changing the FanIn flag and displays an error message.

Fig. 606  Error Message

If the FanIn flag is enabled in any of the existing stations, then user will unable to launch the 
station using the latest engineering tool version. The user need to remove the FanIn flag first, 
delete if there are multiple links to the same slot, and then launch the station using the latest 
engineering tool.
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Workaround for Tuning Policy behavior issue
Scenario 1
When the IRM NX controller is online, if you set the Use Cov Property to true and Tuning 
Policy Name property to IrmTuningPolicy.

Issue: If you perform the clear controller operation, the IRM NX controller and BACnet 
points will go offline.

Fig. 607  Tuning Policy Name property
Solution 1: While assigning points to a BACnet device, set the Tuning Policy Name 
property as Default Policy (without COV mode). 
Or 
Go to Points, double-click on the point to open the property sheet, and set Tuning Policy 
Name property as Default Policy. The controller will be online in a few seconds. 

Fig. 608   Editing Point Property
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Solution 2: Go to BacnetNetwork, double-click on the controller to open the property 
sheet, and set the Use Cov property to False. The controller will be online in a few seconds.

Fig. 609  Editing Controller Property

Scenario 2
When the IRM NX controller is online, if you the set the Tuning Policy Name property as 
Irm Tuning Policy in the Global VAV template or Venom template. 

Issue: The controller will go offline if the match operation is performed on an online device. 

Solution: When creating a template, make sure that all of the points are disabled by 
default.

Fig. 610  Points edit window
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While performing the match operation between the template and the device, do not set the 
Use Cov property to True.

Fig. 611  Use Cov Property

Important:  Disable the BACnet points if the TuningPolicyName property is IrmTuningPolicy. You can 
enable the points after commissioning or teach the controller operation.
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Replacing Defective Controller
Use this method to replace defective controller with the new controller. When a controller 
become defective it become inoperative. You can replace the defective controller with new 
controller and restore the configuration and application data to the new controller.

Note: When replacing the MSTP controller, make sure the max master is within the same 
range as the other controllers in the network.

Steps to replace defective controller with new controller:

Step 1. Replace defective controller with new controller and connect to the Bacnet 
Network.

Step 2. Navigate to the Irm Bacnet Device Manager view and click Discover. The new 
controllers in the Bacnet Network are discovered.

Note: The new controllers is in factory default state.

Fig. 612   Discovered Controller

Step 3. Select the new controller from the Discovered section and the existing controller 
from the Database section.
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Step 4. Click Match.

Fig. 613   Irm Bacnet Device Manager View

The new controllers properties matched to the existing controller indicated in 
the Database section.
If desired, you can change the name, device id, network number, and MAC 
address, and enable Use Cov by selecting “true” from the drop-down list.

Step 5. Click OK. 
Step 6. Perform the hardware compatibility check to ensure that the application is 

appropriately designed to run seamlessly in the created device. 
Step 7. Click Teach Full Application to Controller. 

Note: If a large application is created in the controller, it is recommended to perform Teach Full 
Application To Controller.
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Configure IP Address Of Computer
There are two ways to configure the IP address on a computer. 

• Obtaining IP address automatically 

• Manually configuring TCP/IP Properties

Obtaining IP address automatically

Step 1. Go to Internet Protocol 4 (TCP/ IPv4) properties.

Step 2. Set Obtain an IP address automatically and Obtain DNS server 
address automatically. 

Step 3. Click OK to save the settings.

Fig. 614   Automatic IP Address Configuration
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Manually configuring TCP/IP Properties

Step 1. Go to Internet Protocol 4 (TCP/ IPv4) properties.

Step 2. Select Use the following IP address, type IP address, subnet mask and 
default gateway IP address into it.

If the router’s LAN IP address is 169.254.1.0, please type in IP address 
169.254.1.x (x is from 2 to 253?, subnet mask 255.255.255.0, and default 
gateway 169.254.1.1.

Step 3. Select Use the following DNS server addresses.

You can keep Preferred DNS server and the Alternate DNS server blank.
Step 4. Click OK to save the settings.

Fig. 615   Manual IP Address Configuration
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Step 5. Click OK to save and apply your settings.

Fig. 616   Applying Updated IP Settings
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